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1 HP Photosmart D7400 series Help
For information about the HP Photosmart, see:

• “HP Photosmart overview” on page 9
• “Find more information” on page 15
• “Finish setting up the HP Photosmart” on page 17
• “How do I?” on page 53
• “Load paper” on page 55
• “Print from your computer” on page 65
• “Use the photo features” on page 85
• “Print reports and forms” on page 99
• “Maintain the HP Photosmart” on page 101
• “Shop for ink supplies” on page 111
• “HP warranty and support” on page 169
• “Technical information” on page 175
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2 HP Photosmart overview
Use the HP Photosmart to quickly and easily accomplish tasks such as printing photos
from a memory card. You can access many HP Photosmart functions directly from the
control panel, without turning on your computer.
This section contains the following topics:

• The HP Photosmart at a glance
• Control panel features
• Display icons
• Display sleep state
• Menu overview
• Enter text using the visual keyboard
• Use the HP Photosmart Software

The HP Photosmart at a glance

Label Description

1 On

2 Ink cartridge door

3 Color graphics display (also referred to as the
display)

4 Control panel

5 Memory card slots and Photo light

6 Front USB port

7 Photo tray

8 Main input tray (also referred to as the input tray)

9 Paper tray extender (also referred to as the tray
extender)

HP Photosmart overview 9
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Label Description

10 Output tray

11 Power connection*

12 Ethernet port

13 Rear USB port

14 Rear door

* Use only with the power adapter supplied by HP.

Control panel features
The following diagram and related table provide a quick reference to the HP Photosmart
control panel features.

Label Name and Description

1 Display: View menus, photos, and messages. The touch screen display can be adjusted to
different positions. This enables the user to change the display angle to accommodate various
device placements and lighting conditions.

2 Print Photos: Depending on whether you access your photos from the View, Print, or Create
menu, the Print Photos button will display the Print Preview screen or it will print any selected
photo(s). If no photos are selected, a prompt appears asking if you want to print all the photos
on your card or storage device.

3 Wireless light: Indicates that the 802.11 b and g wireless radio is turned on.

4 Attention light: Indicates that a problem occurred. See the display for more information.

5 Cancel: Stops the current operation, exits a menu, or exits settings.

Chapter 2
(continued)
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Label Name and Description

6 Red Eye Removal: Turns the Red Eye Removal feature On or Off. By default, this feature is
turned off. When the feature is turned on, the HP Photosmart automatically corrects red eye
coloring in the photo currently shown on the display.

Display icons
The following icons can appear at the bottom of the display to provide important
information about the HP Photosmart.

Icon Purpose

Shows the ink cartridge status. The color of the icon corresponds to the color of
the ink cartridge, and the fill level of the icon corresponds to the fill level of the
ink cartridge.

NOTE: The ink level icons will only appear if one of the ink cartridges is less
than 50% full. If the ink level for all ink cartridges is more than 50% full, the ink
cartridge icons do not appear on the display.

Shows that the ink cartridge is nearly empty, and will need to be replaced.

Shows that an unknown ink cartridge is inserted. This icon might appear if an
ink cartridge contains non-HP ink.

Indicates that there is a wired network connection.

Indicates the presence and signal strength of a wireless network connection.

Indicates the presence of an Ad hoc wireless network connection.

Indicates that an HP bt450, Printer and PC Adapter with Bluetooth® Wireless
Technology is connected to the front USB port.

Display sleep state
To prolong the life of the display, it dims after two minutes of inactivity. After 30 minutes
of inactivity, the display goes into a sleep state and the screen shuts off completely. The
display turns back on when you touch the display, press a control panel button, insert a
memory card or connect a storage device, or access the HP Photosmart from a connected
computer.

(continued)
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Menu overview
The following topics provide a quick reference to top-level menus that appear on the
HP Photosmart display.

• Photosmart Express Menu
• Setup Menu
• Help Menu

Photosmart Express Menu
The following options are available in the Photosmart Express menu when you insert a
memory card or storage device.

View

Print Create Share Save

Setup Menu
The following options are available when you touch Setup from the Photosmart
Express menu.

Printable School Papers
Help Menu
Tools
Preferences
Wireless
Bluetooth

NOTE: The Bluetooth option only appears if an optional HP bt450, Printer and PC
Adapter with Bluetooth® Wireless Technology is attached to the HP Photosmart.

Chapter 2
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Help Menu
The Help menu provides quick access to key help topics. It is available when you touch
the ? icon in the idle state. You can also access this menu through the Setup menu. The
following options are available. If you select one of the first four topics, the help appears
on the display. If you select one of the last six topics, the help appears on your computer.

Insert Ink Cartridges
Load Paper
Load Paper in Photo Tray
Paper Jam
How Do I
Error Messages
General Troubleshooting
Networking Troubleshooting
Use Memory Cards
Get Support

Enter text using the visual keyboard
You can enter text or symbols by using the visual keyboard that automatically appears
on the display when you need to enter text. For example, the visual keyboard
automatically appears when you are setting up a wireless network or bluetooth device
name.

To enter text using the visual keyboard
1. To select a letter, number, or symbol on the visual keyboard, touch the appropriate

selection.

To enter lowercase letters, uppercase letters, numbers, and symbols
• To enter lowercase letters, touch abc on the visual keyboard.
• To enter uppercase letters, touch ABC on the visual keyboard.
• To enter numbers, touch 123 on the visual keyboard.
• To enter symbols, touch .@! on the visual keyboard.

2. After you touch the appropriate letter, number, or symbol, the selection appears in
the white space above the visual keyboard.

TIP: To erase a letter, number, or symbol, touch Del on the visual keyboard.

3. When you are finished entering text, numbers, or symbols, touch Done on the visual
keyboard.

Use the HP Photosmart Software
The HP Photosmart Software provides a fast and easy way to make prints of your photos.
It also provides access to other basic HP imaging software features, such as saving and
viewing your photos.

Enter text using the visual keyboard 13
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For more information on using the HP Photosmart Software:

• Check the Contents panel on the left. Look for the HP Photosmart Software Help
contents book at the top.

• If you do not see the HP Photosmart Software Help contents book at the top of the
Contents panel, access the software help through the HP Solution Center.

Chapter 2
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3 Find more information
You can access a variety of resources, both printed and onscreen, that provide
information about setting up and using the HP Photosmart.

Setup Guide
The Setup Guide provides instructions for setting up the HP Photosmart and
installing software. Make sure you follow the steps in the Setup Guide in order.
If you have problems during setup, check the Setup Guide for troubleshooting
information, or see “Troubleshooting” on page 113 in this onscreen Help.

HP Photosmart  
2600 series printer 
User Guide

Basics Guide
The Basics Guide contains an overview of the HP Photosmart, including step-
by-step instructions for basic tasks, troubleshooting tips, and technical
information.

HP Photosmart Essential animations
The HP Photosmart Essential animations are an interactive way to get a brief
overview of the software included with the HP Photosmart. You will learn how
the software can help you create, share, organize, and print your photos.

Onscreen Help
The onscreen Help provides detailed instructions on using all features of the
HP Photosmart.

• The How Do I? topic provides links so you can quickly find information on
performing common tasks.

• The HP Photosmart overview topic provides general information about
the main features of the HP Photosmart.

• The Troubleshooting topic provides information about resolving errors
you might encounter with the HP Photosmart.

Readme
The Readme file contains the most recent information which might not be found
in other publications.
Install the software to access the Readme file.

www.hp.com/support If you have Internet access, you can get help and support from the HP Web
site. This Web site offers technical support, drivers, supplies, and ordering
information.
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4 Finish setting up the
HP Photosmart
After you have completed the steps in your Setup Guide, refer to this section to help you
finish setting up the HP Photosmart. This section contains important setup-related
information for your device, including information on setting preferences.

This section contains the following topics:

• Set your preferences
• Computer connection information
• Connect to a network

Set your preferences
You can change the settings on the HP Photosmart so that it behaves according to your
preference. For example, you can set general device preferences, such as the language
used to display messages. You can also restore the device settings to what they were
when you purchased your device. This will erase any new defaults you have set.

This section contains the following topics:

• Set your language and country/region
• Adjust the volume
• Set the default paper tray for PictBridge/DPOF/uPnP printing
• Enable faster browsing of photos
• Set the paper tray for printing from a Bluetooth device
• Restore the factory defaults
• Play a slideshow on the display

Set your language and country/region
The language setting determines which language the HP Photosmart uses to show
messages on the display. The country/region setting determines the default paper sizes
and layouts for printing. You can change these settings at any time by using the following
procedures.

To set the language
1. Touch Setup on the display.
2. Touch Preferences.
3. Touch Set Language.
4. Touch the language you want to select.

NOTE: If the menu option you want is not visible on the screen, touch  or
 to scroll through all the menu options.

5. When prompted, touch Yes to confirm your selection, or touch No to choose another
language.

Finish setting up the HP Photosmart 17

Fi
ni

sh
 s

et
up



To set the country/region
1. Touch Setup on the display.
2. Touch Preferences.
3. Touch Set Country/Region.
4. Touch the country/region you want to select.

NOTE: If the menu option you want is not visible on the screen, touch  or
 to scroll through all the menu options.

5. When prompted, touch Yes to confirm your selection, or touch No to choose another
country/region.

Adjust the volume
The HP Photosmart provides three levels for adjusting the volume of sounds associated
with device events and errors. The default setting is Medium.

To adjust the volume
1. Touch Setup on the display.
2. Touch Preferences.
3. Touch Sound Effects Volume, and then touch the volume you want to select.

Set the default paper tray for PictBridge/DPOF/uPnP printing
Set the default paper tray to use when you print photos from a Pictbridge device, DPOF
file, or a UPnP device. The default setting is Photo Tray.

To set the default paper tray
1. Touch Setup on the display.
2. Touch Preferences.
3. Touch PictBridge/DPOF/uPnP Tray Select.
4. Touch Main Tray or Photo Tray.

Enable faster browsing of photos
You can set up the HP Photosmart to enable faster photo browsing by writing small
thumbnails to the memory card. The thumbnails take up a relatively small amount of
space and are used to speed up the browsing performance of photos on the card.

NOTE: This feature is on by default.

To turn faster browsing on or off
1. Touch Setup on the display.
2. Touch Tools.
3. Touch  to scroll through the options, and then touch Enable Faster Browsing.
4. Touch On or Off to turn it on or off.

Chapter 4
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Set the paper tray for printing from a Bluetooth device
Set the default paper tray to use when you print photos from a Bluetooth device.

To set the paper tray for printing from a Bluetooth device
1. Touch Setup.
2. Touch Bluetooth.

NOTE: If the menu option you want is not visible on the screen, touch  or
 to scroll through all the menu options.

3. Touch Default Paper Tray.
4. Touch Main Tray or Photo Tray.

Restore the factory defaults
You can restore the current settings to what they were when you purchased the
HP Photosmart.

You can perform this process from the control panel only.

To restore the factory defaults
1. Touch Setup on the display.
2. Touch Tools.
3. Touch  to scroll through the options, and then touch Restore Factory Defaults.

The factory default settings are restored.

Play a slideshow on the display
You can set up the HP Photosmart to play a slideshow on the display, similar to a
screensaver on a computer, when you are not using the device.

There are two types of slideshows that you can enable:

• Store Demo: appears after the HP Photosmart is inactive for one minute and shows
a set of predefined graphics that describe features of the device. The slideshow plays
until you press a button or use the device. If the HP Photosmart remains inactive for
eight hours, the display turns off.

NOTE: HP recommends leaving Store Demo off.

• Tips Slideshow: appears only after you print from the computer. The HP Photosmart
shows a set of predefined slides with information about special features that you can
do with the device. The slideshow plays through once and then the display returns to
the main menu.

To turn the store demo on or off
1. Touch Setup on the display.
2. Touch Tools.
3. Touch  to scroll through the options, and then touch Store Demo.
4. Touch On or Off to turn it on or off.
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To turn tips slideshow on or off
1. Touch Setup on the display.
2. Touch Tools.
3. Touch  to scroll through the options, and then touch Tips Slideshow.
4. Touch On or Off to turn it on or off.

Computer connection information
The HP Photosmart comes equipped with a USB port so you can connect directly to a
computer using a USB cable. You can also connect the HP Photosmart to either a wired
or wireless network. If you insert an HP bt450, Printer and PC Adapter with Bluetooth®

Wireless Technology into the front USB port, Bluetooth® devices such as PDAs and
camera phones can print to the HP Photosmart.

NOTE: In the remainder of this chapter, the HP bt450, Printer and PC Adapter with
Bluetooth® Wireless Technology is referred to simply as an HP bt450.

This section contains the following topics:

• Supported connection types
• Connect using Ethernet
• Connect using integrated wireless WLAN 802.11
• Connect using the HP bt450, Printer and PC Adapter with Bluetooth® Wireless

Technology
• Use printer sharing

Supported connection types
The following table contains a list of supported connection types.

Description Recommended number
of connected
computers for best
performance

Supported software
features

Setup instructions

USB connection One computer connected
with a USB cable to the
rear USB 2.0 High Speed
port on the
HP Photosmart.

All features are
supported.

Follow the Setup Guide
for detailed instructions.

Ethernet (wired)
connection

Up to five computers
connected to an
HP Photosmart using a
hub or router.

All features are
supported, including
Webscan.

Follow the instructions in
“Wired network setup”
on page 27.

Wireless WLAN 802.11
connection

Up to five computers
connected using a
wireless router
(infrastructure mode).

All features are
supported, including
Webscan.

Follow instructions in
“Integrated wireless
WLAN 802.11 network
setup” on page 29.

HP bt450, Printer and PC
Adapter with Bluetooth®

Wireless Technology

One Bluetooth device or
computer.

Printing from a Bluetooth
device such as a PDA or
camera phone, or a

Follow the instructions in
“Connect using the
HP bt450, Printer and PC
Adapter with Bluetooth®
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Description Recommended number
of connected
computers for best
performance

Supported software
features

Setup instructions

Bluetooth-enabled
computer.

Wireless Technology”
on page 21.

Printer sharing Five.
The host computer must
be on at all times in order
to print from the other
computers.

All features resident on
the host computer are
supported. Only printing
is supported from the
other computers.

Follow the instructions in
“Use printer sharing”
on page 26.

Connect using Ethernet
The HP Photosmart supports both 10 Mbps and 100 Mbps Ethernet network connections.
For detailed instructions on connecting the HP Photosmart to an Ethernet (wired) network,
see “Wired network setup” on page 27.

Connect using integrated wireless WLAN 802.11
The HP Photosmart uses an internal networking component that supports a wireless
network. For detailed instructions on connecting the HP Photosmart to a wireless (802.11)
network, see “Integrated wireless WLAN 802.11 network setup” on page 29.

Connect using the HP bt450, Printer and PC Adapter with Bluetooth® Wireless
Technology

HP bt450, Printer and PC Adapter with Bluetooth® Wireless Technology allows you to
print images from most Bluetooth devices, including computers. Simply insert the HP
bt450 into the front USB port and print from a Bluetooth device such as a PDA or camera
phone.

This section contains the following topics:

• Find the device name and address
• Set Bluetooth security for the HP Photosmart
• Use a Bluetooth® connection to print from your computer

Find the device name and address
Some Bluetooth devices exchange device addresses when they communicate with each
other, so you might need to find out the device address of the HP Photosmart in order to
establish a connection. Also, some Bluetooth devices display the name of the printer
when connected. If you do not want the default name displayed as the name of the
HP Photosmart, you can change the device name.

To find out the device address of the HP Photosmart
1. Insert the HP bt450 into the front USB port.
2. Touch Setup on the display.

(continued)
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3. Touch Bluetooth.

NOTE: If the menu option you want is not visible on the screen, touch  or
 to scroll through all the menu options.

4. Touch Device Address.
The Device Address is read only.

5. To enter the address into your device, follow the instructions that came with your
Bluetooth device.

6. Touch OK to exit the Setup menu.

To change the device name of the HP Photosmart
1. Touch Setup on the display.
2. Touch Bluetooth.

NOTE: If the menu option you want is not visible on the screen, touch  or
 to scroll through all the menu options.

3. Touch Device Name.

NOTE: The HP Photosmart ships with the predefined name of Photosmart
D7400.

4. Touch Change.
5. Use the visual keyboard to enter a new name.
6. When you have finished entering a name for the HP Photosmart, touch OK.

The name you entered will appear on your Bluetooth device when you connect to the
HP Photosmart to print.

7. Touch OK to exit the Setup menu.

Related topics
“Enter text using the visual keyboard” on page 13

Set Bluetooth security for the HP Photosmart
You can enable printer security settings through the Bluetooth menu on the
HP Photosmart. Touch Setup on the display, and then touch Bluetooth. From the
Bluetooth menu, you can:

• Require passkey authentication prior to someone printing to the HP Photosmart from
a Bluetooth device.

• Make the HP Photosmart visible or invisible to Bluetooth devices that are within range.

This section contains the following topics:

• Use a passkey to authenticate Bluetooth devices
• Set the HP Photosmart to be invisible to Bluetooth devices
• Turn the Bluetooth radio on and off
• Reset Bluetooth settings on the HP Photosmart

Chapter 4
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Use a passkey to authenticate Bluetooth devices
You can set the security level of the HP Photosmart to either Low or High. The default
security setting is Low. Low level security does not require authentication.
• Low: This is the default security setting. Low level security does not require a

passkey, as it does not support authentication. Any Bluetooth device within range can
print to it.

• High: High level security requires a passkey, as it supports authentication. The
Bluetooth device must provide a passkey, before the HP Photosmart will allow the
device to send a print job to it.

NOTE: The HP Photosmart ships with a predefined passkey that is set to four zeroes
"0000".

To set the HP Photosmart to require passkey authentication
1. Touch Setup on the display.
2. Touch Bluetooth.

NOTE: If the menu option you want is not visible on the screen, touch  or
 to scroll through all the menu options.

3. Touch Passkey.
4. Touch Change.
5. Use the visual keyboard to enter a new passkey.

NOTE: The passkey must be 1 to 4 characters long, and can only consist of
numbers.

6. When you have finished entering your passkey, touch OK.
The Bluetooth menu appears.

7. Touch Security Level.
8. Touch High.

High level security requires authentication.
Passkey authentication is now set for the HP Photosmart.

Related topics
“Enter text using the visual keyboard” on page 13

Set the HP Photosmart to be invisible to Bluetooth devices
You can set the HP Photosmart to be either Visible to all Bluetooth devices (public) or
Not visible to any (private).
• Visible to all: Any Bluetooth device within range can print to the HP Photosmart.
• Not visible: Only Bluetooth devices that have stored the device address of the

HP Photosmart can print to it.

NOTE: The HP Photosmart ships with a default accessibility level of Visible to all.
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To set the HP Photosmart to be Not visible
1. Touch Setup on the display.
2. Touch Bluetooth.

NOTE: If the menu option you want is not visible on the screen, touch  or
 to scroll through all the menu options.

3. Touch Visibility.
4. Touch Not visible.

The HP Photosmart is inaccessible to Bluetooth devices that have not stored its
device address.

Turn the Bluetooth radio on and off
The Bluetooth radio is on by default, as indicated by the blue light on the front of the
HP Photosmart. In order to stay connected to Bluetooth, the radio must stay on. However,
if the HP Photosmart is connected to a wireless network or you have a USB connection,
the radio is not used. In this case you might want to turn the radio off.

To turn the Bluetooth radio on and off
1. Touch Setup on the display.
2. Touch Bluetooth.

NOTE: If the menu option you want is not visible on the screen, touch  or
 to scroll through all the menu options.

3. Touch Bluetooth Radio.
4. Touch On or Off.

Reset Bluetooth settings on the HP Photosmart
You can reset all of the Bluetooth settings on the HP Photosmart to the factory defaults.

NOTE: Only select Reset Bluetooth if you want all of the HP Photosmart Bluetooth
settings returned to factory defaults.

To reset the Bluetooth settings
1. Touch Setup on the display.
2. Touch Bluetooth.

NOTE: If the menu option you want is not visible on the screen, touch  or
 to scroll through all the menu options.

3. Touch Reset Bluetooth.

Use a Bluetooth® connection to print from your computer
A Bluetooth connection provides a quick and easy way to print images from a Bluetooth-
enabled computer without using a cable. With a Bluetooth connection you can access
many of the same printing features as with a USB connection. For example, you can
check the printer status, as well as the estimated amount of ink remaining in your ink
cartridges.
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Before you print, you must connect an HP bt450, Printer and PC Adapter with
Bluetooth® Wireless Technology to the HP Photosmart.

You must have Windows XP or Windows Vista and either the Microsoft Bluetooth®

Protocol Stack or the Widcomm Bluetooth® Protocol Stack installed in order to connect
the HP Photosmart. It is possible to have both the Microsoft Stack and the Widcomm
Stack on your computer, but you use only one of them to connect the HP Photosmart.

• Microsoft stack If you have Windows XP with Service Pack 2 or Windows Vista
installed on your computer, then your computer has the Microsoft Bluetooth® Protocol
Stack. The Microsoft stack allows you to install an external Bluetooth® adapter
automatically. If your Bluetooth® adapter supports the Microsoft stack but it does not
install automatically, then you do not have the Microsoft stack on your computer.
Check the documentation that came with the Bluetooth® adapter to see if it supports
the Microsoft stack.

• Widcomm stack: If you have an HP computer with Bluetooth® built in, or if you have
installed an HP bt450, then your computer has the Widcomm stack. If you have an
HP computer and plug in an HP bt450, it will install automatically using the Widcomm
stack.

To install and print using the Microsoft stack
1. Make sure that you have installed the HP Photosmart software on the computer.

NOTE: The purpose of installing the software is to make sure the printer driver
is available for the Bluetooth® connection. Therefore, if you have already installed
the software, you do not need to reinstall it. If you want both a USB and a
Bluetooth® connection to the HP Photosmart, install the USB connection first. For
more information, see the Setup Guide. However, if you do not want a USB
connection, select Directly to the computer on the Connection Type screen.
Also, on the Connect Your Device Now screen, select the check box next to If
you are unable to connect your device now... at the bottom of the screen.

2. Attach an HP bt450 to the front USB port of the HP Photosmart.
3. If you are using an external Bluetooth® adapter for your computer, make sure your

computer is started and then attach the Bluetooth® adapter to a USB port on the
computer. If you have Windows XP with Service Pack 2 or Windows Vista installed,
the Bluetooth® drivers are installed automatically. If you are prompted to select a
Bluetooth® profile, select HCRP.
If your computer has Bluetooth® built in, just make sure the computer is started.

4. On the Windows taskbar, click Start, and then click Printers and Faxes (or click
Control Panel, and then Printers).

5. Double-click the Add Printer icon (or click Add a printer).
6. Click Next, and then select A Bluetooth Printer.
7. Follow the onscreen instructions to finish the installation.
8. Print as you would to any printer.
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To install and print using the Widcomm stack
1. Make sure that you have installed the HP Photosmart software on the computer.

NOTE: The purpose of installing the software is to make sure the printer driver
is available for the Bluetooth® connection. Therefore, if you have already installed
the software, you do not need to reinstall it. If you want both a USB and a
Bluetooth® connection to the HP Photosmart, install the USB connection first. For
more information, see the Setup Guide. However, if you do not want a USB
connection, select Directly to the computer on the Connection Type screen.
Also, on the Connect Your Device Now screen, select the check box next to If
you are unable to connect your device now... at the bottom of the screen.

2. Attach an HP bt450 to the front USB port of the HP Photosmart.
3. Click the My Bluetooth Places icon on the desktop or in the taskbar.
4. Click View devices in range.
5. Once the available printers are discovered, double-click the name of HP Photosmart

to finish the installation.
6. Print as you would to any printer.

Use printer sharing
If your computer is on a network, and another computer on the network has an
HP Photosmart connected to it by a USB cable, you can print to that printer using printer
sharing.

The computer directly connected to the HP Photosmart acts as the host for the printer
and has full software functionality. The other computer, which is referred to as a client,
has access only to the print features. You must perform other functions from the host
computer or from the control panel on the HP Photosmart.

To enable printer sharing on a Windows computer
▲ Refer to the user guide that came with your computer or see the Windows onscreen

Help.

Connect to a network
This section describes how to connect the HP Photosmart to a network and how to view
and manage network settings.

If you want to: See this section:

Connect to a wired (Ethernet) network. “Wired network setup” on page 27

Connect to a wireless network with a wireless
router (infrastructure).

“Integrated wireless WLAN 802.11 network
setup” on page 29

Connect directly to a wireless-capable
computer without a wireless router (ad hoc).

“Wireless ad hoc network setup” on page 33

Install the HP Photosmart software for use in a
networked environment.

“Install the software for a network connection”
on page 36
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If you want to: See this section:

Add connections to more computers on the
network.

“Connect to additional computers on a
network” on page 37

Change the HP Photosmart from a USB
connection to a network connection.

NOTE: Use the instructions in this section if
you first installed the HP Photosmart with a USB
connection, and you now want to change to
either a wireless or Ethernet network
connection.

“Change the HP Photosmart from a USB
connection to a network connection”
on page 38

View or change the network settings. “Manage your network settings” on page 38

Find troubleshooting information. “Network troubleshooting” on page 125

NOTE: You can connect the HP Photosmart to either a wireless or wired network,
but not both at the same time.

Wired network setup
This section describes how to connect the HP Photosmart to a router, switch, or hub using
an Ethernet cable and how to install the HP Photosmart software for a network
connection. This is known as a wired or Ethernet network.

To set up the HP Photosmart on a wired
network, you need to do the following:

See this section:

First, collect all of the required materials. “What you need for a wired network”
on page 28

Next, connect to a wired network. “Connect the HP Photosmart to the network”
on page 28

Finally, install the software. “Install the software for a network connection”
on page 36

(continued)

Connect to a network 27

Fi
ni

sh
 s

et
up



What you need for a wired network
Before you connect the HP Photosmart to a network, make sure you have all of the
required materials.

❑ A functional Ethernet network that includes a router, switch, or hub with an Ethernet
port.

❑ CAT-5 Ethernet cable.

Although standard Ethernet cables look similar to standard telephone cables, they
are not interchangeable. There is a different number of wires in each one, and each
has a different connector. An Ethernet cable connector (also called an RJ-45
connector) is wider and thicker and always has 8 contacts on the end. A phone
connector has between 2 and 6 contacts.

❑ A desktop computer or laptop with an Ethernet connection.

NOTE: The HP Photosmart supports both 10 Mbps and 100 Mbps Ethernet
networks. If you are purchasing, or have purchased, a network interface card
(NIC), make sure it can operate at either speed.

Connect the HP Photosmart to the network
To connect the HP Photosmart to the network, use the Ethernet port on the back of the
device.

To connect the HP Photosmart to the network
1. Remove the yellow plug from the back of the HP Photosmart.
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2. Connect the Ethernet cable to the Ethernet port on the back of the HP Photosmart.

3. Connect the other end of the Ethernet cable to an available port on your Ethernet
router or switch.

4. Once you have connected the HP Photosmart to the network, install the software.

Related topics
“Install the software for a network connection” on page 36

Integrated wireless WLAN 802.11 network setup
For optimal performance and security in your wireless network, HP recommends you use
a wireless router or access point (802.11) to connect the HP Photosmart and the other
network elements. When network elements are connected through a wireless router or
access point, this is called an infrastructure network.
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The advantages of a wireless infrastructure network as compared to an ad hoc network
include:

• Advanced network security
• Enhanced reliability
• Network flexibility
• Better performance, especially with 802.11 g mode
• Shared Broadband Internet access

To set up the HP Photosmart on an
integrated wireless WLAN 802.11 network,
you need to do the following:

See this section:

First, collect all of the required materials. “What you need for an integrated wireless
WLAN 802.11 network” on page 30

Next, connect the HP Photosmart to the
wireless router, and run the Wireless Setup
Wizard.

“Connect to an integrated wireless WLAN
802.11 network” on page 30

Finally, install the software. “Install the software for a network connection”
on page 36

What you need for an integrated wireless WLAN 802.11 network
To connect the HP Photosmart to an integrated wireless WLAN 802.11 network, you will
need the following:

❑ A wireless 802.11 network that includes a wireless router or access point.
❑ A desktop computer or laptop with either wireless networking support, or a network

interface card (NIC). The computer must be connected to the wireless network that
you intend to install the HP Photosmart on.

❑ Broadband Internet access (recommended) such as cable or DSL.
If you connect the HP Photosmart on a wireless network that has Internet access, HP
recommends that you use a wireless router (access point or base station) that uses
Dynamic Host Configuration Protocol (DHCP).

❑ Network name (SSID).
❑ WEP key or WPA Passphrase (if needed).

Connect to an integrated wireless WLAN 802.11 network
The Wireless Setup Wizard provides an easy way to connect the HP Photosmart to your
network. You can also use SecureEasySetup, if your wireless router or access point
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supports this feature. See the documentation that came with your wireless router or
access point to find out if it supports using EasySetup and for additional setup instructions.

CAUTION: To prevent other users from accessing your wireless network, HP
strongly recommends using a password or passphrase (WPA or WEP security) and
a unique network name (SSID) for your wireless router. Your wireless router might
have been shipped with a default network name, which is typically the manufacturer
name. If you use the default network name, your network can be easily accessed by
other users using the same default network name (SSID). It also means that the
HP Photosmart might accidently connect to a different wireless network in your area
which uses the same network name. If this happens you will not be able to access
the HP Photosmart. For more information on how to change the network name, see
the documentation that came with your wireless router.

NOTE: Before connecting to a wireless infrastructure network, ensure that the
ethernet cable is not connected to the HP Photosmart.

To connect the HP Photosmart with the Wireless Setup Wizard
1. Write down the following information about your wireless router or access point:

• Network Name (also called SSID)
• WEP Key, WPA Passphrase (if needed)
If you do not know where to find this information, see the documentation that came
with your wireless router or access point. You might be able to find the network name
(SSID) and the WEP key or WPA passphrase on the Embedded Web Server for the
wireless router.

2. Touch Setup on the display.
3. Touch Network.

NOTE: If the menu option you want is not visible on the screen, touch  or
 to scroll through all the menu options.

4. Touch Wireless Setup Wizard.
This runs the Wireless Setup Wizard.
The wireless network test also runs, performing a series of diagnostic tests to
determine whether network setup is successful. The wireless network test prints upon
completion of the test.

5. Touch the name of the network you wrote down in step 1.

If you do not see your network name in the list
a. Touch Enter a New Network Name (SSID).

The visual keyboard appears.
b. Enter the network name (SSID). Touch the appropriate letters or numbers on the

visual keyboard.

NOTE: You must enter the exact uppercase (capital) and lowercase (small)
letters. Otherwise, the wireless connection will fail.
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c. When you have finished entering the new network name, touch Done, and then
touch OK.

TIP: If the HP Photosmart is unable to discover the network based on the
network name you entered, you will see the following prompts. You may want
to move the HP Photosmart closer to the computer and try running the
Wireless Setup Wizard again to automatically discover the network.

d. Touch Infrastructure.
e. Touch WEP encryption or WPA encryption.

If you do not want to use WEP encryption, touch No, my network does not use
encryption. Go to step 7.

6. If prompted, enter your WPA or WEP key as follows:
a. Touch the appropriate letters or numbers on the visual keyboard.

NOTE: You must enter the exact uppercase (capital) and lowercase (small)
letters. Otherwise, the wireless connection will fail.

b. When you are finished entering the WPA or WEP key, touch Done.
c. Touch OK to confirm.

The HP Photosmart will attempt to connect to the network. If a message says you
entered an invalid WPA or WEP key, check the key you wrote down for your new
network, follow the prompts to correct the key, and then try again.

7. When the HP Photosmart connects successfully to the network, install the software
on each computer that will use the device over the network.

To connect the HP Photosmart with SecureEasySetup
1. Activate SecureEasySetup on your wireless router or access point.
2. Touch Setup on the display.
3. Touch Network.

NOTE: If the menu option you want is not visible on the screen, touch  or
 to scroll through all the menu options.

4. Touch Wireless Setup Wizard.
5. Follow the onscreen prompts on the display to complete the connection.
6. When the HP Photosmart connects successfully to the network, go to your computer

to install the software on each computer that will use the network.

NOTE: If the connection fails, the wireless router or access point might have
timed out after you activated SecureEasySetup. Repeat the above task, ensuring
that you complete the steps on the control panel of the HP Photosmart
immediately after pressing the button on the wireless router or access point.

Related topics
“Install the software for a network connection” on page 36
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Wireless ad hoc network setup
Use this section if you want to connect the HP Photosmart to a wireless-capable computer
without using a wireless router or access point.

NOTE: An ad hoc connection is available if you do not have a wireless router or
access point. However, it provides little flexibility, a low level of network security, and
slower network performance than with a wireless router or access point.

In order to connect the HP Photosmart to your computer (ad hoc), you need to create an
ad hoc network profile on your computer. This includes choosing a network name (SSID)
and WEP security (optional but recommended) for your ad hoc network.

To set up the HP Photosmart on a wireless
ad hoc network, you need to do the
following:

See this section:

First, collect all of the required materials. “What you need for an ad hoc network”
on page 33

Next, prepare your computer by creating a
network profile.

“Create a network profile for a Windows XP
computer” on page 33
“Create a network profile for other operating
systems” on page 35

Next, run the Wireless Setup Wizard. “Connect to a wireless ad hoc network”
on page 35

Finally, install the software. “Install the software for a network connection”
on page 36

What you need for an ad hoc network
To connect the HP Photosmart to a wireless network, you will need a Windows computer
with a wireless network adapter.

Create a network profile for a Windows XP computer
Prepare your computer for an ad hoc connection by creating a network profile.
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To create a network profile

NOTE: The HP Photosmart comes configured with a network profile with hpsetup
as the network name (SSID). However, for security and privacy HP recommends you
create a new network profile on your computer as described here.

1. In the Control Panel, double-click Network Connections.
2. On the Network Connections window, right-click the Wireless Network

Connection. If you see Enable on the pop-up menu, select it. Otherwise, if you see
Disable on the menu, the wireless connection is already enabled.

3. Right-click the Wireless Network Connection icon, and then click Properties.
4. Click the Wireless Networks tab.
5. Select the Use Windows to configure my wireless network settings check box.
6. Click Add, and then do the following:

a. In Network name (SSID) box, type in a unique network name of your choice.

NOTE: The network name is case sensitive, so it is important to remember
any uppercase (capital) and lowercase (small) letters.

b. If there is a Network Authentication list, select Open. Otherwise, go to the next
step.

c. In the Data encryption list, select WEP.

NOTE: It is possible to create a network that does not use a WEP key.
However, HP recommends using a WEP key in order to secure your network.

d. Make sure that the check box is not selected next to The key is provided for me
automatically. If it is selected, click the check box to clear it.

e. In the Network key box, type a WEP key that has exactly 5 or exactly 13
alphanumeric (ASCII) characters. For example, if you enter 5 characters, you
might enter ABCDE or 12345. Or, if you enter 13 characters, you might enter
ABCDEF1234567. (12345 and ABCDE are examples only. Select a combination
of your choosing.)
Alternatively, you can use HEX (hexadecimal) characters for the WEP key. A HEX
WEP key must be 10 characters for 40 bit encryption, or 26 characters for 128 bit
encryption.

f. In the Confirm network key box, type the same WEP key you typed in the
previous step.

g. Write down the WEP key exactly as you typed it, including uppercase and
lowercase letters.

NOTE: You must remember the exact uppercase (capital) and lowercase
(small) letters. If you enter your WEP key incorrectly on the HP Photosmart,
the wireless connection will fail.

h. Select the check box for This is a computer-to-computer (ad hoc) network;
wireless access points are not used.

i. Click OK to close the Wireless network properties window, and then click OK
again.

j. Click OK again to close the Wireless Network Properties Connection window.
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Related topics
• “Network glossary” on page 50
• “Connect to a wireless ad hoc network” on page 35

Create a network profile for other operating systems
If you have an operating system other than Windows XP, HP recommends that you use
the configuration program that came with your wireless LAN card. To find the
configuration program for your wireless LAN card, access your computer's list of
programs.
Using the LAN card configuration program, create a network profile that has the following
values:

• Network name (SSID): Mynetwork (example only)

NOTE: You should create a network name that is unique and easy for you to
remember. Just remember that the network name is case-sensitive. Therefore,
you must remember which letters are uppercase and lowercase.

• Communication mode: Ad Hoc
• Encryption: enabled

Connect to a wireless ad hoc network
You can use the Wireless Setup Wizard to connect the HP Photosmart to a wireless ad
hoc network.

To connect to a wireless ad hoc network
1. Touch Setup on the display.
2. Touch Network.

NOTE: If the menu option you want is not visible on the screen, touch  or
 to scroll through all the menu options.

3. Touch Wireless Setup Wizard.
This runs the Wireless Setup Wizard. The setup wizard searches for available
networks, and then displays a list of detected network names (SSIDs). The
infrastructure networks appear first in the list, followed by available ad hoc networks.
The networks with the strongest signal appear first, the weakest appear last.

4. On the display, look for the network name you created on your computer (for example,
Mynetwork).

Connect to a network 35

Fi
ni

sh
 s

et
up



5. Touch the network name.
If you found your network name and selected it, go on to step 6.

If you do not see your network name in the list
a. Touch Enter a New Network Name (SSID).

The visual keyboard appears.
b. Enter the SSID. Touch the appropriate letters or numbers on the visual keyboard.

NOTE: You must enter the exact uppercase (capital) and lowercase (small)
letters. Otherwise, the wireless connection will fail.

c. When you have finished entering the new SSID, touch Done on the visual
keyboard, and then touch OK.

TIP: If the HP Photosmart is unable to discover the network based on the
network name you entered, you will see the following prompts. You may want
to move the HP Photosmart closer to the computer and try running the
Wireless Setup Wizard again to automatically discover the network.

d. Touch Ad Hoc.
e. Touch Yes, my network uses WEP encryption. The visual keyboard displays.

If you do not want to use WEP encryption, touch No, my network does not use
encryption. Go to step 7.

6. If prompted, enter your WEP key as follows. Otherwise go to step 7.
a. Touch the appropriate letters or numbers on the visual keyboard.

NOTE: You must enter the exact uppercase (capital) and lowercase (small)
letters. Otherwise, the wireless connection will fail.

b. When you are finished entering the WEP key, touch Done on the visual keyboard.
7. Touch OK again to confirm.

The HP Photosmart will attempt to connect to the SSID. If a message says you
entered an invalid WEP key, check the key you wrote down for your new network,
follow the prompts to correct the WEP key, and then try again.

8. When the HP Photosmart connects successfully to the network, go to your computer
to install the software.

Related topics
• “Enter text using the visual keyboard” on page 13
• “Install the software for a network connection” on page 36
• “Network troubleshooting” on page 125

Install the software for a network connection
Use this section to install the HP Photosmart software on a computer connected to a
network. Before you install the software, make sure you have connected the
HP Photosmart to a network.
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NOTE: If your computer is configured to connect to a series of network drives, make
sure that your computer is currently connected to these drives before installing the
software. Otherwise, HP Photosmart installation software might try to use one of the
reserved drive letters, and you will not be able to access that network drive on your
computer.

NOTE: Installation time can range from 20 to 45 minutes depending on your
operating system, the amount of available space, and the processor speed of your
computer.

To install the Windows HP Photosmart software
1. Quit all applications running on your computer, including any virus detection software.
2. Insert the Windows CD that came with the HP Photosmart into the CD-ROM drive on

your computer and follow the onscreen instructions.
3. If a dialog box about firewalls appears, follow the instructions. If you see firewall pop-

up messages, you must always accept or allow the pop-up messages.
4. On the Connection Type screen, select Through the network, and then click

Next.
The Searching screen appears as the Setup program searches for the
HP Photosmart on the network.

5. On the Printer Found screen, verify that the printer description is correct.
If more than one printer is found on the network, the Printers Found screen appears.
Select the HP Photosmart you want to connect.

6. Follow the prompts to install the software.
When you have finished installing the software, the HP Photosmart is ready for use.

7. If you disabled any virus detection software on your computer, make sure to enable
it again.

8. To test your network connection, go to your computer and print a self-test report to
the HP Photosmart.

Connect to additional computers on a network
You can connect the HP Photosmart to more than one computer on a small network of
computers. If the HP Photosmart is already connected to a computer on a network, for
each additional computer you must install the HP Photosmart software. During installation
of a wireless connection, the software will discover the SSID (network name) of the
existing network. Once you have set up the HP Photosmart on the network you will not
need to configure it again when you add additional computers.

NOTE: You can connect the HP Photosmart to either a wireless or wired network,
but not both at the same time.

Related topics
“Install the software for a network connection” on page 36
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Change the HP Photosmart from a USB connection to a network connection
If you first install the HP Photosmart with a USB connection, you can later change to either
a wireless or Ethernet network connection. If you already understand how to connect to
a network, you can use the general directions below.

NOTE: For optimal performance and security in your wireless network, use an
access point (such as a wireless router) to connect the HP Photosmart.

To change a USB connection to an integrated wireless WLAN 802.11 connection
1. Unplug the USB connection from the back of the HP Photosmart.
2. Touch Setup on the display.
3. Touch Network.

NOTE: If the menu option you want is not visible on the screen, touch  or
 to scroll through all the menu options.

4. Touch Wireless Setup Wizard.
This runs the Wireless Setup Wizard.

5. Install the software for a network connection, choose Add a Device, and then choose
Through the network.

6. When the installation is complete, open Printers and Faxes (or Printers) in the
Control Panel and delete the printers for the USB installation.

To change a USB connection to a wired (Ethernet) connection
1. Unplug the USB connection from the back of the HP Photosmart.
2. Connect an Ethernet cable from the Ethernet port on the back of the HP Photosmart

to an available Ethernet port on the router or switch.
3. Install the software for a network connection, choose Add a Device, and then choose

Through the network.
4. When the installation is complete, open Printers and Faxes (or Printers) in the

Control Panel and delete the printers from the previous USB installation.

For more detailed instructions on connecting the HP Photosmart to a network, see:

• “Wired network setup” on page 27
• “Integrated wireless WLAN 802.11 network setup” on page 29
• “Wireless ad hoc network setup” on page 33

Manage your network settings
You can manage network settings for the HP Photosmart through the HP Photosmart
control panel. Additional advanced settings are available in the Embedded Web Server,
a configuration and status tool you access from your Web browser using an existing
network connection to the HP Photosmart.

This section contains the following topics:

• Change basic network settings from the control panel
• Change advanced network settings from the control panel settings
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• Use the Embedded Web Server
• Network configuration page definitions

Change basic network settings from the control panel
The HP Photosmart control panel enables you to set up and manage a wireless
connection and to perform a variety of network management tasks. This includes viewing
the network settings, restoring the network defaults, turning the wireless radio on and off,
and changing the network settings.

This section contains the following topics:

• Use the Wireless Setup Wizard
• View and print network settings
• Restore network defaults
• Turn the wireless radio on and off
• Print the wireless network test

Use the Wireless Setup Wizard
The Wireless Setup Wizard provides an easy way to set up and manage a wireless
connection to the HP Photosmart.

To run the Wireless Setup Wizard
1. Touch Setup on the display.
2. Touch Network.

NOTE: If the menu option you want is not visible on the screen, touch  or
 to scroll through all the menu options.

3. Touch Wireless Setup Wizard.
This runs the Wireless Setup Wizard.

Related topics
• “Integrated wireless WLAN 802.11 network setup” on page 29
• “Wireless ad hoc network setup” on page 33

View and print network settings
You can display a summary of the network settings on the HP Photosmart control panel,
or you can print a more detailed configuration page. The network configuration page lists
all of the important network settings such as the IP address, link speed, DNS, and mDNS.

To view and print the network settings
1. Touch Setup on the display.
2. Touch Network.

NOTE: If the menu option you want is not visible on the screen, touch  or
 to scroll through all the menu options.
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3. Touch View Network Settings.
4. Do one of the following:

• To display wired network settings, touch Display Wired Summary.
• To display wireless network settings, touch Display Wireless Summary.
• To print the network configuration page, touch Print Network Configuration

Page.

Related topics
“Network configuration page definitions” on page 44

Restore network defaults
You can reset the network settings to what they were when you purchased the
HP Photosmart.

CAUTION: This will erase all wireless setup information that you have entered. In
order to restore this information, you will need to run the Wireless Setup Wizard again.

To restore network defaults
1. Touch Setup on the display.
2. Touch Network.

NOTE: If the menu option you want is not visible on the screen, touch  or
 to scroll through all the menu options.

3. Touch Restore Network Defaults.
4. Touch Yes or No.

Turn the wireless radio on and off
The wireless radio is off by default. In order to stay connected to a wireless network, the
radio must stay on. When the radio is on, the blue light on the front of the HP Photosmart
is lit. However, if the HP Photosmart is connected to a wired network or you have a USB
connection, the radio is not used. In this case you might want to turn the radio off.

To turn the wireless radio on and off
1. Touch Setup on the display.
2. Touch Network.

NOTE: If the menu option you want is not visible on the screen, touch  or
 to scroll through all the menu options.

3. Touch Wireless Radio.
4. Touch On or Off.

Print the wireless network test
The wireless network test performs a series of diagnostic tests to determine whether
network setup is successful. The wireless network test prints automatically when the
Wireless Setup Wizard is run. You also can print the wireless network test at any time.
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To print the wireless test report
1. Touch Setup on the display.
2. Touch Network.

NOTE: If the menu option you want is not visible on the screen, touch  or
 to scroll through all the menu options.

3. Touch Wireless Network Test.
The Wireless Network Test prints.

Related topics
“Network troubleshooting” on page 125

Change advanced network settings from the control panel settings
The advanced network settings are provided for your convenience. However, unless you
are an advanced user, you should not change any of these settings.

This section contains the following topics:

• Set link speed
• Change IP settings

Set link speed
You can change the speed at which data is transmitted over the network. The default is
Automatic.

To set link speed
1. Touch Setup on the display.
2. Touch Network.

NOTE: If the menu option you want is not visible on the screen, touch  or
 to scroll through all the menu options.

3. Touch Advanced Setup.
4. Touch Set Link Speed.
5. Touch the link speed that matches your network hardware.

• Automatic
• 10-Full
• 10-Half
• 100-Full
• 100-Half

Change IP settings
The default setting for the IP settings is Automatic, which sets the IP settings
automatically. However, if you are an advanced user, you might want to manually change
the IP address, subnet mask, or the default gateway. To see the IP address and subnet
mask of the HP Photosmart, print a network configuration page from the HP Photosmart.
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NOTE: When manually entering an IP setting, you must already be connected to an
active network, otherwise the setting will not stay when you exit from the menu.

CAUTION: Be careful when manually assigning an IP address. If you enter an invalid
IP address during the installation, your network components will not be able to connect
with the HP Photosmart.

To change IP settings
1. Touch Setup on the display.
2. Touch Network.

NOTE: If the menu option you want is not visible on the screen, touch  or
 to scroll through all the menu options.

3. Touch Advanced Setup.
4. Touch IP Settings.
5. Touch Manual.
6. Touch one of the following IP settings.

• IP Address
• Subnet Mask
• Default Gateway

7. Touch  or  to change the settings, and then touch OK to confirm the setting.

Related topics
• “View and print network settings” on page 39
• “Network configuration page definitions” on page 44

Use the Embedded Web Server
If your computer is connected to an HP Photosmart on a network, you can access the
Embedded Web Server that resides in the HP Photosmart. The Embedded Web Server
is a web-based user interface that provides some options not available on the
HP Photosmart control panel, including Webscan, a feature that lets you scan photos and
documents from the HP Photosmart to your computer using a Web browser, and
advanced network security options. Also, the Embedded Web Server enables you to
monitor status and order printer supplies.
For information on how to use the features available in the Embedded Web Server,
including Webscan, see the onscreen help within the Embedded Web Server. To access
Embedded Web Server help, open the Embedded Web Server, then click the Help link
under Other Links on the Embedded Web Server Home tab.

NOTE: Use the Embedded Web Server to change network settings not available on
the control panel.

This section contains the following topics:

• Access the Embedded Web Server
• Use the Embedded Web Server setup wizard
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Access the Embedded Web Server
The computer you use to access the Embedded Web Server on the HP Photosmart must
be connected to the same network as the HP Photosmart.

To access the Embedded Web Server
1. Print a network configuration page to find the IP address for the HP Photosmart.
2. In the Address box in your Web browser on your computer, type the IP address of

the HP Photosmart, as shown on the network settings page. For example, http://
192.168.1.101.
The Embedded Web Server Home page appears, showing information for the
HP Photosmart.

NOTE: If you are using a proxy server in your browser, you might need to disable
it to access the Embedded Web Server.

3. If you need to change the language displayed in the Embedded Web Server, do the
following:
a. Click the Settings tab.
b. Click Select Language in the Settings navigation menu.
c. In the Select Language list, click the appropriate language.
d. Click Apply.

4. Click the Home tab to access device and network information, or click the
Networking tab to access more network information or to modify network information.

5. Make any configuration changes.
6. Close the Embedded Web Server.

Related topics
“View and print network settings” on page 39

Use the Embedded Web Server setup wizard
The network setup wizard provided in the Embedded Web Server gives you an intuitive
interface to your network connection parameters.

To access the Embedded Web Server setup wizard
1. Print a network configuration page to find the IP address for the HP Photosmart.
2. In the Address box in your Web browser on your computer, type the IP address of

the HP Photosmart, as shown on the network settings page. For example, http://
192.168.1.101.
The Embedded Web Server Home page appears, showing information for the
HP Photosmart.

NOTE: If you are using a proxy server in your browser, you might need to disable
it to access the Embedded Web Server.

3. Click the Networking tab.
4. Click Wired (802.3) or Wireless (802.11) in the Connections navigation menu.
5. Click Start Wizard, and then follow all of the wizard instructions.
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Related topics
“View and print network settings” on page 39

Network configuration page definitions
The network configuration page shows the network settings for the HP Photosmart. There
are settings for general information, 802.3 wired (Ethernet), 802.11 wireless, and
Bluetooth®.

This section contains the following topics:

• General network settings
• Wired (802.3) network settings
• Wireless (802.11) network settings
• Bluetooth settings

Related topics
• “View and print network settings” on page 39
• “Network glossary” on page 50

General network settings
The following table describes the general network settings shown on the network
configuration page.

Parameter Description

Network Status Status of the HP Photosmart:

• Ready: The HP Photosmart is ready to receive or transmit data.
• Offline: The HP Photosmart is not currently connected to the network.

Active connection
type

Network mode of the HP Photosmart:

• Wired: The HP Photosmart is connected by Ethernet cable to an IEEE
802.3 network.

• Wireless: The HP Photosmart is connected to a wireless (802.11)
network.

• None: There is no network connection.

URL The IP address of the Embedded Web Server.

NOTE: You will need to know this URL when you try to access the
Embedded Web Server.

Firmware
Revision

The internal networking component and device firmware revision code.

NOTE: If you call HP Support, depending on the problem, you might be
asked to provide the firmware revision code.

Hostname The TCP/IP name assigned by the installation software to the device. By
default, this is the letters HP followed by the last 6 digits of the Media Access
Control (MAC) address.
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Parameter Description

Admin Password Status of the administrator's password for the Embedded Web Server:

• Set: Password is specified. You must enter the password to make
changes to the Embedded Web Server parameters.

• Not Set: No password is set. A password is not required for making
changes to the Embedded Web Server parameters.

mDNS Some local and ad hoc networks do not use central DNS servers. They use
a DNS alternative called mDNS.
With mDNS, your computer can find and use any HP Photosmart connected
to your local area network. It can also work with any other Ethernet-enabled
device that appears on the network.

Wired (802.3) network settings
The following table describes the 802.3 wired settings shown on the network configuration
page.

Parameter Description

Hardware
Address (MAC)

The Media Access Control (MAC) address that identifies the HP Photosmart.
This is a unique 12-digit identification number assigned to networking
hardware for identification, including routers, switches, and other such
devices. No two pieces of hardware have the same MAC address.

NOTE: Some Internet service providers (ISPs) require that you register the
MAC address of the Network Card or LAN Adapter that was connected to
your cable or DSL modem during installation.

IP Address This address uniquely identifies the device on the network. IP addresses are
assigned dynamically through DHCP or AutoIP. You can also set up a static
IP address, though this is not recommended.

CAUTION: Be careful when manually assigning an IP address. An invalid
IP address during installation will prevent your network components from
seeing the HP Photosmart.

Subnet Mask A subnet is an IP address assigned by the installation software to make an
additional network available as part of a larger network. Subnets are specified
by a subnet mask. This mask determines which of the HP Photosmart IP
address bits identify the network and subnet, and which bits identify the device
itself.

NOTE: It is recommended that the HP Photosmart and the computers that
use it all reside on the same subnet.

Default Gateway A node on a network that serves as an entrance to another network. A node
in this instance can be a computer or some other device.

NOTE: The address of the default gateway is assigned by the installation
software, unless you have already set a manual ip address.

(continued)
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Parameter Description

Configuration
Source

The protocol used to assign the IP address to the HP Photosmart:

• AutoIP: The installation software automatically determines the
configuration parameters.

• DHCP: The configuration parameters are supplied by a dynamic host
configuration protocol (DHCP) server on the network. On small networks,
this could be a router.

• Manual: The configuration parameters are set manually, such as a static
IP address.

• Not Specified: The mode used when the HP Photosmart is initializing.

DNS server The IP address of the domain name service (DNS) for the network. When you
use the web or send an e-mail message, you use a domain name to do it. For
example, the URL http://www.hp.com contains the domain name hp.com. The
DNS on the Internet translates the domain name into an IP address. Devices
use the IP addresses to refer to one another.

• IP Address: The IP address of the domain name server.
• Not Specified: The IP address is not specified, or the device is initializing.

NOTE: Check to see if a DNS IP address appears on the network
configuration page. If no address is shown, obtain the DNS IP address from
your Internet service provider (ISP).

Link
Configuration

The speed at which data is transmitted over a network. Speeds include 10TX-
Full, 10TX-Half, 100TX-Full, and 100TX-Half. When set to None, networking
is disabled.

Total Packets
transmitted

The number of packets transmitted by the HP Photosmart without error since
it has been turned on. The counter clears after the HP Photosmart is turned
off. When a message is transmitted over a packet-switching network, it is
broken up into packets. Each packet contains the destination address as well
as the data.

Total Packets
received

The number of packets received by the HP Photosmart without error since it
has been turned on. The counter clears after the HP Photosmart is turned off.
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Wireless (802.11) network settings
The following table describes the 802.11 wireless settings shown on the network
configuration page.

Parameter Description

Hardware
Address (MAC)

The Media Access Control (MAC) address that identifies the HP Photosmart.
This is a unique 12-digit identification number assigned to networking
hardware for identification, including wireless access points, routers, and
other such devices. No two pieces of hardware have the same MAC address.
Two MAC addresses are assigned: one for wired Ethernet and one for
wireless 802.11.

NOTE: Some Internet service providers (ISPs) require that you register the
MAC address of the Network Card or LAN Adapter that was connected to
your cable or DSL modem during installation.

IP Address This address uniquely identifies the device on the network. IP addresses are
assigned dynamically through DHCP or AutoIP. You can also set up a static
IP address, though this is not recommended.

NOTE: Manually assigning an invalid IP address during installation will
prevent your network components from seeing the HP Photosmart.

Subnet Mask A subnet is an IP address assigned by the installation software to make an
additional network available as part of a larger network. Subnets are specified
by a subnet mask. This mask determines which of the HP Photosmart IP
address bits identify the network and subnet, and which bits identify the device
itself.

NOTE: It is recommended that the HP Photosmart and the computers that
use it all reside on the same subnet.

Default Gateway A node on a network that serves as an entrance to another network. A node
in this instance can be a computer or some other device.

NOTE: The address of the default gateway is assigned by the installation
software.

Configuration
Source

The protocol used to assign the IP address to the HP Photosmart:

• AutoIP: The installation software automatically determines the
configuration parameters.

• DHCP: The configuration parameters are supplied by a dynamic host
configuration protocol (DHCP) server on the network. On small networks,
this could be a router.

• Manual: The configuration parameters are set manually, such as a static
IP address.

• Not Specified: The mode used when the HP Photosmart is initializing.

DNS server The IP address of the domain name service (DNS) for the network. When you
use the Web or send an e-mail message, you use a domain name to do it.
For example, the URL http://www.hp.com contains the domain name hp.com.
The DNS on the Internet translates the domain name into an IP address.
Devices use the IP addresses to refer to one another.

• IP Address: The IP address of the domain name server.
• Not Specified: The IP address is not specified, or the device is initializing.
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Parameter Description

NOTE: Check to see if a DNS IP address appears on the network
configuration page. If no address is shown, obtain the DNS IP address from
your Internet service provider (ISP).

Wireless Status Status of the wireless network:

• Connected: The HP Photosmart is connected to a wireless LAN and
everything is working.

• Disconnected: The HP Photosmart is not connected to the wireless LAN
due to incorrect settings (such as the wrong WEP key), the
HP Photosmart is out of range, or an Ethernet cable is plugged in and
connected to an active network.

• Disabled: The radio is turned off.
• Not applicable: This parameter does not apply to this network type.

Communication
Mode

An IEEE 802.11 networking framework in which devices or stations
communicate with each other:

• Infrastructure: The HP Photosmart communicates with other network
devices through a wireless access point, such as a wireless router or
base station.

• Ad hoc: The HP Photosmart communicates directly with each device on
the network. No wireless router or access point is used. This is also called
a peer-to-peer network.

• Not applicable: This parameter does not apply to this network type.

Network Name
(SSID)

Service Set Identifier. A unique identifier (up to 32 characters) that
differentiates one wireless local area network (WLAN) from another. The
SSID is also referred to as the network name. This is the name of the network
to which the HP Photosmart is connected.

Signal Strength
(1-5)

The transmitting or return signal graded on a scale of 1 to 5:

• 5: Excellent
• 4: Good
• 3: Fair
• 2: Poor
• 1: Marginal
• No signal: No signal detected on the network.
• Not applicable: This parameter does not apply to this network type.

Channel The channel number currently being used for wireless communication. This
depends on the network in use, and might differ from the requested channel
number. Value is from 1 to 14; countries/regions might limit the range of
approved channels.

• (number): Value ranging from 1 to 14, depending on country/region.
• None: No channel is in use.
• Not Applicable: The WLAN is disabled or this parameter does not apply

to this network type.

NOTE: In ad hoc mode, if you are not able to receive or transmit data
between your computer and the HP Photosmart, make sure that you are using
the same communication channel on your computer and the HP Photosmart.
In infrastructure mode, the channel is dictated by the access point.
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Parameter Description

Authentication
type

Type of authentication in use:

• None: No authentication in use.
• Open System (ad hoc and infrastructure): No authentication
• Shared Key: WEP key is required.
• WPA-PSK (infrastructure only): WPA with Pre-Shared Key.
• Not applicable: This parameter does not apply to this network type.

Authentication verifies the identity of a user or device before granting access
to the network, making it more difficult for unauthorized users to access
network resources. This security method is common on wireless networks.
A network using Open System authentication does not screen network users
based on their identities. Any wireless user can have access from the network.
However, such a network might use WEP (Wired Equivalent Privacy)
encryption to provide a first level of security against casual eavesdroppers.
A network using Shared Key authentication provides increased security by
requiring users or devices to identify themselves with a static key (a
hexadecimal or alphanumeric string). Every user or device on the network
shares the same key. WEP encryption is used along with shared key
authentication, using the same key for both authentication and encryption.
A network using server-based (WPA-PSK) authentication provides
significantly stronger security, and is supported in most wireless access
points and wireless routers. The access point or router verifies the identity of
a user or device requesting access to the network before granting that access.
Several different authentication protocols might be used on an authentication
server.

Encryption The type of encryption in use on the network:

• None: No encryption is in use.
• 64-bit WEP: A 5-character or 10-hex-digit WEP key is in use.
• 128-bit WEP: A 13-character or 26-hex-digit WEP key is in use.
• WPA-AES: Advanced Encryption Standard encryption is in use. This is

an encryption algorithm for securing sensitive but unclassified material
by US Government agencies.

• WPA-TKIP: Temporal Key Integrity Protocol, an advanced encryption
protocol, is in use.

• Automatic: AES or TKIP is in use.
• Not applicable: This parameter does not apply to this network type.

WEP aims to provide security by encrypting data over radio waves so that it
is protected as it is transmitted from one end point to another. This security
method is common on wireless networks.

Access Point HW
Address

The hardware address of the wireless router or access point on the network
to which the HP Photosmart is connected:

• (MAC address): The unique MAC (Media Access Control) hardware
address of the access point.

• Not applicable: This parameter does not apply to this network type.

Total Packets
transmitted

The number of packets transmitted by the HP Photosmart without error since
it has been turned on. The counter clears after the HP Photosmart is turned
off. When a message is transmitted over a packet-switching network, it is
broken up into packets. Each packet contains the destination address as well
as the data.

(continued)
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Parameter Description

Total Packets
received

The number of packets received by the HP Photosmart without error since it
has been turned on. The counter clears after the HP Photosmart is turned off.

Bluetooth settings
The following table describes the Bluetooth settings shown on the network configuration
page.

Parameter Description

Device Address The hardware address of the Bluetooth device.

Device Name The device name assigned to the printer, which can identify it on a Bluetooth
device.

Passkey A value that the user must enter in order to print via Bluetooth.

Visibility Shows whether or not the HP Photosmart is visible to Bluetooth devices that
are within range.

• Visible to all: Any Bluetooth device within range can print to the
HP Photosmart.

• Not visible: Only Bluetooth devices that have stored the device address
of the HP Photosmart can print to it.

Security The level of security set for an HP Photosmart connected by Bluetooth.

• Low: The HP Photosmart does not require a passkey. Any Bluetooth
device within range can print to it.

• High: The HP Photosmart requires a passkey from the Bluetooth device
before allowing the device to send a print job.

Network glossary

access point A network router that has wireless capability.

ASCII American Standard Code for Information Interchange. The standard for
numbers used by computers to represent all the uppercase and lowercase
Latin letters, numbers, punctuation, etc.

AutoIP A feature of the installation software, which determines the configuration
parameters of devices on the network.

DHCP Dynamic Host Configuration Protocol. A server on the network that supplies
configuration parameters to devices on the network. On small networks, this
could be a router.

DNS Domain Name Service. When you use the Web or send an e-mail message,
you use a domain name to do it. For example, the URL http://www.hp.com
contains the domain name hp.com. The DNS on the Internet translates the
domain name into an IP address. Devices use the IP addresses to refer to
one another.

DNS-SD See DNS. The SD portion stands for Service Discovery. This is part of a
protocol developed by Apple that enables automatic discovery of computers,
devices, and services on IP networks.

DSL Digital Subscriber Line. A high-speed connection to the Internet.
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Ethernet The most common local network technology that connects computers using
copper cabling.

Ethernet cable The cable used to connect network elements in a wired network. The CAT-5
Ethernet cable is also known as a straight-through cable. When using an
Ethernet cable, the network elements must be attached to a router. An
Ethernet cable uses an RJ-45 connector.

EWS Embedded Web Server. A browser-based utility that provides a simple way
to manage the HP Photosmart. You can monitor status, configure
HP Photosmart networking parameters, or access HP Photosmart features.

Gateway A computer or other device, such as a router, that serves as an entrance to
the Internet or another network.

HEX Hexadecimal. The base 16 numbering system, which uses the digits 0-9 plus
the letters A-F.

host computer The computer at the center of a network.

Hostname The TCP/IP name assigned by the installation software to the device. By
default, this is the letters HP followed by the last 6 digits of the Media Access
Control (MAC) address.

hub No longer commonly used in modern home networks, a hub takes its signal
from each computer and sends it to all of the other computers connected to
the hub. Hubs are passive; other devices on the network plug into the hub in
order to communicate with one another. A hub does not manage the network.

IP address A number that uniquely identifies the device on the network. IP addresses
are assigned dynamically through DHCP or AutoIP. You can also set up a
static IP address, though this is not recommended.

MAC address Media Access Control (MAC) address that uniquely identifies the
HP Photosmart. This is a unique 12-digit identification number assigned to
networking hardware for identification. No two pieces of hardware have the
same MAC address.

network name The SSID or network name identifies a wireless network.

NIC Network Interface Card. A card on your computer that provides an Ethernet
connection so that you can connect your computer to a network.

RJ-45 connector The connector on the ends of an Ethernet cable. Although standard Ethernet
cable connectors (RJ-45 connectors) look similar to standard telephone
cable connectors, they are not interchangeable. An RJ-45 connector is wider
and thicker and always has 8 contacts on the end. A phone connector has
between 2 and 6 contacts.

router A router provides a bridge between two or more networks. A router can link
a network to the Internet, link two networks and connect both to the Internet,
and help secure networks through the use of firewalls and assigning dynamic
addresses. A router can also act as a gateway, while a switch cannot.

SSID The SSID or network name identifies a wireless network.

switch A switch makes it possible for several users to send information over a
network at the same time without slowing each other down. Switches allow
different nodes (a network connection point, typically a computer) of a
network to communicate directly with one another.

WEP Wired Equivalent Privacy (WEP) is a type of encryption used for wireless
network security.
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WPA Wi-Fi Protected Access (WPA) is a type of encryption used for wireless
network security. WPA offers greater security than WEP.
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5 How do I?
This section contains links to commonly performed tasks, such as printing and sharing
photos.

• “How do I print 10 x 15 cm (4 x 6 inch) borderless photos from a memory card?”
on page 87

• “How do I print 13 x 18 cm (5 x 7 inch) or larger size photos from a memory card?”
on page 87

• “How do I create special projects from the photos on my memory card?”
on page 89

• “How do I save photos to my computer?” on page 91
• “How do I share my photos with family and friends?” on page 90
• “How do I print on both sides of the paper?” on page 75
• “How do I print wide-rule notebook paper and graph paper for my child's homework

project?” on page 100
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6 Load paper
You can load many different types and sizes of paper in the HP Photosmart, including
letter or A4 paper, photo paper, transparencies, envelopes, and HP CD/DVD tattoo labels.
By default, the HP Photosmart is set to detect the size and type of paper you load in the
input tray automatically and then adjust its settings to generate the highest quality output
for that paper.

If you are using special papers, such as photo paper, transparency films, envelopes, or
labels, or if you experience poor print quality using the Automatic setting, you can
manually set the paper size and type for the print jobs.

This section contains the following topics:

• Choose papers for printing
• Load paper
• Avoid paper jams

Choose papers for printing
You can use different types and sizes of paper in the HP Photosmart. Review the following
recommendations to get the best printing quality. Whenever you change paper types or
sizes, remember to change those settings.

This section contains the following topics:

• Recommended papers for printing
• Papers to avoid

Recommended papers for printing
If you want the best print quality, HP recommends using HP papers that are specifically
designed for the type of project you are printing. Using paper that is too thin or too thick,
paper that has a slick texture, or paper that stretches easily can cause paper jams. Using
paper that has a heavy texture or does not accept ink can cause printed images to smear,
bleed, or not fill in completely.

Depending on your country/region, some of these papers might not be available.

HP Premium Plus Photo Paper
HP Premium Plus Photo Papers are the best HP photo paper, with image quality and
fade resistance superior to store-processed photos. They are ideal for printing your high-
resolution images for framing or including in a photo album. These papers are available
in several sizes, including 10 x 15 cm (4 x 6 inch) (with or without tabs), A4, and 8.5 x 11
inch sizes for printing or copying photos from the HP Photosmart.

HP Premium Photo Paper
HP Premium Photo Papers are high-quality, glossy-finish or soft gloss-finish photo
papers. They look and feel like store-processed photos and can be mounted under glass
or in an album. These papers are available in several sizes, including 10 x 15 cm (4 x 6
inch) (with or without tabs), A4, and 8.5 x 11 inch sizes for printing or copying photos from
the HP Photosmart.
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HP Advanced Photo Paper or HP Photo Paper
HP Advanced Photo Paper or HP Photo Paper is a sturdy, glossy photo paper that
features an instant-dry finish for easy handling without smudging. It resists water, smears,
fingerprints, and humidity. Your prints have a look and feel comparable to a store-
processed photo. It is available in several sizes, including A4, 8.5 x 11 inch, and 10 x 15
cm (4 x 6 inch) (with or without tabs) for printing or copying photos from the
HP Photosmart. HP Advanced Photo Paper is marked on the nonprinting corners with
the following symbol.

HP Premium Inkjet Transparency Film and HP Premium Plus Inkjet Transparency
Film
HP Premium Inkjet Transparency Film and HP Premium Plus Inkjet Transparency Film
make your color presentations vivid and even more impressive. This film is easy to use
and handle and dries quickly without smudging.

HP Premium Inkjet Paper
HP Premium Inkjet Paper is the ultimate coated paper for high-resolution usage. A
smooth, matte finish makes it ideal for your highest-quality documents.

HP Bright White Inkjet Paper
HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque
enough for two-sided color usage with no show-through, which makes it ideal for
newsletters, reports, and flyers.

HP All-in-One Paper or HP Printing Paper
• HP All-in-One Paper is specifically designed for HP Photosmart devices. It has an

extra bright blue-white shade that produces sharper text and richer colors than
ordinary multifunction papers.

• HP Printing Paper is a high-quality multifunction paper. It produces documents that
look and feel more substantial than documents printed on standard multipurpose or
copy paper.

HP Iron-On Transfers
HP Iron-On Transfers (for color fabrics or for light or white fabrics) are the ideal solution
for creating custom T-shirts from your digital photos.

HP Premium Photo Cards
HP Premium Photo Cards enable you to make your own greeting cards.

HP Brochure & Flyer Paper
HP Brochure & Flyer Paper (Gloss or Matte) is glossy-coated or matte-coated on both
sides for two-sided use. They are the perfect choice for near-photographic reproductions
and business graphics for report covers, special presentations, brochures, mailers, and
calendars.
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HP Premium Presentation Paper
HP Premium Presentation Paper gives your presentation a quality look and feel.

HP CD/DVD Tattoos
HP CD/DVD Tattoos allow you to personalize your CDs and DVDs by printing high-
quality, low-cost CD or DVD labels.
To order genuine HP supplies for the HP Photosmart, go to www.hp.com/buy/supplies.
If prompted, choose your country/region, follow the prompts to select your product, and
then click one of the shopping links on the page.

Papers to avoid
Using paper that is too thin or too thick, paper that has a slick texture, or paper that
stretches easily can cause paper jams. Using paper that has a heavy texture or does not
accept ink can cause printed images to smear, bleed, or not fill in completely.

Papers to avoid for all print jobs
• Any size paper other than those listed in “Specifications” on page 175 or in the printer

driver.

NOTE: For a complete list of supported media sizes, see the printer driver.

• Paper with cutouts or perforations (unless specifically designed for use with HP inkjet
devices).

• Highly textured stock, such as linen. It might not print evenly, and the ink can bleed
into these papers.

• Extremely smooth, shiny, or coated papers not specifically designed for the
HP Photosmart. They can jam the HP Photosmart or repel the ink.

• Multi-part forms, such as duplicate and triplicate forms. They can wrinkle or get stuck,
and the ink is more likely to smear.

• Envelopes with clasps or windows. They can get stuck in the rollers and cause paper
jams.

• Banner paper.

Load paper
This section describes the procedure for loading different types and sizes of paper into
the HP Photosmart for your printouts.

TIP: To help prevent rips, wrinkles, and curled or bent edges, store all paper flat in
a resealable bag. If the paper is not stored properly, extreme changes in temperature
and humidity might result in curled paper that does not work well in the
HP Photosmart.

This section contains the following topics:

• Load full-size paper
• Load 10 x 15 cm (4 x 6 inch) photo paper
• Load index cards
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• Load envelopes
• Load other types of paper

Load full-size paper
You can load many types of letter or A4 paper into the main input tray of the
HP Photosmart.

To load full-size paper
1. Pull out the main input tray, and then slide the paper-width and paper-length guides

to their outermost positions.

2. Tap a stack of paper on a flat surface to align the edges, and then check the paper
for the following:
• Make sure it is free of rips, dust, wrinkles, and curled or bent edges.
• Make sure all the paper in the stack is the same size and type.
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3. Insert the stack of paper into the main input tray with the short edge forward and the
print side down. Slide the stack of paper forward until it stops.

CAUTION: Make sure that the HP Photosmart is idle and silent when you load
paper into the main input tray. If the HP Photosmart is servicing the ink cartridges
or otherwise engaged in a task, the paper stop inside the device might not be in
place. You could push the paper too far forward, causing the HP Photosmart to
eject blank pages.

TIP: If you are using letterhead, insert the top of the page first with the print side
down. For more help on loading full-size paper and letterhead, refer to the diagram
engraved in the base of the main input tray.

4. Slide the paper-width and paper-length guides inward until they stop at the edges of
the paper.
Do not overload the main input tray; make sure the stack of paper fits within the main
input tray and is no higher than the top of the paper-width guide.
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5. Push the main input tray back into the HP Photosmart.
6. Pull the output tray extender toward you, as far as it will go.

NOTE: When you use legal-size paper, leave the tray extender closed.

Load 10 x 15 cm (4 x 6 inch) photo paper
You can load up to 10 x 15 cm (4 x 6 inch) photo paper into the photo tray of the
HP Photosmart. For the best results, use 10 x 15 cm (4 x 6 inch) HP Premium Plus Photo
Paper or HP Premium Photo Paper.

To load 10 x 15 cm (4 x 6 inch) photo paper in the photo tray
1. Raise the output tray, and then pull out the photo tray.

2. Insert the stack of photo paper into the photo tray with the short edge forward and the
print side down. Slide the stack of photo paper forward until it stops.
If the photo paper you are using has perforated tabs, load the photo paper so that the
tabs are closest to you.
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3. Slide the paper-length and paper-width guides inward against the stack of photo
paper until the guides stop.
Do not overload the photo tray; make sure the stack of photo paper fits within the
photo tray and is no higher than the top of the paper-width guide.

4. Push in the photo tray, and then lower the output tray.

Related topics
• “Recommended papers for printing” on page 55
• “Print your photos” on page 87
• “Print a borderless image” on page 72
• “Print a photo on photo paper” on page 73

Load index cards
You can load index cards into the photo tray of the HP Photosmart to print notes, recipes,
and other text.

For best results, set the paper type and paper size before printing.

To load index cards in the photo tray
1. Raise the output tray, and then pull out the photo tray.

2. Insert the stack of cards into the photo tray with the short edge forward and the print
side down. Slide the stack forward until it stops.
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3. Slide the paper-length and paper-width guides inward against the stack of cards until
the guides stop.
Do not overload the photo tray; make sure the stack of cards fits within the photo tray
and is no higher than the top of the paper-width guide.

4. Push in the photo tray, and then lower the output tray.

Related topics
• “Load 10 x 15 cm (4 x 6 inch) photo paper” on page 60
• “Change the print settings for the current job” on page 66

Load envelopes
You can load one or more envelopes into the main input tray of the HP Photosmart. Do
not use shiny or embossed envelopes or envelopes that have clasps or windows.

NOTE: For specific details on how to format text for printing on envelopes, consult
the help files in your word processing software. For best results, consider using a label
for the return address on envelopes.

To load envelopes
1. Pull out the main input tray to load envelopes.
2. Remove all paper from the main input tray.
3. Insert one or more envelopes into the far-right side of the main input tray, with the

envelope flaps on the left and facing up. Slide the stack of envelopes forward until it
stops.
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4. Slide the paper-width guide inward against the stack of envelopes until it stops.
Do not overload the main input tray; make sure the stack of envelopes fits within the
main input tray and is not higher than the top of the paper-width guide.

5. Push the main input tray back into the HP Photosmart.
6. Pull the output tray extender towards you, as far as it will go.

Load other types of paper
The following types of paper are designed for special projects. Create your project in the
HP Photosmart Software or another application, set the paper type and size, and then
print.

HP Premium Inkjet Transparency Film and HP Premium Plus Inkjet Transparency
Film
▲ Insert the film so that the white transparency strip (with arrows and the HP logo) is on

top and is going into the input tray first.

NOTE: For best results, set the paper type to transparency film before printing
on transparency film.

HP Iron-On Transfers
1. Flatten the transfer sheet completely before using it; do not load curled sheets.

TIP: To prevent curling, keep transfer sheets sealed in the original package until
you are ready to use them.

2. Locate the blue stripe on the nonprinting side of the transfer paper and then manually
feed one sheet at a time into the input tray with the blue stripe facing up.

HP Greeting Cards, HP Photo Greeting Cards, or HP Textured Greeting Cards
▲ Insert a small stack of HP greeting card paper into the input tray with the print side

down; slide the stack of cards forward until it stops.

TIP: Make sure the area on which you want to print is inserted first, print side
down in the input tray.

HP Inkjet labels
1. Always use letter or A4 label sheets designed for use with HP inkjet devices (such as

HP inkjet labels), and make sure that the labels are no more than two years old. Labels
on older sheets might peel off when the paper is pulled through the HP Photosmart,
causing subsequent paper jams.

2. Fan the stack of labels to make sure none of the pages are sticking together.
3. Place a stack of label sheets on top of full-size plain paper in the input tray, label side

down. Do not insert labels one sheet at a time.
For best results, set the paper type and paper size before printing.
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HP CD/DVD Tattoo labels
▲ Place one sheet of CD/DVD tattoo paper in the input tray with the print side down;

slide the CD/DVD tattoo paper forward until it stops.

NOTE: When you use CD/DVD tattoo labels, leave the tray extender closed.

Related topics
• “Load 10 x 15 cm (4 x 6 inch) photo paper” on page 60
• “Change the print settings for the current job” on page 66

Avoid paper jams
To help avoid paper jams, follow these guidelines.

• Remove printed papers from the output tray frequently.
• Prevent curled or wrinkled paper by storing all unused paper flat in a resealable bag.
• Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.
• Do not combine different paper types and paper sizes in the input tray; the entire stack

of paper in the input tray must be the same size and type.
• Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure

the paper-width guide does not bend the paper in the input tray.
• Do not force paper too far forward in the input tray.
• Use paper types that are recommended for the HP Photosmart. For more information,

see “Choose papers for printing” on page 55.
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7 Print from your computer
The HP Photosmart can be used with any software application that allows printing. You
can print a range of projects, such as borderless images, newsletters, greeting cards,
iron-on transfers, and posters.
This section contains the following topics:

• Print from a software application
• Make the HP Photosmart the default printer
• Change the print settings for the current job
• Change the default print settings
• Printing shortcuts
• Perform special print jobs
• Stop a print job

Print from a software application
Most print settings are automatically handled by the software application. You need to
change the settings manually only when you change print quality, print on specific types
of paper or transparency film, or use special features.

To print from a software application
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Select the HP Photosmart as the printer.

If you set the HP Photosmart as the default printer, you can skip this step. The
HP Photosmart will already be selected.

4. If you need to change settings, click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

NOTE: When printing a photo, you must select options for the specific photo
paper and photo enhancement.

5. Select the appropriate options for your print job by using the features available in the
Advanced, Printing Shortcuts, Features, and Color tabs.

TIP: You can easily select the appropriate options for your print job by choosing
one of the predefined print tasks on the Printing Shortcuts tab. Click a type of
print task in the Printing Shortcuts list. The default settings for that type of print
task are set and summarized on the Printing Shortcuts tab. If necessary, you
can adjust the settings here and save your custom settings as a new printing
shortcut. To save a custom printing shortcut, select the shortcut and click Save
As. To delete a shortcut, select the shortcut and click Delete.

6. Click OK to close the Properties dialog box.
7. Click Print or OK to begin printing.
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Make the HP Photosmart the default printer
You can set the HP Photosmart as the default printer to use from all software applications.
This means that the HP Photosmart is automatically selected in the printer list when you
select Print from the File menu in a software application. The default printer is
automatically selected when you click the Print button in the toolbar of most software
applications. For more information, see the Windows Help.

Change the print settings for the current job
You can customize the print settings of the HP Photosmart to handle nearly any print
task.

This section contains the following topics:

• Set the paper size
• Set the paper type for printing
• View the print resolution
• Change the print speed or quality
• Change the page orientation
• Scale the document size
• Change the saturation, brightness, or color tone
• Preview your print job

Set the paper size
The Size setting helps the HP Photosmart determine the printable area on the page.
Some of the paper size choices have a borderless equivalent, which allows you to print
to the top, bottom, and side edges of the paper.

Usually, you set the paper size in the software application you used to create your
document or project. However, if you are using custom-size paper, or if you cannot set
the paper size from your software application, you can change the paper size in the
Properties dialog box before printing.

To set the paper size
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Resizing Options area, click the appropriate paper size from the Size list.

The following table lists the suggested paper size settings for the different types of
paper you can load in the input tray. Make sure to look at the long list of choices in
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the Size list to see if a defined paper size already exists for the type of paper you are
using.

Paper type Suggested paper size settings

CD/DVD tattoo paper 5 x 7 in.

Copier, multi-purpose, or
plain papers

Letter or A4

Envelopes Appropriate listed envelope size

Greeting-card papers Letter or A4

Index cards Appropriate listed card size (if listed sizes are not appropriate,
you can specify a custom paper size)

Inkjet papers Letter or A4

Iron-on T-shirt transfers Letter or A4

Labels Letter or A4

Legal Legal

Letterhead Letter or A4

Panorama photo paper Appropriate listed panorama size (if listed sizes are not
appropriate, you can specify a custom paper size)

Photo papers 10 x 15 cm. (with or without tab), 4 x 6 in. (with or without tab),
letter, A4, or appropriate listed size

Transparency films Letter or A4

Custom-size papers Custom paper size

Set the paper type for printing
If you print on special papers, such as photo paper, transparency film, envelopes, or
labels, or if you experience poor print quality, you can set the paper type manually.

To set the paper type for printing
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Basic Options area, click the appropriate paper type from the Paper Type list.

View the print resolution
The printer software displays the print resolution in dots per inch (dpi). The dpi varies
according to the paper type and print quality that you select in the printer software.
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To view the print resolution
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Print Quality drop-down list, select the appropriate print quality setting for your

project.
7. In the Paper Type drop-down list, select the type of paper that you have loaded.
8. Click the Resolution button to view the print resolution dpi.

Change the print speed or quality
The HP Photosmart automatically chooses a print quality and speed setting depending
on the paper type setting you select. You can also change the print quality setting to
customize the speed and quality of the print process.

To select a print speed or quality
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Print Quality drop-down list, select the appropriate quality setting for your

project.

NOTE: To view the maximum dpi that the HP Photosmart will print, click
Resolution.

7. In the Paper Type drop-down list, select the type of paper that you have loaded.

Change the page orientation
The page orientation setting allows you to print your document vertically or horizontally
on the page.

Usually, you set the page orientation in the software application you used to create your
document or project. However, if you are using custom-size or special HP paper, or if you
cannot set the page orientation from your software application, you can change the page
orientation in the Properties dialog box before printing.

To change the page orientation
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
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3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Basic Options area, click one of the following:

• Click Portrait to print the document vertically on the page.
• Click Landscape to print the document horizontally on the page.

Scale the document size
The HP Photosmart allows you to print the document at a different size than the original.

To scale the document size
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Resizing options area, click Scale to paper size, and then click the

appropriate paper size from the drop-down list.

Change the saturation, brightness, or color tone
You can change the intensity of colors and the level of darkness in your printout by
adjusting the Saturation, Brightness, or Color Tone options.

To change the saturation, brightness, or color tone
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Color tab.

Preview your print job
You can preview your print job before sending it to the HP Photosmart. This helps to
prevent wasting paper and ink on projects that do not print as expected.

To preview your print job
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
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4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Select the print settings appropriate for your project on each of the tabs in the dialog
box.

6. Click the Features tab.
7. Select the Show Preview Before Printing check box.
8. Click OK, and then click Print or OK in the Print dialog box.

Your print job displays in the preview window.
9. In the HP preview window, do one of the following:

• To print, click Start Printing.
• To cancel, click Cancel Printing.

Change the default print settings
If there are settings that you frequently use for printing, you might want to make them the
default print settings so they are already set when you open the Print dialog box from
within your software application.

To change the default print settings
1. In the HP Solution Center, click Settings, point to Print Settings, and then click

Printer Settings.
2. Make changes to the print settings, and click OK.

Printing shortcuts
Use printing shortcuts to print with print settings that you use often. The printer software
has several specially designed printing shortcuts that are available in the Printing
Shortcuts list.

NOTE: When you select a printing shortcut the appropriate printing options are
automatically displayed. You can leave them as is, change them, or create your own
shortcuts for commonly used tasks.

Use the Printing Shortcuts tab for the following print tasks:

• General Everyday Printing: Print documents quickly.
• Photo Printing–Borderless: Print to the top, bottom, and side edges of 10 x 15 cm

(4 x 6 inch) HP Photo Papers with or without a tear-off tab.
• Photo Printing–With White Borders: Print a photo with a white border around the

edges.
• Fast/Economical printing: Produce draft-quality printouts quickly.
• Presentation printing: Print high-quality documents, including letters and

transparencies.
• Two-sided (Duplex) Printing: Print two-sided pages with the HP Photosmart.
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This section contains the following topics:

• Create printing shortcuts
• Delete printing shortcuts

Related topics
• “Print a borderless image” on page 72
• “Print a photo on photo paper” on page 73
• “Print on transparencies” on page 79
• “Print on both sides of the page” on page 75

Create printing shortcuts
In addition to the printing shortcuts that are available in the Printing Shortcuts list, you
can create your own printing shortcuts.

If you frequently print on transparency film, for example, you can create a printing shortcut
by selecting the Presentation Printing shortcut, changing the paper type to HP Premium
Inkjet Transparency Film, and then saving the modified shortcut under a new name; for
example, Transparency Presentations. After creating the printing shortcut, simply
select it when printing on transparency film rather than changing the print settings each
time.

To create a printing shortcut
1. On the File menu in your software application, click Print.
2. Make sure the HP Photosmart is the selected printer.
3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

4. Click the Printing Shortcuts tab.
5. In the Printing Shortcuts list, click a printing shortcut.

The print settings for the selected printing shortcut are displayed.
6. Change the print settings to those you want in the new printing shortcut.
7. In the Type new shortcut name here box, type a name for the new printing shortcut,

and then click Save.
The printing shortcut is added to the list.

Delete printing shortcuts
You might want to delete printing shortcuts that you no longer use.

To delete a printing shortcut
1. On the File menu in your software application, click Print.
2. Make sure the HP Photosmart is the selected printer.
3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

4. Click the Printing Shortcuts tab.
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5. In the Printing Shortcuts list, click the printing shortcut that you want to delete.
6. Click Delete.

The printing shortcut is removed from the list.

NOTE: Only the shortcuts that you have created can be deleted. The original HP
shortcuts cannot be deleted.

Perform special print jobs
In addition to supporting standard print jobs, the HP Photosmart can perform special jobs
such as printing borderless images, iron-on transfers, and posters.
This section contains the following topics:

• Print a borderless image
• Print a photo on photo paper
• Print custom CD/DVD labels
• Print using Maximum dpi
• Print on both sides of the page
• Print a multiple-page document as a booklet
• Print multiple pages on a single sheet
• Print a multiple-page document in reverse order
• Reverse an image for iron-on transfers
• Print on transparencies
• Print a group of addresses on labels or envelopes
• Print a poster
• Print a Web page

Print a borderless image
Borderless printing lets you print to the top, bottom, and side edges of 10 x 15 cm (4 x 6
inch) photo paper.

TIP: For the best results, use HP Premium Photo Papers or HP Premium Plus Photo
Papers to print your photos.

To print a borderless image
1. Load up to 10 x 15 cm (4 x 6 inch) paper in the photo tray or full-size photo paper in

the main input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
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6. In the Size list, click the size of photo paper loaded in the photo tray.
If a borderless image can be printed on the specified size, the Borderless printing
check box is enabled.

7. In the Paper Type drop-down list, click More, and then select the appropriate paper
type.

NOTE: You cannot print a borderless image if the paper type is set to Plain
paper or to a type of paper other than a photo paper.

8. Select the Borderless printing check box if it is not already checked.
If the borderless paper size and paper type are not compatible, the HP Photosmart
software displays an alert and allows you to select a different type or size.

9. Click OK, and then click Print or OK in the Print dialog box.

Print a photo on photo paper
For high-quality photo printing, HP recommends you use HP Premium Plus Photo
Papers with the HP Photosmart.

To print a photo on photo paper
1. Remove all paper from the input tray, and then load the photo paper print side down.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Basic Options area, select the appropriate photo paper type from the Paper

Type drop-down list.
7. In the Resizing Options area, click the appropriate paper size from the Size list.

If the paper size and paper type are not compatible, the HP Photosmart software
displays an alert and allows you to select a different type or size.

8. In the Basic Options area, select a high print quality, such as Best or Maximum
dpi from the Print Quality drop-down list.

9. In the HP Real Life technologies area, click the Photo fix drop-down list and select
from the following options:
• Off: applies no HP Real Life technologies to the image.
• Basic: automatically focuses the image; moderately adjusts image sharpness.
• Full: automatically lightens dark images; automatically adjusts sharpness,

contrast, and focus of images; automatically removes red-eye.
10. Click OK to return to the Properties dialog box.
11. If you want to print the photo in black and white, click the Color tab and select the

Print in grayscale check box.
12. Click OK, and then click Print or OK in the Print dialog box.
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NOTE: Do not leave unused photo paper in the input tray. The paper might start to
curl, which could reduce the quality of your printout. Photo paper should be flat before
printing.

Print custom CD/DVD labels 
You can use the HP Photosmart Software or online templates from the HP Web site to
create and print a custom label on CD/DVD tattoo paper. You can affix the printed CD/
DVD tattoo to any CD/DVD.

To print a CD/DVD tattoo
1. Use the HP Photosmart Software, or go to www.hp.com to access templates for

creating CD/DVD labels.
2. Load 13 x 18 cm (5 x 7 inch) CD/DVD tattoo paper in the main input tray.
3. On the File menu in your software application, click Print.
4. Make sure the HP Photosmart is the selected printer.
5. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

6. Click the Features tab.
7. In the Paper Type drop-down list, click More, and then select HP CD/DVD tattoo

paper from the list.
8. Click OK, and then click Print or OK in the Print dialog box.

Print using Maximum dpi
Use Maximum dpi mode to print high-quality, sharp images.

To get the most benefit from Maximum dpi mode, use it to print high-quality images such
as digital photographs. When you select the Maximum dpi setting, the printer software
displays the optimized dots per inch (dpi) that the HP Photosmart will print.

Printing in Maximum dpi takes longer than printing with other settings and requires a
large amount of disk space.

To print in Maximum dpi mode
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Paper Type drop-down list, click More, and then select the appropriate paper

type.
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7. In the Print Quality drop-down list, click Maximum dpi.

NOTE: To view the maximum dpi that the HP Photosmart will print, click
Resolution.

8. Select any other print settings that you want, and then click OK.

Print on both sides of the page
You can print two-sided pages with the HP Photosmart manually. When printing two-
sided pages, make sure to use paper that is thick enough so that images do not show
through to the other side.

To print on both sides of the page
1. Load paper into the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Paper saving options area, select Manual from the Two-sided printing drop-

down list.
7. For binding, do one of the following:

• For binding on the top like a notebook or calendar, select the Flip Pages Up check
box.
This causes the odd and even pages of your document to print opposite of each
other top-to-bottom. This ensures that the top of the page is always at the top of
the sheet when you flip the pages up in your bound document.
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• For binding on the side like a book or magazine, click to clear the Flip Pages
Up check box.
This causes the odd and even pages of your document to print opposite of each
other left-to-right. This ensures that the top of the page is always at the top of the
sheet when you turn the pages in your bound document.

8. Click OK, and then click Print or OK in the Print dialog box.
The HP Photosmart begins printing. Wait until all the odd-numbered pages are printed
before removing any of the printed pages from the output tray.
A dialog box displays instructions on the screen when it is time to process the second
side of your job.

9. Click Continue when done.

Related topics
“Recommended papers for printing” on page 55

Print a multiple-page document as a booklet
The HP Photosmart allows you to print your document as a small booklet, which you can
fold and then staple together.

For best results, design your document to fit on a multiple of four pages, such as an 8,
12, or 16-page program for a child's school play or for a wedding.

To print a multiple-page document as a booklet
1. Load paper into the input tray.

The paper should be thick enough so that the images do not show through to the
other side.

2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Paper saving options area, select Manual from the Two-sided printing drop-

down list.
7. Select the binding edge from the Booklet layout is list, as appropriate for your

language.
• If your language reads left-to-right, click Left edge binding.
• If your language reads right-to-left, click Right edge binding.
The Pages per sheet box is automatically set to two pages per sheet.
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8. Click OK, and then click Print or OK in the Print dialog box.
The HP Photosmart begins printing.
A dialog box displays instructions on the screen when it is time to process the second
side of your job. Do not click Continue in the dialog box until you have reloaded the
paper as instructed in the following steps.

9. Wait until the HP Photosmart has stopped printing for several seconds before
removing any of the printed pages from the output tray.
If you remove the pages while the document is still printing, the pages might get out
of order.

10. Follow the instructions that appear on your screen for reloading the paper to print on
the second side, and then click Continue.

11. When the entire document has finished printing, fold the stack of paper in half, so that
the first page is on top, then staple the document along the crease.

TIP: For best results, use a saddle stapler, or a heavy-duty stapler with a long
reach to staple the booklet.

1 3 5

7911

Figure 7-1 Left-edge binding for left-to-right languages

135

7 9 11

Figure 7-2 Right-edge binding for right-to-left languages
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Print multiple pages on a single sheet
You can print up to 16 pages on a single sheet of paper.

To print multiple pages on a single sheet
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Pages per sheet list, click 2, 4, 6, 8, 9, or 16.
7. If you want a border to appear around each page image printed on the sheet of paper,

select the Print page borders check box.
8. In the Page order list, click an appropriate page order option.

The sample output graphic is numbered to show how the pages will be ordered if you
select each option.

9. Click OK, and then click Print or OK in the Print dialog box.

Print a multiple-page document in reverse order
Because of the way the paper feeds through the HP Photosmart, the first page that prints
is print side up at the bottom of the stack. Usually this means you need to put the printed
pages in the correct order.

1
2
3
4
5

A better way is to print the document in reverse order so that the pages are stacked
correctly.

5
4
3
2
1

TIP: Set this option as a default setting so you do not have to remember to set it
every time you print a multiple-page document.
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To print a multiple-page document in reverse order
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Advanced tab.
6. In the Layout Options area, select Front to Back in the Page Order option.

NOTE: If you set your document to print on both sides of the page, the Front to
Back option is not available. Your document will automatically print in the correct
order.

7. Click OK, and then click Print or OK in the Print dialog box.

NOTE: When you are printing multiple copies, each set is printed completely
before the next set is printed.

Reverse an image for iron-on transfers
This feature reverses an image so you can use it for iron-on transfers. This feature is also
useful for transparencies when you want to make notations on the back of the
transparency without scratching the original.

To reverse an image for iron-on transfers
1. On the File menu in your software application, click Print.
2. Make sure the HP Photosmart is the selected printer.
3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

4. Click the Features tab.
5. In the Paper Type drop-down list, click More, and then select HP Iron-on Transfer

from the list.
6. If the selected size is not what you want, click an appropriate size in the Size list.
7. Click the Advanced tab.
8. In the Printer Features area, select On from the Mirror Image drop-down list.
9. Click OK, and then click Print or OK in the Print dialog box.

NOTE: To prevent jams, manually feed the iron-on transfer sheets into the input
tray one sheet at a time.

Print on transparencies
For the best results, HP recommends you use HP transparency products with the
HP Photosmart.
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To print on transparencies
1. Load the transparency into the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Paper Type drop-down list, click More, and then select the appropriate paper

type.

TIP: If you want to make notations on the back of the transparencies and erase
them later without scratching the original, click the Advanced tab, and select the
Mirror Image check box.

7. In the Resizing Options area, click an appropriate size in the Size list.
8. Click OK, and then click Print or OK in the Print dialog box.

NOTE: The HP Photosmart automatically waits for transparencies to dry before
releasing them. Ink dries slower on film than on plain paper. Make sure you allow
enough time for the ink to dry before handling the transparency.

Print a group of addresses on labels or envelopes
With the HP Photosmart, you can print on a single envelope, a group of envelopes, or
label sheets designed for inkjet printers.

To print a group of addresses on labels or envelopes
1. Print a test page on plain paper first.
2. Place the test page on top of the label sheet or envelope, and hold both up to the

light. Check the spacing for each block of text. Make adjustments as needed.
3. Load the labels or envelopes into the main input tray.

CAUTION: Do not use envelopes with clasps or windows. They can get stuck in
the rollers and cause paper jams.

4. Slide the paper-length and paper-width guides inward against the stack of labels or
envelopes until the guides stop.

5. If you are printing on envelopes, do the following:
a. Display the print settings, and click the Features tab.
b. In the Resizing Options area, click the appropriate envelope size in the Size list.

6. Click OK, and then click Print or OK in the Print dialog box.
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Print a poster
You can create a poster by printing a document on multiple pages. The HP Photosmart
prints dotted lines on some pages to indicate where to trim the pages before taping them
together.

To print a poster
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Advanced tab.
6. Expand Document Options, and then expand Printer Features.
7. In the Poster Printing drop-down list, click either 2x2 (4 sheets), 3x3 (9 sheets),

4x4 (16 sheets), or 5x5 (25 sheets).
This selection tells the HP Photosmart to enlarge your document so that it fits on 4,
9, 16, or 25 pages.
If your originals are of multiple pages, each of those pages will be printed on 4, 9, 16,
or 25 pages. For example, if you have a one-page original and you select 3x3, you
will get 9 pages; if you select 3x3 for a two-page original, 18 pages will print.

8. Click OK, and then click Print or OK in the Print dialog box.
9. After the poster has printed, trim the edges of the sheets and tape the sheets together.

Print a Web page
You can print a Web page from your Web browser on the HP Photosmart.
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To print a Web page
1. Make sure you have paper loaded in the main input tray.
2. On the File menu in your Web browser, click Print.

The Print dialog box appears.
3. Make sure the HP Photosmart is the selected printer.
4. If your Web browser supports it, select the items on the Web page that you want to

include in the printout.
For example, in Internet Explorer, click the Options tab to select options such as As
laid out on screen, Only the selected frame, and Print all linked documents.

5. Click Print or OK to print the Web page.

TIP: To print Web pages correctly, you might need to set your print orientation to
Landscape.

Stop a print job
Although you can stop a print job from either the HP Photosmart or the computer, HP
recommends you stop it from the HP Photosmart for best results.

NOTE: Although most software applications designed for Windows use the
Windows print spooler, your software application might not use the spooler. An
example of a software application that does not use the Windows print spooler is
PowerPoint in Microsoft Office 97.

If you cannot cancel your print job by using one of the following procedures, consult
the instructions for canceling background printing in the online help for your software
application.

To stop a print job from the HP Photosmart
▲ Press Cancel on the control panel. If the print job does not stop, press Cancel again.

It can take a few moments for the print job to be cancelled.

To stop a print job from the computer (Windows 2000 users)
1. On the Windows taskbar, click Start, point to Settings, and then click Printers.
2. Double-click the HP Photosmart icon.

TIP: You can also double-click the printer icon in the Windows taskbar.

3. Select the print job you want to cancel.
4. On the Document menu, click Cancel Printing or Cancel, or press the Delete key

on your keyboard.
It can take a few moments for the print job to be cancelled.

To stop a print job from the computer (Windows XP users)
1. On the Windows taskbar, click Start, and then click Control Panel.
2. Open the Printers and Faxes control panel.
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3. Double-click the HP Photosmart icon.

TIP: You can also double-click the printer icon in the Windows taskbar.

4. Select the print job you want to cancel.
5. On the Document menu, click Cancel Printing or Cancel, or press the Delete key

on your keyboard.
It can take a few moments for the print job to be cancelled.

To stop a print job from the computer (Windows Vista users)
1. On the Windows taskbar, click Start, and then click Control Panel.
2. Click Printers.
3. Double-click the HP Photosmart icon.

TIP: You can also double-click the printer icon in the Windows taskbar.

4. Select the print job you want to cancel.
5. On the Document menu, click Cancel Printing or Cancel, or press the Delete key

on your keyboard.
It can take a few moments for the print job to be cancelled.
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8 Use the photo features
The HP Photosmart is equipped with memory card slots and a front USB port that enable
you to print or edit photos from a memory card or storage device (such as a keychain
drive, portable hard drive, or a digital camera in storage mode) without uploading your
photos to a computer first. Additionally, if the HP Photosmart is network-connected or
connected to a computer with a USB cable, you can also transfer your photos to the
computer to print, edit, or share.

The HP Photosmart supports the memory cards described below. Each type of memory
card can only be inserted in the appropriate slot for that card, and only one card may be
inserted at a time.

CAUTION: Do not insert more than one memory card at a time. If more than one
memory card is inserted, unrecoverable data loss might occur.

1 xD-Picture Card

2 CompactFlash (CF) types I and II

3 Memory Stick, Memory Stick Pro, Memory Stick Select, Memory Stick Magic Gate, Memory
Stick Duo or Duo Pro (adapter optional), or Memory Stick Micro (adapter required)

4 Secure Digital (SD), Secure Digital Mini (adapter required), Secure Digital High Capacity
(SDHC), MultiMediaCard (MMC), MMC Plus, MMC Mobile (RS-MMC; adapter required),
TransFlash MicroSD Card, or Secure MultiMedia Card

The memory card area also has a Photo light. This light blinks aqua-white when a memory
card is being read or when an image is being printed from a card, and stays solid aqua-
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white when images are ready to be viewed. The Photo light is located near the memory
card slots and is indicated by a camera icon.

CAUTION: Do not pull out the memory card or storage device while the Photo light
is flashing. A flashing light means the HP Photosmart is accessing the memory device.
Wait until the light remains solid. Removing a memory card or storage device while it
is being accessed might corrupt information on the memory device or damage the
HP Photosmart, memory card, or storage device.

This section contains the following topics:

• View and select photos
• Print your photos
• Create special projects from your photos
• Share photos using HP Photosmart Software
• Save photos to your computer
• Edit photos using the control panel

View and select photos
You can view and select photos on your memory card or storage device before or while
printing them.

To view and select photos
1. Insert a memory card into the appropriate slot on the HP Photosmart, or connect a

storage device to the front USB port.
The Photosmart Express menu appears, with the most recent photo shown on the
display.

View
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Print Create Share Save

2. Load up to 10 x 15 cm (4 x 6 inch) photo paper in the photo tray or full-size photo
paper in the main input tray.

3. Touch View.
The View Photos screen appears.

4. Touch  or  to scroll through the thumbnails of your photos.
5. When the thumbnail of the photo you want to view appears, touch it.
6. When the photo appears by itself on the display, touch the image again.

The Photo Options screen appears.
7. Touch Print Preview.

The Print Preview screen appears, showing how your photo will look when printed.
If you want to select additional photos to view and print, touch Add More and repeat
steps 4–6.

TIP: A checkmark appears to indicate each photo that is selected. You can
change the number of copies by touching  or . The total number of photos that
will print appears at the top of the display.

8. (Optional) If you want to check and/or modify any of your print settings, touch
Settings.

9. To print the photo(s), touch Print or press the Print Photos button on the control
panel.
A print status screen displays the number of pages to print and the estimated time to
complete.

TIP: During printing, you can touch Add more photos to add more photos to
the print queue.

Print your photos
You can print the photos on your memory card or storage device in a variety of sizes,
from 10 x 15 cm (4 x 6 inch) up to the size of letter or A4 paper, including multiple small-
size photos on a single page.
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To print your photos
1. Insert a memory card into the appropriate slot on the HP Photosmart, or connect a

storage device to the front USB port.
The Photosmart Express menu appears, with the most recent photo shown on the
display.

View

Print Create Share Save

2. Load up to 10 x 15 cm (4 x 6 inch) photo paper in the photo tray or full-size photo
paper in the main input tray.

3. Touch Print.
The Print Layout screen appears.

4. Touch  or  to scroll through the layout options, then touch the print layout you want:

4x6 5x7

The Select Photos screen appears.
5. Touch  or  to scroll through the thumbnails of your photos.
6. When the thumbnail of the photo you want to print appears, touch it.
7. When the selected photo appears by itself on the display, touch the image again.

A checkmark appears to indicate that the photo is selected. You can change the
number of copies by touching  or . The total number of photos that will print
appears at the top of the display.
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8. Touch  or  to continue scrolling through and selecting photos, and then touch
Done.
The Print Preview screen appears, showing how your photo(s) will look when printed.

9. (Optional) If you want to check and/or modify any of your print settings, touch
Settings.

10. Touch Print (or press the Print Photos button on the control panel).
A print status screen displays the number of pages to print and the estimated time to
complete.

Create special projects from your photos
The HP Photosmart enables you to create special projects from your photos, including:

• Photo albums
• Panorama prints
• Wallet-size photos
• Passport-size photos
• Video action prints (from your video frames)

To create special projects
1. Insert a memory card into the appropriate slot on the HP Photosmart, or connect a

storage device to the front USB port.
The Photosmart Express menu appears, with the most recent photo shown on the
display.

View

Print Create Share Save

2. Make sure the photo tray or main input tray is loaded with the correct paper for the
type of project you are creating.
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3. Touch Create.
The Create screen appears.

4. Touch  or  to scroll through the projects, and then touch one of the following
projects.
• Album Pages: Enables you to select multiple photos and print them onto a series

of themed album pages, which you can then bind to create a photo album. The
photos in your album pages are placed in the same orientation for a visually
pleasing presentation.

• Panorama Prints: Enables you to select multiple photos to "stitch" together to
create a single wide view (or panorama) photo. The HP Photosmart automatically
aligns the edges of the photos you select to create the smoothest transition from
one photo to the next.

• Wallets: Enables you to print your own wallet-size photos to carry with you or give
to friends or relatives.

• Passport Photos: Enables you to print your own passport-size photos. (If you
have questions on guidelines or restrictions for passport photos, contact a local
passport service agency.)

• Video Frame Prints: If you have digital video files saved on your memory card
or storage device, you can watch a video on the display, and then select up to 10
individual frames from the video to print as photos for framing or saving in a photo
album.

5. Respond to the prompts for the project you are creating.
6. At the Print Preview screen, touch Print.

A print status screen displays the number of pages to print and the estimated time to
complete.

Share photos using HP Photosmart Software
You can use the HP Photosmart Software installed on your computer to transfer photos
from a memory card or storage device to your computer’s hard drive for sharing photos
online and printing from your computer.
Before transferring photos to your computer, you need to remove the memory card from
your digital camera and insert it in the appropriate memory card slot on the
HP Photosmart, or connect a storage device to the front USB port.
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To share photos from a memory card or storage device
1. Insert a memory card into the appropriate slot on the HP Photosmart, or connect a

storage device to the front USB port.
The Photosmart Express menu appears, with the most recent photo shown on the
display.

View

Print Create Share Save

2. Touch Share.
The Select Photos screen appears.

3. Touch  or  to scroll through the thumbnails of your photos.
4. When the thumbnail of the photo you want to share appears, touch it.
5. When the photo appears by itself on the display, touch the image again.

A checkmark appears to indicate that the photo is selected.
6. Touch  or  to continue scrolling through and selecting photos, and then touch

Done.
The Share Preview screen appears, showing which photos you have selected.

7. Touch Send.
If the HP Photosmart is network-connected, a list of available computers appears.
Select the computer you want to use to send the photos, and then continue to the
next step.

8. When the Save to Computer screen asks you to see the computer monitor for Share
photo options, follow the onscreen prompts on your computer.

Save photos to your computer
You can use the HP Photosmart Software installed on your computer to transfer photos
from a memory card or storage device to your computer’s hard drive for sharing photos
online and printing from your computer.
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Before transferring photos to your computer, you need to remove the memory card from
your digital camera and insert it in the appropriate memory card slot on the
HP Photosmart, or connect a storage device to the front USB port.

To save photos
1. Insert a memory card into the appropriate slot on the HP Photosmart, or connect a

storage device to the front USB port.
The Photosmart Express menu appears, with the most recent photo shown on the
display.

View

Print Create Share Save

2. Touch Save.
The Save Photos menu appears.

3. Touch Save to Computer.

TIP: You can also transfer images from a memory card to a connected USB
storage device by choosing the Save to USB drive option.

If the HP Photosmart is network-connected, a list of available computers appears.
Select the computer to which you want to transfer the photos, and then continue to
the next step.

4. When the Save to Computer screen asks you to see the computer monitor for Import
photo options, follow the onscreen prompts on your computer to save the photos to
your computer.
Only images that were not previously saved are copied to your computer.
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Edit photos using the control panel
The HP Photosmart offers several basic editing features that you can use to edit your
photos manually before you print them, as well as a feature that enables you to
automatically enhance your photos.
This section contains the following topics:

• Zoom and pan to crop a photo
• Rotate a photo
• Adjust the brightness of your photos
• Print a frame around your photo
• Apply special color effects to your photos
• Remove red-eye
• Automatically enhance your photos

Zoom and pan to crop a photo
The HP Photosmart enables you to zoom in or out on a specific area of a photo. When
you print the photo, the photo is cropped so only the area shown on the display prints.

NOTE: The changes you make to the photo apply only to viewing and printing the
photo. The changes will not be saved on the memory card or storage device.

To crop a photo
1. Insert a memory card into the appropriate slot on the HP Photosmart, or connect a

storage device to the front USB port.
The Photosmart Express menu appears, with the most recent photo shown on the
display.

2. Touch View.
The View Photos screen appears.

3. Touch  or  to scroll through the thumbnails of your photos.
4. When the thumbnail of the photo you want to edit appears, touch it.
5. When the selected photo appears by itself on the display, touch the image or touch

Options.
The Options menu appears.

6. Touch Edit.
The Edit menu appears.

7. Touch Crop.
The Crop screen appears.

8. Touch the Zoom In or Zoom Out magnifying glass icons on the right side of the display
to zoom closer to or farther away from the subject of the photo.
An outline appears on the photo to show you an approximate view of the area that
will print.
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9. Use the arrow buttons to pan around the photo and select a specific area to print.
10. Touch Crop.

To preview your cropped photo
▲ Touch the Back icon until you return to the Options menu, then touch Print

Preview.

To print your cropped photo
▲ Touch the Back icon until you return to the View Photos screen, then touch

Print.

Rotate a photo
Depending how a photo is saved, the photo might appear sideways or upside down on
the display. You might need to rotate the photo to make it show or print properly.

NOTE: When printing more than one photo on a page, the HP Photosmart
automatically adjusts the orientation of your photos to fit a maximum number of photos
on the page. The rotation you apply here is ignored to accommodate the number of
photos selected per page.

To rotate a photo
1. Insert a memory card into the appropriate slot on the HP Photosmart, or connect a

storage device to the front USB port.
The Photosmart Express menu appears, with the most recent photo shown on the
display.

2. Touch View.
The View Photos screen appears.

3. Touch  or  to scroll through the thumbnails of your photos.
4. When the thumbnail of the photo you want to edit appears, touch it.
5. When the selected photo appears by itself on the display, touch the image or touch

Options.
The Options menu appears.

6. Touch Edit.
The Edit menu appears.

7. Touch Rotate.
The Rotate screen appears.

8. Touch the Rotate Right or Rotate Left icons at the lower right of the screen to flip the
image 90 degrees clockwise or counterclockwise.

9. When you are done rotating the image, touch Done.

To preview your rotated photo
▲ Touch the Back icon until you return to the Options menu, then touch Print

Preview.
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To print your rotated photo
▲ Touch the Back icon until you return to the View Photos screen, then touch

Print.

Adjust the brightness of your photos
You can adjust the brightness of a photo so that it prints lighter or darker than the original
photo you took with your digital camera.

NOTE: The changes you make to the photo apply only to viewing and printing the
photo. The changes will not be saved on the memory card or storage device.

To adjust the brightness
1. Insert a memory card into the appropriate slot on the HP Photosmart, or connect a

storage device to the front USB port.
The Photosmart Express menu appears, with the most recent photo shown on the
display.

2. Touch View.
The View Photos screen appears.

3. Touch  or  to scroll through the thumbnails of your photos.
4. When the thumbnail of the photo you want to edit appears, touch it.
5. When the selected photo appears by itself on the display, touch the image or touch

Options.
The Options menu appears.

6. Touch Edit.
The Edit menu appears.

7. Touch Brightness.

NOTE: If the menu option you want is not visible on the screen, touch  or
 to scroll through all the menu options.

The Brightness screen appears.
8. Touch  or  to decrease or increase the brightness of the photo.

The current brightness selection is indicated by the vertical line on the slidebar.
9. When you are done adjusting brightness, touch Done.

To preview your edited photo
▲ Touch the Back icon until you return to the Options menu, then touch Print

Preview.

To print your edited photo
▲ Touch the Back icon until you return to the View Photos screen, then touch

Print.

Print a frame around your photo
You can print a decorative colored border around the outside edge of your photo to frame
the photo.
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NOTE: The changes you make to the photo apply only to viewing and printing the
photo. The changes will not be saved on the memory card or storage device.

To print a frame around your photo
1. Insert a memory card into the appropriate slot on the HP Photosmart, or connect a

storage device to the front USB port.
The Photosmart Express menu appears, with the most recent photo shown on the
display.

2. Touch View.
The View Photos screen appears.

3. Touch  or  to scroll through the thumbnails of your photos.
4. When the thumbnail of the photo you want to edit appears, touch it.
5. When the selected photo appears by itself on the display, touch the image or touch

Options.
The Options menu appears.

6. Touch Edit.
The Edit menu appears.

7. Touch Add Frame.
The Select Creative Frame screen appears.

8. Touch  or  to scroll through the frames until you find the one you want, and then
touch the frame.
The selected frame is applied to the photo and shown by itself on the display.

To preview your edited photo
▲ Touch the Back icon until you return to the Options menu, then touch Print

Preview.

To print your edited photo
▲ Touch the Back icon until you return to the View Photos screen, then touch

Print.

Apply special color effects to your photos
You can apply special color effects to a photo so that it prints with a sepia, hand-tinted,
or black-and-white finish.

NOTE: The changes you make to the photo apply only to viewing and printing the
photo. The changes will not be saved on the memory card or storage device.

To change the color effects
1. Insert a memory card into the appropriate slot on the HP Photosmart, or connect a

storage device to the front USB port.
The Photosmart Express menu appears, with the most recent photo shown on the
display.

2. Touch View.
The View Photos screen appears.
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3. Touch  or  to scroll through the thumbnails of your photos.
4. When the thumbnail of the photo you want to edit appears, touch it.
5. When the selected photo appears by itself on the display, touch the image or touch

Options.
The Options menu appears.

6. Touch Edit.
The Edit menu appears.

7. Touch Color Effect.

NOTE: If the menu option you want is not visible on the screen, touch  or
 to scroll through all the menu options.

The Color Effect menu appears.
8. Touch one of the color effect options:

No Effect Does not apply any special color effects to your photo.

Black & White Prints the photo in black and white.

Sepia Applies brown tones, similar to photos produced in the early 1900s, to
your photo.

Antique Applies brown tones along with some pale colors to your photo. With
this option, your photo will look like it was hand-tinted.

The selected color effect is applied to the photo, and the photo is shown by itself on
the display.

To preview your edited photo
▲ Touch the Back icon until you return to the Options menu, then touch Print

Preview.

To print your edited photo
▲ Touch the Back icon until you return to the View Photos screen, then touch

Print.

Remove red-eye
The flash on a camera (especially on older model cameras) can sometimes cause a
subject's eyes to appear red in your photos. You can remove redness so that eyes appear
the correct shade in your photos.

To remove red-eye from photos
1. Insert a memory card into the appropriate slot on the HP Photosmart, or connect a

storage device to the front USB port.
The Photosmart Express menu appears, with the most recent photo shown on the
display.

2. Touch View.
The View Photos screen appears.

3. Touch  or  to scroll through the thumbnails of your photos.
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4. When the thumbnail of the photo you want to edit appears, touch it.
5. When the selected photo appears by itself on the display, press the Red Eye

Removal button on the control panel.

TIP: Another method is to choose Red Eye Removal from the Edit menu.

A red-eye icon blinks in the upper left corner of the photo, red-eye removal is applied,
and the photo is shown by itself on the display.

Automatically enhance your photos
The HP Photosmart is set up, by default, to enhance your photos automatically when you
print them. The changes are only visible on your printed output; you cannot see the
changes on the display.
When this feature is enabled, the HP Photosmart uses HP Real Life Technologies to:

• Adjust the brightness or darkness of your photos.
• Adjust the lighting to make dark images appear brighter.
• Sharpen blurry images.

You can turn off the automatic photo enhancement feature for individual photos, on a per-
image basis.

To turn off automatic photo enhancement
1. Insert a memory card into the appropriate slot on the HP Photosmart, or connect a

storage device to the front USB port.
The Photosmart Express menu appears, with the most recent photo shown on the
display.

2. Touch View.
The View Photos screen appears.

3. Touch  or  to scroll through the thumbnails of your photos.
4. When the thumbnail of the photo you want to edit appears, touch it.
5. When the selected photo appears by itself on the display, touch the image or touch

Options.
The Options menu appears.

6. Touch Edit.
The Edit menu appears.

7. Touch Photo Fix.
The Photo Fix menu appears.

8. To turn off automatic photo enhancement, touch Off.
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9 Print reports and forms
The HP Photosmart enables you to print self-test reports. You can also print forms such
as ruled papers and checklists.

This section contains the following topics:

• Print a self-test report
• Print forms

Print a self-test report
If you are experiencing problems with printing, print a self-test report before you replace
the ink cartridges. This report provides useful information on several aspects of your
device, including your ink cartridges.

To print a self-test report
1. Load letter, A4, or legal unused plain white paper into the input tray.
2. Touch Setup on the display.
3. Touch Tools.
4. Touch Self-Test Report.

The HP Photosmart prints a self-test report, which contains the following information:
• Product information: includes the model number, serial number, and other

product information.
• Revision information: includes the firmware version number.
• Ink delivery system information: displays the approximate ink level of each

installed ink cartridge, the status of each ink cartridge, the date each cartridge
was installed, and the date each cartridge will expire.

• Print quality pattern: displays six color blocks, representing each of the six
installed cartridges. Solid, even blocks of color indicate there are no print quality
problems. When streaks are displayed or there are missing blocks, clean the print
head using the procedure described in “Clean the print head” on page 106. If the
color blocks still show print quality problems after cleaning the print head, align
the printer using the procedure described in “Align the printer” on page 105. If
the color blocks continue to show print quality problems after cleaning and
aligning, contact HP support.

• History log: contains information that might be used for diagnostic purposes if
you need to call HP support.
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Print forms
The HP Photosmart contains built-in templates that enable you to print common forms,
such as narrow or wide ruled notebook paper, graph paper, task checklists, and music
sheets on plain letter- or A4-size paper.

To print forms from the control panel
1. Make sure you have paper loaded in the input tray.
2. Touch Setup on the display.
3. Touch Printable School Papers.
4. Touch the form you want to print.

NOTE: If the menu option you want is not visible on the screen, touch  or
 to scroll through all the menu options.
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10 Maintain the HP Photosmart
The HP Photosmart requires little maintenance. You might need to replace, align, or clean
your ink cartridges from time to time ensure that your printouts are always of the highest
quality. This section provides instructions for keeping the HP Photosmart in top working
condition. Perform these simple maintenance procedures as necessary.

This section contains the following topics:

• Check the estimated ink levels
• Work with ink cartridges
• Clean the HP Photosmart
• Self-maintenance sounds
• Reduce energy consumption when the HP Photosmart is off
• Turn off the HP Photosmart

Check the estimated ink levels
You can easily check the ink supply level to determine how soon you might need to
replace an ink cartridge. The ink supply level shows an estimate of the amount of ink
remaining in the ink cartridges.

NOTE: The HP Photosmart can only detect the ink levels for genuine HP ink. The
ink levels in ink cartridges that are refilled or have been used in other devices might
not register accurately.

NOTE: Ink from the cartridges is used in the printing process in a number of different
ways, including in the initialization process, which prepares the device and cartridges
for printing, and in printhead servicing, which keeps print nozzles clear and ink flowing
smoothly. In addition, some residual ink is left in the cartridge after it is used. For more
information, see www.hp.com/go/inkusage.

To check the ink levels from the control panel
1. Touch Setup on the display.
2. Touch Tools.
3. Touch Display Ink Gauge.

The HP Photosmart displays a gauge that shows the estimated ink levels of all
cartridges installed.
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To check the ink levels from the HP Photosmart Software
1. In the HP Solution Center, click Settings, point to Print Settings, and then click

Printer Toolbox.

NOTE: You can also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Services tab, and then click
Service this device.

The Printer Toolbox appears.
2. Click the Estimated Ink Level tab.

The estimated ink levels for the ink cartridges appear.

TIP: You can also print a self-test report to see if ink cartridges might need to be
replaced.

Related topics
“Print a self-test report” on page 99

Work with ink cartridges
To ensure the best print quality from the HP Photosmart, you will need to perform some
simple maintenance procedures and, when prompted by a message on the display,
replace the ink cartridges.

This section contains the following topics:

• Replace the ink cartridges
• Align the printer
• Clean the print head
• Clean the ink cartridge contacts
• Remove ink from your skin and clothing

Replace the ink cartridges
Follow these instructions when you need to replace ink cartridges.

NOTE: If you are installing ink cartridges in the HP Photosmart for the first time, be
sure to use only the ink cartridges that came with the device. The ink in these
cartridges is specially formulated to mix with the ink in the print head assembly at first-
time setup.

If you do not already have replacement ink cartridges for the HP Photosmart, to order
cartridges, go to www.hp.com/buy/supplies. If prompted, choose your country/region,
follow the prompts to select your product, and then click one of the shopping links on the
page.
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To replace the ink cartridges
1. Make sure the HP Photosmart is turned on.
2. Open the ink cartridge door by lifting from the front center of the device, until the door

locks into place.

3. Squeeze the bottom of the latch below the ink cartridge you want to replace, and then
lift the latch.
If you are replacing the black ink cartridge, lift the latch on the far left.
If you are replacing one of the five color ink cartridges, such as yellow, light cyan
(blue), cyan, light magenta (pink), or magenta, lift the appropriate latch in the center
area.

1 Ink cartridge latch for the black ink cartridge

2 Ink cartridge latches for the color ink cartridges
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4. Pull the ink cartridge toward you out of its slot to remove it.

5. Remove the new ink cartridge from its packaging, and then, holding it by the handle,
push the ink cartridge into the empty slot.
Match the color and pattern of the ink cartridge to the color and pattern on the print
carriage.

6. Close the latch and make sure it is secure.
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7. Repeat steps 3 through 6 for each ink cartridge you are replacing.
8. Close the ink cartridge door.

Related topics
“Shop for ink supplies” on page 111

Align the printer
The HP Photosmart automatically aligns the print head when you install the ink cartridges
during the initial setup. The HP Photosmart also aligns the print head during periodic
maintenance to ensure excellent print quality. You might want to use this feature when
the self-test report shows streaking or white lines through any of the blocks of color.

If you still have print quality problems after aligning the printer, try cleaning the print head.
If print quality problems persist after aligning and cleaning, contact HP support.

To align the printer from the control panel
1. Load letter, A4, or legal unused plain white paper into the input tray.
2. Touch Setup on the display.
3. Touch Tools.
4. Touch Align Printer.
5. The HP Photosmart prints a test page, aligns the print head, and calibrates the printer.

Recycle or discard the page.
A success or failure message appears.

NOTE: If you have colored paper loaded in the input tray when you align the
printer, the alignment will fail. Load unused plain white paper into the input tray,
and then try the alignment again.

If the alignment fails again, you might have a defective sensor or ink cartridge.
Contact HP support. Go to www.hp.com/support. If prompted, choose your
country/region, and then click Contact HP for information on calling for technical
support.
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To align the printer from the HP Photosmart Software
1. Load letter, A4, or legal unused plain white paper into the input tray.
2. In the HP Solution Center, click Settings, point to Print Settings, and then click

Printer Toolbox.

NOTE: You can also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Services tab, and then click
Service this device.

The Printer Toolbox appears.
3. Click the Device Services tab.
4. Click Align the Printer.

The HP Photosmart prints a test page, aligns the print head, and calibrates the printer.
Recycle or discard the page.

Related topics
“Clean the print head” on page 106

Clean the print head
Use this feature when the self-test report shows streaking or white lines through any of
the blocks of color. Do not clean the print head unnecessarily, as this wastes ink and
shortens the life of the ink nozzles on the print head.

To clean the print head from the control panel
1. Load letter, A4, or legal unused plain white paper into the input tray.
2. Touch Setup on the display.
3. Touch Tools.
4. Touch Clean Print Head.

The HP Photosmart cleans the print head and prints a page that you can recycle or
discard.

To clean the print head from the HP Photosmart Software
1. Load letter, A4, or legal unused plain white paper into the input tray.
2. In the HP Solution Center, click Settings, point to Print Settings, and then click

Printer Toolbox.

NOTE: You can also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Services tab, and then click
Service this device.

The Printer Toolbox appears.
3. Click the Device Services tab.
4. Click Clean the Print Head.
5. Follow the prompts until you are satisfied with the quality of the output, and then click

Done.
If print quality still seems poor after you clean the print head, try aligning the printer.
If print quality problems persist after cleaning and aligning, contact HP support.
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Related topics
“Align the printer” on page 105

Clean the ink cartridge contacts
Clean the copper-colored ink cartridge contacts if all ink cartridges are installed and a
message appears on the display that says a cartridge is missing or damaged.

Before cleaning the ink cartridge contacts, remove the ink cartridge and verify that nothing
is covering the ink cartridge contacts or the ink cartridge slot, then reinstall the ink
cartridge. If you continue to get a message that says a cartridge is missing or damaged,
clean the ink cartridge contacts. If you still get this message after cleaning the contacts,
you will need a replacement ink cartridge. Remove the affected ink cartridge and look at
the end-of-warranty date on the bottom. If it is before the end-of-warranty date, contact
HP support to obtain a replacement ink cartridge.

Make sure you have the following materials available:

• Dry foam rubber swabs, lint-free cloth, or any soft material that will not come apart or
leave fibers.

• Distilled, filtered, or bottled water (tap water might contain contaminants that can
damage the ink cartridges).

CAUTION: Do not use platen cleaners or alcohol to clean the ink cartridge contacts.
These can damage the ink cartridge or the HP Photosmart.

To clean the ink cartridge contacts
1. Make sure the HP Photosmart is turned on.
2. Lift the ink cartridge door.
3. Squeeze the bottom of the latch below the ink cartridge you want to clean, and then

lift the latch.

NOTE: Do not remove multiple ink cartridges at the same time. Remove and
clean each ink cartridge one at a time. Do not leave an ink cartridge outside the
HP Photosmart for more than 30 minutes.

4. Inspect the ink cartridge contacts for ink and debris buildup.
5. Dip a clean foam rubber swab or lint-free cloth into distilled water, and squeeze any

excess water from it.

NOTE: Hold the ink cartridge by its handle. Do not touch the copper-colored
contacts with your hands or anything other than a foam rubber swab or lint-free
cloth.
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6. Clean only the copper-colored contacts.

1 Copper-colored contacts

7. Place the ink cartridge back into the empty slot and press down on the gray latch until
it clicks into place.

8. Repeat if necessary for the other ink cartridges.
9. Gently close the ink cartridge door.

Remove ink from your skin and clothing
Follow these instructions to remove ink from your skin and clothing:

Surface Remedy

Skin Wash the area with an abrasive soap.

White fabric Wash the fabric in cold water and use chlorine bleach.

Color fabric Wash the fabric in cold water and use sudsy ammonia.

CAUTION: Always use cold water to remove ink from fabric. Warm or hot water can
set the ink into the fabric.

Clean the HP Photosmart
Use a soft cloth or slightly moistened sponge to wipe dust, smudges, and stains off the
case. The interior of the HP Photosmart does not require cleaning. Keep fluids away from
the control panel and the interior of the HP Photosmart.

CAUTION: To avoid damage to the exterior of the HP Photosmart, do not use
alcohol or alcohol-based cleaning products.

TIP: You can purchase an HP Cleaning Kit for Inkjet Printers and All-in-Ones
(Q6260A) that provides everything needed to safely clean your HP device. For more
information, go to: www.hp.com/buy/supplies.
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Self-maintenance sounds
The HP Photosmart will make mechanical noises at various times to perform periodic
maintenance functions, such as replenishing the ink levels in the print head assembly or
cleaning the print head. This is normal operation and is necessary to ensure the
HP Photosmart produces the best quality printouts.

CAUTION: A message on the display will notify you when the HP Photosmart is
performing maintenance functions. Do not remove power from the device during this
time.

Reduce energy consumption when the HP Photosmart is
off

When the HP Photosmart is off, an amount of energy is still being consumed. Energy
consumption can be lessened by enabling the Federal Energy Management Program
(FEMP) mode.

NOTE: When the HP Photosmart is in FEMP mode, it will take longer than usual to
turn back on.

To enable FEMP mode
▲ Press and hold the On button for 3 seconds until the HP Photosmart turns off.

Turn off the HP Photosmart
To avoid damaging the HP Photosmart, you must properly shut it down by using the
On button located on the device. Do not turn the HP Photosmart off by unplugging the
power cord or turning off a power strip.
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11 Shop for ink supplies
For a list of ink cartridge numbers, see the printed documentation that came with the
HP Photosmart. You can also use the software that came with the HP Photosmart to find
out the reorder number for all the ink cartridges. You can order ink cartridges online from
the HP Web site. Additionally, you can contact a local HP reseller to find out the correct
ink cartridge reorder numbers for your device and purchase ink cartridges.

To order genuine HP supplies for the HP Photosmart, go to www.hp.com/buy/supplies.
If prompted, choose your country/region, follow the prompts to select your product, and
then click one of the shopping links on the page.

NOTE: Ordering ink cartridges online is not supported in all countries/regions. If it is
not supported in your country/region, contact a local HP reseller for information about
purchasing ink cartridges.

To order ink cartridges from your desktop
▲ Click the Shop for HP Supplies icon on your desktop to connect to HP SureSupply.

You will see a list of original HP printing supplies that are compatible with your device,
as well as options to conveniently purchase the supplies you need (options vary by
country/region).
If you deleted this icon from your desktop, click the Start menu, point to the HP folder,
then click Shop for Supplies.

To order HP printing supplies through the HP Solution Center
1. In the HP Solution Center, click Settings, point to Print Settings, and then click

Printer Toolbox.

NOTE: You can also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Services tab, and then click
Service this device.

2. Click the Estimated Ink Levels tab.
3. Click Ink Cartridge Ordering Information.

The ink cartridge reorder numbers appear.
4. Click Order Online.

HP sends detailed printer information, including model number, serial number, and
ink supply levels, to an authorized online reseller. The supplies you need are
preselected; you can change quantities, add or remove items, and then check out.
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12 Troubleshooting
This section contains the following topics:

• Troubleshooting tips
• Hardware setup troubleshooting
• Software installation troubleshooting
• Network troubleshooting
• Print quality troubleshooting
• Print troubleshooting
• Memory card and front USB port troubleshooting
• Errors

Troubleshooting tips
This section contains the following topics:

• Communication problems over a USB connection
• Information on ink cartridges and the print head
• Information on paper
• Clear paper jams
• View the Readme file

Communication problems over a USB connection

NOTE: For information on network communication problems, see “Network
troubleshooting” on page 125. For information on communication problems involving
a memory card, PictBridge camera, or storage device, see “Memory card and front
USB port troubleshooting” on page 145.

If the HP Photosmart and computer are not communicating with each other, try the
following:
• Look at the display on the HP Photosmart. If the display is blank and the On button

is not lit, the HP Photosmart is turned off. Make sure the power cord is firmly
connected to the HP Photosmart and plugged into a power outlet. Press the On button
to turn on the HP Photosmart.

• Check the USB cable. If you are using an older cable, it might not be working properly.
Try connecting it to another product to see if the USB cable works. If you experience
problems, the USB cable might need to be replaced. Also verify that the cable does
not exceed 3 meters (9.8 feet) in length.

• Check the connection from the HP Photosmart to your computer. Verify that the USB
cable is securely plugged into the USB port on the back of the HP Photosmart. Make
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sure the other end of the USB cable is plugged into a USB port on your computer.
After the cable is connected properly, turn the HP Photosmart off and then on again.

• If you are connecting the HP Photosmart through a USB hub, make sure the hub is
turned on. If the hub is on, try connecting directly to your computer.

• Check other printers or scanners. You might need to disconnect older products from
your computer.

• Try connecting the USB cable to another USB port on your computer. After you check
the connections, try restarting your computer. Turn the HP Photosmart off and then
on again.

• If necessary, remove the software you installed with the HP Photosmart and then
install it again.

For more information, see:

• “Uninstall and reinstall the software” on page 123
• “Find more information” on page 15

Information on ink cartridges and the print head
The following tips help maintain HP ink cartridges and ensure consistent print quality.
• Install the ink cartridge on or before the install by date, which is printed on the ink

cartridge package.
• Keep all ink cartridges in the original sealed packages until they are needed.
• Turn off the HP Photosmart by pressing the On button located on the device. Do not

turn off the device by turning off a power strip or unplugging the power cord from the
HP Photosmart. If you improperly turn off the HP Photosmart, the print head assembly
might not return to the correct position.

• Store ink cartridges at room temperature (15.6°-26.6° C or 60°-78° F).
• HP recommends that you do not remove the ink cartridges from the HP Photosmart

until you have replacement cartridges available to install.
If you are transporting the HP Photosmart make sure you turn off the device by
pressing the On button to power it down properly. Also, make sure you leave the ink
cartridges installed. Doing these actions will prevent ink leaking from the print head
assembly.
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• Clean the print head when you notice a significant decrease in print quality.
• Do not clean the print head unnecessarily. This wastes ink and shortens the life of

the cartridges.
• Handle ink cartridges carefully. Dropping, jarring, or rough handling during installation

can cause temporary printing problems.

Information on paper
The HP Photosmart is designed to work well with most paper types. Test a variety of
paper types before buying a large quantity. Find a paper type that works well and is easy
to purchase. HP Premium papers are designed for the best quality results. In addition,
follow these tips:

• Do not use paper that is too thin, that has a slick texture, or that stretches easily. It
can feed incorrectly through the paper path, causing paper jams.

• Store photo media in its original packaging inside a resealable plastic bag on a flat
surface in a cool, dry place. When you are ready to print, remove only the paper you
plan to use immediately. When you have finished printing, return any unused photo
paper to the plastic bag.

• Do not leave unused photo paper in the input tray. The paper might start to curl, which
might reduce the quality of your printouts. Curled paper can also cause paper jams.

• Always hold photo paper by the edges. Fingerprints on photo paper can reduce print
quality.

• Do not use paper that is heavily textured. It can cause graphics or text to print
improperly.

• Do not combine different paper types and paper sizes in the input tray; the entire stack
of paper in the input tray must be the same size and type.

• Store printed photos under glass or in a storage book to prevent bleeding over time
from high humidity. Use HP Premium Plus photo paper for maximum performance.

Clear paper jams
If the HP Photosmart has a paper jam, first check the rear door. If the jammed paper is
not in the rear rollers, check the top door.

To clear a paper jam from the rear door
1. Turn off the HP Photosmart.
2. Press in the tab on the rear door to release the door. Remove the door by pulling it

away from the HP Photosmart.

CAUTION: Trying to clear a paper jam from the front of the HP Photosmart can
damage the print mechanism. Always access and clear paper jams through the
rear door.

Troubleshooting tips 115

Tr
ou

bl
es

ho
ot

in
g



3. Gently pull the paper out of the rollers.

CAUTION: If the paper tears when you are removing it from the rollers, check
the rollers and wheels for torn pieces of paper that might be remaining inside the
device. If you do not remove all the pieces of paper from the HP Photosmart, more
paper jams are likely to occur.

4. Replace the rear door. Gently push the door forward until it snaps into place.
5. Turn on the HP Photosmart, and then touch OK to continue the current job.

To clear a paper jam from the top door
1. Turn off the HP Photosmart.
2. Open the ink cartridge door.

3. Lift the top door that is located behind the ink cartridges and print head assembly.
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4. Gently pull the paper out of the rollers.

CAUTION: If the paper tears when you are removing it from the rollers, check
the rollers and wheels for torn pieces of paper that might be remaining inside the
device. If you do not remove all the pieces of paper from the HP Photosmart, more
paper jams are likely to occur.

5. Close the top door.
6. Close the ink cartridge door.

7. Turn on the HP Photosmart, and then touch OK to continue the current job.

View the Readme file
You might want to refer to the Readme file for information on system requirements and
possible installation problems.
You can access the Readme file by clicking Start, pointing to Programs or All
Programs, pointing to HP, pointing to Photosmart D7400 series, and then clicking
Readme.

You can access the Readme file by double-clicking the icon located in the top-level folder
of the HP Photosmart software CD-ROM.

Hardware setup troubleshooting
This section contains hardware troubleshooting information for the HP Photosmart.

Many issues are caused when the HP Photosmart is connected to the computer using a
USB cable before the HP Photosmart software is installed on the computer. If you
connected the HP Photosmart to your computer before the software installation screen
prompts you to do so, you must follow these steps:

Troubleshooting common setup issues
1. Disconnect the USB cable from the computer.
2. Uninstall the software (if you have already installed it).
3. Restart your computer.
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4. Turn off the HP Photosmart, wait one minute, then restart it.
5. Reinstall the HP Photosmart software.

CAUTION: Do not connect the USB cable to the computer until prompted by the
software installation screen.

This section contains the following topics:
• The HP Photosmart will not turn on
• I connected the USB cable, but I am having problems using the HP Photosmart with

my computer
• The display shows the wrong language
• The wrong measurements are showing in menus on the display
• I received a message on the display that the printer alignment failed
• I received a message on the display about a paper jam or a blocked print head

assembly

The HP Photosmart will not turn on
Cause: The HP Photosmart is not properly connected to a power supply.

Solution:
• Make sure the power cord is firmly connected to both the HP Photosmart and the

power adapter. Plug the power cord into a grounded power outlet, surge protector,
or power strip.

1 Power connection

2 Power cord and adapter

3 Grounded power outlet

• If you are using a power strip, make sure the power strip is on. Or, try plugging
the HP Photosmart directly into a grounded power outlet.
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• Test the power outlet to make sure it is working. Plug in an appliance that you
know works, and see if the appliance has power. If not, then there might be a
problem with the power outlet.

• If you plugged the HP Photosmart into a switched outlet, make sure the switch is
on. If it is switched to on but still does not work, then there might be a problem
with the power outlet.

Cause: You pressed the On button too quickly.

Solution: The HP Photosmart might not respond if you press the On button too
quickly. Press the On button once. It might take a few minutes for the HP Photosmart
to turn on. If you press the On button again during this time, you might turn the device
off.

CAUTION: If the HP Photosmart still does not turn on, it might have a mechanical
failure. Unplug the HP Photosmart from the power outlet and contact HP. Go to:
www.hp.com/support. If prompted, choose your country/region, and then click
Contact HP for information on calling for technical support.

I connected the USB cable, but I am having problems using the HP Photosmart with
my computer

Cause: The USB cable was connected before the software was installed.
Connecting the USB cable before prompted can cause errors.

Solution: You must first install the software that came with the HP Photosmart
before connecting the USB cable. During installation, do not plug in the USB cable
until prompted by the onscreen instructions.

Once you have installed the software, connecting your computer to the
HP Photosmart with a USB cable is straightforward. Simply plug one end of the USB
cable into the back of your computer and the other into the back of the HP Photosmart.
You can connect to any USB port on the back of your computer.

Hardware setup troubleshooting 119

Tr
ou

bl
es

ho
ot

in
g

http://h20180.www2.hp.com/apps/Nav?h_lang=en&h_cc=all&h_product=3184564&h_page=hpcom&h_pagetype=s-001&lang=en&cc=all&h_client=s-h-e002-1


For more information on installing the software and connecting the USB cable, see
the Setup Guide that came with the HP Photosmart.

The display shows the wrong language
Cause: You might have selected the incorrect language when setting up the
HP Photosmart.

Solution: You can change the language settings at any time from the
Preferences menu.

For more information, see:

“Set your language and country/region” on page 17

The wrong measurements are showing in menus on the display
Cause: You might have selected the incorrect country/region when setting up the
HP Photosmart. The country/region you select determines the paper sizes shown on
the display.

Solution: You can change the country/region settings from the Preferences menu.

For more information, see:

“Set your language and country/region” on page 17

I received a message on the display that the printer alignment failed
Cause: The incorrect type of paper is loaded in the input tray (for example, colored
paper, paper with text on it or, certain recycled paper).

Solution: Load unused plain white letter or A4 paper into the input tray, and then
try the alignment again.

If the alignment fails again, you might have a defective sensor on the print head
assembly. Contact HP support. Go to www.hp.com/support. If prompted, choose your
country/region, and then click Contact HP for information on calling for technical
support.

For more information, see:

“Align the printer” on page 105

I received a message on the display about a paper jam or a blocked print head
assembly

Cause: The HP Photosmart has a paper jam.
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Solution: Clear the paper jam, and then follow the prompts on the display or the
computer screen to continue.

For more information, see:
“Clear paper jams” on page 115

Cause: The print head assembly is blocked.

Solution: There might be some packing material inside the HP Photosmart. Turn
the HP Photosmart off and open the ink cartridge door. Remove any objects that are
blocking the print head assembly (including any packing materials), and then turn the
HP Photosmart on again. Follow the prompts on the display or the computer screen
to continue.

Software installation troubleshooting
Use this section to solve any problems you might encounter while setting up the
HP Photosmart software.

This section contains the following topics:

• When I insert the CD-ROM into my computer’s CD-ROM drive, nothing happens
• The minimum system checks screen appears
• A red X appears on the USB connect prompt
• I received a message that an unknown error has occurred
• The registration screen does not appear
• Uninstall and reinstall the software
• Missing HP Photosmart Software

When I insert the CD-ROM into my computer’s CD-ROM drive, nothing happens
Cause: The installation failed to run automatically.

Solution: If the installation does not run automatically, you can start it manually.

To start the installation from a Windows computer
1. From the Windows Start menu, click Run (or click Accessories, and then Run).
2. In the Run dialog box, enter d:\setup.exe, and then click OK.

If your CD-ROM drive is not assigned to drive letter D, enter the appropriate drive
letter.

The minimum system checks screen appears
Cause: Your system does not meet the minimum requirements to install the
software.

Solution: Click Details to see what the specific problem is, and then correct the
problem before attempting to install the software.
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A red X appears on the USB connect prompt
Cause: Normally, a green check appears indicating that the usb connection is
successful. A red X indicates that the usb connection failed.
Solution: Check that the HP Photosmart is turned on, and then try the usb
connection again.

To retry the usb connection
1. Unplug the HP Photosmart power cord, and then plug it in again.
2. Verify that the USB cable and power cord are plugged in.

3. Click Retry to retry the connection. If this does not work, continue to the next step.
4. Verify that the USB cable is set up properly as follows:

• Unplug the USB cable and plug it in again or try plugging the USB cable into
a different USB port.

• Do not attach the USB cable to a keyboard.
• Verify that the USB cable is 3 meters (9.8 feet) or less in length.
• If you have several USB devices attached to your computer, you might want

to unplug the other devices during the installation.
5. Continue with the installation and restart the computer when prompted.

For more information, see:

“Uninstall and reinstall the software” on page 123

I received a message that an unknown error has occurred
Cause: The source of the error is unknown.

Solution: Try to continue with the installation. If that does not work, stop and then
restart the installation, and follow the directions on the screen. If an error occurs, you
might need to uninstall and then reinstall the software. Do not simply delete the
HP Photosmart application files from your computer. Make sure to remove them
properly using the uninstall utility provided when you installed the software that came
with the HP Photosmart.

Chapter 12

122 Troubleshooting

Troubleshooting



For more information, see:

“Uninstall and reinstall the software” on page 123

The registration screen does not appear
Cause: The registration screen did not launch automatically.

Solution: You can access the registration (Sign up now) screen from the Windows
taskbar by clicking Start, pointing to Programs or All Programs, HP, Photosmart
D7400 series, and then clicking Product Registration.

Uninstall and reinstall the software
If your installation is incomplete, or if you connected the USB cable to the computer before
prompted by the software installation screen, you might need to uninstall and then
reinstall the software. Do not simply delete the HP Photosmart application files from your
computer. Make sure to remove them properly using the uninstall utility provided when
you installed the software that came with the HP Photosmart.

To uninstall from a Windows computer, method 1
1. Disconnect the HP Photosmart from your computer. Do not connect the

HP Photosmart to your computer until after you have reinstalled the software.
2. On the Windows taskbar, click Start, Programs or All Programs, HP, Photosmart

D7400 series, Uninstall.
3. Follow the onscreen instructions.
4. If you are asked whether you would like to remove shared files, click No.

Other programs that use these files might not work properly if the files are deleted.
5. Restart your computer.

NOTE: It is important that you disconnect the HP Photosmart before restarting
your computer. Do not connect the HP Photosmart to your computer until after
you have reinstalled the software.

6. To reinstall the software, insert the HP Photosmart CD-ROM into your computer’s
CD-ROM drive, and follow the onscreen instructions and the instructions provided in
the Setup Guide that came with the HP Photosmart.

7. After the software is installed, connect the HP Photosmart to your computer.
8. Press the On button to turn the HP Photosmart on.

After connecting and turning on the HP Photosmart, you might have to wait several
minutes for all of the Plug and Play events to complete.

9. Follow the onscreen instructions.

To uninstall from a Windows computer, method 2

NOTE: Use this method if Uninstall is not available in the Windows Start menu.
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1. On the Windows taskbar, click Start, Settings, Control Panel (or just Control
Panel).

2. Double-click Add/Remove Programs (or click Uninstall a program).
3. Select HP Photosmart Printer Driver Software, and then click Change/Remove.

Follow the onscreen instructions.
4. Disconnect the HP Photosmart from your computer.
5. Restart your computer.

NOTE: It is important that you disconnect the HP Photosmart before restarting
your computer. Do not connect the HP Photosmart to your computer until after
you have reinstalled the software.

6. Insert the HP Photosmart CD-ROM into your computer’s CD-ROM drive and then
start the Setup program.

7. Follow the onscreen instructions and the instructions provided in the Setup Guide that
came with the HP Photosmart.

To uninstall from a Windows computer, method 3

NOTE: Use this method if Uninstall is not available in the Windows Start menu.

1. Insert the HP Photosmart CD-ROM into your computer’s CD-ROM drive and then
start the Setup program.

2. Disconnect the HP Photosmart from your computer.
3. Select Uninstall and follow the onscreen directions.
4. Restart your computer.

NOTE: It is important that you disconnect the HP Photosmart before restarting
your computer. Do not connect the HP Photosmart to your computer until after
you have reinstalled the software.

5. Start the Setup program for the HP Photosmart again.
6. Select Install.
7. Follow the onscreen instructions and the instructions provided in the Setup Guide that

came with the HP Photosmart.

Missing HP Photosmart Software
Cause: The HP Photosmart Software is not installed.

Solution: Install the HP Photosmart Software that came with the HP Photosmart.
If it is installed, restart your computer.

To install the HP Photosmart Software
1. Insert the HP Photosmart CD-ROM into your computer’s CD-ROM drive and then

start the Setup program.
2. When prompted, click Install More Software to install the HP Photosmart

Software.
3. Follow the onscreen instructions and the instructions provided in the Setup Guide

that came with the HP Photosmart.
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Cause: The HP Photosmart is turned off.

Solution: Turn the HP Photosmart on.

Cause: The computer is turned off.

Solution: Turn the computer on.

Cause: The HP Photosmart is not properly connected to the computer.

Solution: Check the connection from the HP Photosmart to your computer. Verify
that the USB cable is securely plugged into the USB port on the back of the
HP Photosmart. Make sure the other end of the USB cable is plugged into a USB port
on your computer. After the cable is connected properly, turn the HP Photosmart off
and then on again.

For more information on setting up the HP Photosmart and connecting it to your
computer, see the Setup Guide that came with the HP Photosmart.

Network troubleshooting
This section addresses problems you might encounter while setting up a network.

This section contains the following topics:

• Wired network setup troubleshooting
• Wireless setup troubleshooting

Wired network setup troubleshooting
This section addresses problems you might encounter setting up a wired network.
This section contains the following topics:

• The computer is unable to discover the HP Photosmart
• The Printer not Found screen appears during installation
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The computer is unable to discover the HP Photosmart
Cause: Cables are not connected properly.

Solution: Check the following cables to ensure they are connected properly.
• Cables between the HP Photosmart and the hub or router
• Cables between the hub or router and your computer
• Cables to and from your modem or HP Photosmart Internet connection (if

applicable)

Cause: Your computer's Local Area Network card (LAN card) is not set up properly.

Solution: Make sure that your LAN card is set up properly.

To check your LAN card (Windows 2000 and XP)
1. Right-click My Computer.
2. In the System Properties dialog box, click the Hardware tab.
3. Click Device Manager.
4. Make sure your card shows up under Network Adapters.
5. Refer to the documentation that came with your card.

To check your LAN card (Windows Vista)
1. On the Windows taskbar, click Start, Computer, and then click Properties.
2. Click Device Manager.
3. Make sure your card shows up under Network Adapters.
4. Refer to the documentation that came with your card.

Cause: You do not have an active network connection.

Solution: Check to see if you have an active network connection.

To see if you have an active network connection
▲ Check the two Ethernet indicator lights on the top and bottom of the RJ-45

Ethernet jack on the back of the HP Photosmart. The lights indicate the following:
a. Top light: If this light is a solid green, the device is properly connected to the

network, and communications have been established. If the top light is off,
there is no network connection.

b. Bottom light: This yellow light flashes when data is being sent or received by
the device over the network.

To establish an active network connection
1. Check the cable connections from the HP Photosmart to your gateway, router, or

hub to ensure connections are secure.
2. If the connections are secure, turn off the power on the HP Photosmart, and then

turn it on again. Press the On button on the control panel to turn the
HP Photosmart off, and press it again to turn the device on. Also, turn off the
power on your router or hub, and then turn it on again.
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Cause: You were able to connect the HP Photosmart to the network previously, but
now it will not connect.

Solution: Turn off the HP Photosmart, the computer, and the router. Wait 30
seconds. Turn on the router first, and then turn on the HP Photosmart and the
computer.

Cause: The HP Photosmart and computer are not connected to the same network.

Solution: Try accessing the Embedded Web Server on the HP Photosmart. To find
the IP address, print a network configuration page.

Related topics
• “View and print network settings” on page 39
• “Use the Embedded Web Server” on page 42

The Printer not Found screen appears during installation
Cause: The HP Photosmart is not turned on.

Solution: Turn on the HP Photosmart.

Cause: You do not have an active network connection.

Solution: Make sure you have an active network connection.

To make sure your network connection is active
1. If the connections are secure, turn off the power on the HP Photosmart, and then

turn it on again. Press the On button on the control panel to turn the
HP Photosmart off, and press it again to turn the device on. Also, turn off the
power on your router or hub, and then turn it on again.

2. Check the cable connections from the HP Photosmart to your gateway, router, or
hub to ensure connections are secure.

3. Make sure the HP Photosmart is connected to the network with a CAT-5 Ethernet
cable.

Cause: Cables are not connected properly.

Solution: Check the following cables to ensure they are connected properly:
• Cables between the HP Photosmart and the hub or router
• Cables between the hub or router and your computer
• Cables to and from your modem or HP Photosmart Internet connection (if

applicable)

Cause: A firewall, anti-virus, or anti-spyware application is preventing the
HP Photosmart from accessing your computer.

Solution: Uninstall the HP Photosmart software, and then reboot your computer.
Temporarily disable anti-virus or anti-spyware applications, and then reinstall the
HP Photosmart software. You can re-enable your anti-virus or anti-spyware
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applications after installation is complete. If you see firewall pop-up messages, you
must always accept or allow the pop-up messages.

If the screen still appears, try uninstalling the HP Photosmart software, rebooting your
computer, and temporarily disabling your firewall before reinstalling the
HP Photosmart software. You can re-enable your firewall application after installation
is complete. If you still see firewall pop-up messages, you must always accept or allow
the pop-up messages.

For more information, see the documentation provided with the firewall software.

Cause: A Virtual Private Network (VPN) is preventing the HP Photosmart from
accessing your computer.

Solution: Try temporarily disabling the VPN before proceeding with the installation.

NOTE: The HP Photosmart is not accessible during VPN sessions. However,
print jobs are saved in the print queue. When you exit the VPN session, print jobs
in the print queue will be printed.

Wireless setup troubleshooting
This section addresses problems you might encounter setting up a network. Check the
device display for specific error messages.

This section contains the following topics:

• During wireless network setup you do not see the SSID (network name) displayed
• Weak signal
• Cannot connect to network during setup
• Invalid WEP key during wireless setup
• Invalid passphrase during wireless setup
• The Printer Not Found screen appears during installation

During wireless network setup you do not see the SSID (network name)
displayed

Cause: Your wireless router is not broadcasting its network name (SSID) because
the Broadcast SSID option is turned off.

Solution: Access the router's Embedded Web Server and turn on the Broadcast
SSID option. See the user guide that came with your wireless router for information
on how to access the Embedded Web Server and check the Broadcast SSID setting.

For more information, see:

“Connect to an integrated wireless WLAN 802.11 network” on page 30

Cause: The wireless router (infrastructure) or computer (ad hoc) is too far from the
HP Photosmart or there is interference.

Solution: In order to establish a good signal between the HP Photosmart and
wireless router (infrastructure) or computer (ad hoc), you might have to experiment a
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bit. Assuming the equipment is functioning properly, try doing the following things
separately or in combination:
• If there is a long distance between your computer or wireless router and the

HP Photosmart, move them closer together.
• If there are metal objects (such as a metal bookcase or refrigerator) in the

transmission path, clear the path between the HP Photosmart and the computer
or wireless router.

• If a cordless telephone, microwave, or other device that emits radio signals
transmitting at 2.4 GHz is nearby, move it farther away to reduce radio
interference.

• If your computer or wireless router is near an external wall, move them away from
the wall.

Cause: Your network name (SSID) may be at the bottom of the SSID list that is
displayed when you install the HP Photosmart on a wireless network.

Solution: Touch  to scroll to the bottom of the list. Infrastructure entries are listed
first, ad hoc last.

Weak signal
Cause: The HP Photosmart is too far away from the wireless router or there is
interference.

Solution: In order to establish a good signal between the HP Photosmart and the
wireless router, you might have to experiment a bit. Assuming the equipment is
functioning properly, try doing the following things separately or in combination:
• If there is a long distance between your computer or wireless router and the

HP Photosmart, move them closer together.
• If there are metal objects (such as a metal bookcase or refrigerator) in the

transmission path, clear the path between the HP Photosmart and the computer
or wireless router.

• If a cordless telephone, microwave, or other device that emits radio signals
transmitting at 2.4 GHz is nearby, move it farther away to reduce radio
interference.

• If your computer or wireless router is near an external wall, move them away from
the wall.

Cannot connect to network during setup
Cause: The equipment is not turned on.

Solution: Turn on the networked devices, such as the wireless router for an
infrastructure network, or the computer for an ad hoc network. For more information
on how to turn on the wireless router, see the documentation that came with your
wireless router.

Cause: The HP Photosmart is not receiving a signal.
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Solution: Move the wireless router and the HP Photosmart closer together. Then
run the wireless setup again.

For more information, see:
“Integrated wireless WLAN 802.11 network setup” on page 29

Cause: If you manually entered your network name (SSID), you might have entered
it incorrectly.
Solution: Run the wireless setup process again and enter your network name
(SSID) carefully. Remember that the SSID is case-sensitive.

For more information, see:

“Connect to an integrated wireless WLAN 802.11 network” on page 30

Cause: The setting for MAC address filtering might be enabled on your wireless
router.

Solution: Disable MAC address filtering on your wireless router until the
HP Photosmart has successfully connected to your network. If you re-enable MAC
address filtering on your wireless router, make sure the MAC address of the
HP Photosmart is on the list of acceptable MAC addresses.

Invalid WEP key during wireless setup
Cause: If you are using WEP security, you might have entered the WEP key
incorrectly during the wireless setup process.

Solution: During the wireless setup process, you might have entered the WEP key
incorrectly. Some wireless routers provide up to four WEP keys. The HP Photosmart
uses the first WEP key (selected by the wireless router as the default WEP key). Run
the wireless setup process again and be sure to use the first WEP key provided by
the wireless router. Enter the WEP key exactly as it appears in the wireless router
settings. The WEP key is case sensitive.

If you do not know the WEP key, see the documentation that came with your wireless
router for information on how to access the router's Embedded Web Server. You can
find the WEP key by logging onto the router's Embedded Web Server using a
computer on the wireless network.

Invalid passphrase during wireless setup
Cause: During the wireless setup process, you might have entered the WPA
passphrase incorrectly.

Solution: Run the wireless setup process again and enter the correct passphrase.
The passphrase is case-sensitive.
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The Printer Not Found screen appears during installation
Cause: A firewall, anti-virus, or anti-spyware application is preventing the
HP Photosmart from accessing your computer.
Solution: Uninstall the HP Photosmart software, and then reboot your computer.
Temporarily disable anti-virus or anti-spyware applications, and then reinstall the
HP Photosmart software. You can re-enable your anti-virus or anti-spyware
applications after installation is complete. If you see firewall pop-up messages, you
must always accept or allow the pop-up messages.

If the screen still appears, try uninstalling the HP Photosmart software, rebooting your
computer, and temporarily disabling your firewall before reinstalling the
HP Photosmart software. You can re-enable your firewall application after installation
is complete. If you still see firewall pop-up messages, you must always accept or allow
the pop-up messages.

For more information, see the documentation provided with the firewall software.

Cause: A Virtual Private Network (VPN) is preventing the HP Photosmart from
accessing your computer.

Solution: Temporarily disable the VPN before proceeding with the installation.

NOTE: The HP Photosmart functionality will be limited during VPN sessions.

Cause: The HP Photosmart is not turned on.

Solution: Turn on the HP Photosmart.

Print quality troubleshooting
If you are having problems with print quality, try the solutions in this section and observe
the following guidelines:
• Replace refilled or empty ink cartridges with genuine HP ink cartridges.
• Check the device settings to make sure that the print mode and paper selection is

correct for the paper and the task.
For more information, see “Set the paper type for printing” on page 67 and “Choose
papers for printing” on page 55.

• Print and evaluate a self-test report.
For more information, see “Print a self-test report” on page 99.
If the self-test report shows a defect, try the following:
• Clean the ink cartridges automatically. For more information, see “Clean the print

head” on page 106.
• If you are missing lines when you print, clean the electrical contacts. For more

information, see “Clean the ink cartridge contacts” on page 107.
• If the self-test report does not show a problem, investigate other causes, such as the

image file or software program.

For additional ink cartridge troubleshooting, visit the HP Web site at www.hp.com/
support.
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This section contains the following topics:

• Ink is bleeding or smearing
• Ink is not filling the text or graphics completely
• The text edges are jagged
• The printout has a horizontal band of distortion near the bottom of the page
• Colors run into each other on the printout
• Printouts have horizontal streaks or lines
• Printouts are faded or have dull colors
• Printouts seem blurry or fuzzy
• Printouts have vertical streaks
• Printouts are slanted or skewed
• Paper is not picked up from the input tray

Ink is bleeding or smearing
Cause: The paper type is not suitable for the HP Photosmart.

Solution: Use HP Premium Papers or any other paper type that is appropriate for
the HP Photosmart.

Cause: The print head needs to be cleaned.

Solution: Clean the print head, and then print a self-test report. Check the color
blocks in the report for any problems. If the color blocks show print quality problems,
perform a printer alignment.

If the problem persists after cleaning and aligning, contact HP support for help. Go
to:

www.hp.com/support
If prompted, choose your country/region, and then click Contact HP for information
on calling for technical support.

For more information, see:

• “Clean the print head” on page 106
• “Print a self-test report” on page 99
• “Align the printer” on page 105

Cause: The paper is too close to the print head.

Solution: If the paper is too close to the print head during printing, the ink might be
smeared. This can happen if the paper is raised, wrinkled, or very thick, such as a
mailing envelope. Make sure the paper lays flat in the input tray and is not wrinkled.

Ink is not filling the text or graphics completely
Cause: The Paper Type setting is incorrect.
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Solution: Change the paper type setting to match the type of paper loaded in the
input tray.

For more information, see:
“Set the paper type for printing” on page 67

Cause: The print quality setting on the HP Photosmart is set too low.

Solution: Load high-quality paper in the input tray and print the image with a high
print quality setting, such as Best, Maximum dpi, or High Resolution. Always make
sure the paper you are printing on is flat. For best results when printing images, use
HP Premium Plus Photo Paper.
If the problem persists, use the software you installed with the HP Photosmart or
another software application to rotate your image 180 degrees so that the light blue,
gray, or brown hues in your image do not print at the bottom of the page.

For more information, see:

“Information on paper” on page 115

Cause: The print head needs to be cleaned.

Solution: Clean the print head, and then print a self-test report. Check the color
blocks in the report for any problems. If the color blocks show print quality problems,
perform a printer alignment.

If the problem persists after cleaning and aligning, contact HP support for help. Go
to:

www.hp.com/support

If prompted, choose your country/region, and then click Contact HP for information
on calling for technical support.

For more information, see:

• “Clean the print head” on page 106
• “Print a self-test report” on page 99
• “Align the printer” on page 105

Cause: You are using non-HP ink.

Solution: HP recommends that you use genuine HP ink cartridges. Genuine HP
ink cartridges are designed and tested with HP printers to help you easily produce
great results, time after time.

NOTE: HP cannot guarantee the quality or reliability of non-HP ink. Printer
service or repairs required as a result of printer failure or damage attributable to
the use of non-HP ink will not be covered under warranty.

The text edges are jagged
Cause: The font is a custom size.
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Solution: Some software applications offer custom fonts that have jagged edges
when enlarged or printed. Also, if you want to print bitmapped text, it might have
jagged edges when enlarged or printed.

Use TrueType or OpenType fonts to ensure that the HP Photosmart is able to print
smooth fonts. When selecting a font, look for the TrueType or OpenType icon.

The printout has a horizontal band of distortion near the bottom of the page
Cause: Your image has light blue, gray, or brown hues that print near the bottom
of the page.

Solution: Load high-quality paper in the input tray and print the image with a high
print quality setting, such as Best, Maximum dpi, or High Resolution. Always make
sure the paper you are printing on is flat. For best results when printing images, use
HP Premium Plus Photo Paper.

If the problem persists, use the software you installed with the HP Photosmart or
another software application to rotate your image 180 degrees so that the light blue,
gray, or brown hues in your image do not print at the bottom of the page.

For more information, see:

“Information on paper” on page 115

Colors run into each other on the printout
Cause: The print quality setting is set too high for the type of paper loaded in the
HP Photosmart.

Solution: Check the quality setting. Use a lower quality setting to decrease the
amount of ink used for printing.

For more information, see:

“Change the print speed or quality” on page 68

Cause: The paper type is not suitable for the HP Photosmart.

Solution: Use HP Premium Papers or any other paper type that is appropriate for
the HP Photosmart.

Cause: You are printing on the wrong side of the paper.

Solution: Load paper with the side you want to print on facing down. For example,
if you are loading glossy photo paper, load the paper with the glossy side down.

For more information, see:

“Load paper” on page 57

Cause: You are using non-HP ink.
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Solution: HP recommends that you use genuine HP ink cartridges. Genuine HP
ink cartridges are designed and tested with HP printers to help you easily produce
great results, time after time.

NOTE: HP cannot guarantee the quality or reliability of non-HP ink. Printer
service or repairs required as a result of printer failure or damage attributable to
the use of non-HP ink will not be covered under warranty.

Cause: The print head needs to be cleaned.

Solution: Clean the print head, and then print a self-test report. Check the color
blocks in the report for any problems. If the color blocks show print quality problems,
perform a printer alignment.

If the problem persists after cleaning and aligning, contact HP support for help. Go
to:

www.hp.com/support

If prompted, choose your country/region, and then click Contact HP for information
on calling for technical support.

For more information, see:

• “Clean the print head” on page 106
• “Print a self-test report” on page 99
• “Align the printer” on page 105

Printouts have horizontal streaks or lines
Cause: The paper is not feeding properly or is loaded incorrectly.

Solution: Make sure the paper is loaded correctly.

For more information, see:

“Load full-size paper” on page 58

Cause: The printouts are dull or fuzzy.

Solution: Load high-quality paper in the input tray and print the image with a high
print quality setting, such as Best, Maximum dpi, or High Resolution. Always make
sure the paper you are printing on is flat. For best results when printing images, use
HP Premium Plus Photo Paper.

If the problem persists, use the software you installed with the HP Photosmart or
another software application to rotate your image 180 degrees so that the light blue,
gray, or brown hues in your image do not print at the bottom of the page.

For more information, see:

“Information on paper” on page 115

Cause: The print head needs to be cleaned.
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Solution: Clean the print head, and then print a self-test report. Check the color
blocks in the report for any problems. If the color blocks show print quality problems,
perform a printer alignment.

If the problem persists after cleaning and aligning, contact HP support for help. Go
to:

www.hp.com/support
If prompted, choose your country/region, and then click Contact HP for information
on calling for technical support.

For more information, see:

• “Clean the print head” on page 106
• “Print a self-test report” on page 99
• “Align the printer” on page 105

Printouts are faded or have dull colors
Cause: The Paper Type setting is incorrect.

Solution: Load high-quality paper in the input tray and print the image with a high
print quality setting, such as Best, Maximum dpi, or High Resolution. Always make
sure the paper you are printing on is flat. For best results when printing images, use
HP Premium Plus Photo Paper.

If the problem persists, use the software you installed with the HP Photosmart or
another software application to rotate your image 180 degrees so that the light blue,
gray, or brown hues in your image do not print at the bottom of the page.

For more information, see:

“Information on paper” on page 115

Cause: The paper type is not suitable for the HP Photosmart.

Solution: Use HP Premium Papers or any other paper type that is appropriate for
the HP Photosmart.

Cause: The Paper Type setting is incorrect.

Solution: Change the paper type setting to match the type of paper loaded in the
input tray.

For more information, see:

“Set the paper type for printing” on page 67

Cause: The print head needs to be cleaned.
Solution: Clean the print head, and then print a self-test report. Check the color
blocks in the report for any problems. If the color blocks show print quality problems,
perform a printer alignment.

If the problem persists after cleaning and aligning, contact HP support for help. Go
to:
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www.hp.com/support

If prompted, choose your country/region, and then click Contact HP for information
on calling for technical support.
For more information, see:

• “Clean the print head” on page 106
• “Print a self-test report” on page 99
• “Align the printer” on page 105

Printouts seem blurry or fuzzy
Cause: The paper type is not suitable for the HP Photosmart.
Solution: Use HP Premium Papers or any other paper type that is appropriate for
the HP Photosmart.

Cause: The Paper Type setting is incorrect.

Solution: Change the paper type setting to match the type of paper loaded in the
input tray.

For more information, see:

“Set the paper type for printing” on page 67

Cause: The Paper Type setting is incorrect.

Solution: Load high-quality paper in the input tray and print the image with a high
print quality setting, such as Best, Maximum dpi, or High Resolution. Always make
sure the paper you are printing on is flat. For best results when printing images, use
HP Premium Plus Photo Paper.

If the problem persists, use the software you installed with the HP Photosmart or
another software application to rotate your image 180 degrees so that the light blue,
gray, or brown hues in your image do not print at the bottom of the page.

For more information, see:

“Information on paper” on page 115

Cause: You are printing on the wrong side of the paper.

Solution: Load paper with the side you want to print on facing down. For example,
if you are loading glossy photo paper, load the paper with the glossy side down.
For more information, see:

“Load paper” on page 57

Printouts have vertical streaks
Cause: The paper type is not suitable for the HP Photosmart.
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Solution: Use HP Premium Papers or any other paper type that is appropriate for
the HP Photosmart.

Printouts are slanted or skewed
Cause: The paper is not feeding properly or is loaded incorrectly.
Solution: Make sure the paper is loaded correctly.

For more information, see:

“Load full-size paper” on page 58

Cause: More than one type of paper is loaded in the input tray.
Solution: Load only one type of paper at a time.

Cause: The rear door might not be securely installed.

Solution: Make sure the rear door is securely installed.

Paper is not picked up from the input tray
Cause: There is not enough paper in the input tray.
Solution: If the HP Photosmart is out of paper or there are only a few sheets
remaining, load more paper in the input tray. If there is paper in the input tray, remove
the paper, tap the stack of paper against a flat surface, and reload the paper into the
input tray. Follow the prompts on the display or the computer screen to continue your
print job.

For more information, see:

“Load paper” on page 57

Print troubleshooting
Use this section to solve these printing problems:

• Envelopes print incorrectly
• Borderless printing produces unexpected results
• The HP Photosmart is not responding
• The HP Photosmart prints meaningless characters
• Nothing happens when I try to print
• The pages in my document came out in the wrong order
• The margins are not printing as expected
• Text or graphics are cut off at the edge of the page
• A blank page came out while printing
• Ink is spraying the inside of the HP Photosmart when I print a photo

Chapter 12

138 Troubleshooting

Troubleshooting



Envelopes print incorrectly
Cause: A stack of envelopes is loaded incorrectly.

Solution: Remove all paper from the input tray. Load a stack of envelopes in the
input tray, with the envelope flaps facing up and to the left.

NOTE: To avoid paper jams, tuck the flaps inside the envelopes.

Cause: The wrong type of envelope is loaded.

Solution: Do not use shiny or embossed envelopes or envelopes that have clasps
or windows.

Borderless printing produces unexpected results
Cause: Printing a borderless image from a non-HP software application produces
unexpected results.

Solution: Try printing the image from the photo imaging software that came with
the HP Photosmart.

The HP Photosmart is not responding
Cause: The HP Photosmart is busy with another task.

Solution: Some documents take a long time to print. If nothing has printed several
minutes after you sent a print job to the HP Photosmart, check your computer to see
if there are any messages.

Cause: The HP Photosmart has a paper jam.

Solution: Clear the paper jam.

For more information, see:

“Clear paper jams” on page 115

Cause: The HP Photosmart is out of paper.
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Solution: Load paper in the input tray.

For more information, see:

“Load paper” on page 57

Cause: The print head assembly has stalled.

Solution: Turn the HP Photosmart off, remove any objects that are blocking the
print head assembly (including any packing materials), and then turn the
HP Photosmart on again.

Cause: The computer is not communicating with the HP Photosmart.

Solution: If the HP Photosmart is not properly connected to the computer,
communication errors can occur. Make sure the USB cable is connected to the
HP Photosmart and the computer as shown below.

If the connections are secure, and nothing has printed several minutes after you sent
a print job to the HP Photosmart, check the status of the HP Photosmart. In the
HP Photosmart Software, click Status.
For more information, see:

“Communication problems over a USB connection” on page 113

Cause: The HP Photosmart is turned off.

Solution: Look at the On button located on the top of the HP Photosmart. If it is not
lit, the HP Photosmart is turned off. Make sure the power cord is firmly connected to
the HP Photosmart and plugged into a power outlet. Press the On button to turn on
the HP Photosmart.

Cause: The HP Photosmart experienced an error.

Solution: Turn the HP Photosmart off, and then unplug the power cord. Plug the
power cord back in, and then press the On button to turn on the HP Photosmart.

Cause: The status of the printer driver has changed.
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Solution: The printer driver status might have changed to either offline or stop
printing.

To check the printer driver status
1. In the HP Solution Center, click the device tab.
2. Click Settings.
3. Click Status.

If the status is offline or stop printing, change the status to ready.

Cause: A deleted print job is still in the queue.

Solution: A print job might remain in the queue after it has been cancelled. The
cancelled print job jams the queue and prevents the next print job from printing.

From your computer, open the printer folder and see if the cancelled job remains in
the print queue. Try to delete the job from the queue. If the print job remains in the
queue, try one or both of the following:

• Disconnect the USB cable from the HP Photosmart, restart the computer, and
then reconnect the USB cable to the HP Photosmart.

• Shut down the HP Photosmart, restart the computer, and then restart the
HP Photosmart.

The HP Photosmart prints meaningless characters
Cause: There is no more available memory in the HP Photosmart.

Solution: Turn off the HP Photosmart and your computer for 60 seconds, then turn
them both on and try printing again.

Cause: The document is corrupt.
Solution: Try printing another document from the same software application. If this
works, then try printing a previously saved version of the document that is not corrupt.

Nothing happens when I try to print
Cause: The HP Photosmart is turned off.

Solution: Look at the On button located on the top of the HP Photosmart. If it is not
lit, the HP Photosmart is turned off. Make sure the power cord is firmly connected to
the HP Photosmart and plugged into a power outlet. Press the On button to turn on
the HP Photosmart.

Cause: The HP Photosmart is busy with another task.

Solution: Some documents take a long time to print. If nothing has printed several
minutes after you sent a print job to the HP Photosmart, check your computer to see
if there are any messages.

Cause: The HP Photosmart is not the selected printer.
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Solution: Make sure the HP Photosmart is the selected printer in your software
application.

TIP: You can set the HP Photosmart as the default printer to ensure that the
printer is automatically selected when you select Print in the File menu of your
different software applications.

Cause: The computer is not communicating with the HP Photosmart.

Solution: If the HP Photosmart is not properly connected to the computer,
communication errors can occur. Make sure the USB cable is connected to the
HP Photosmart and the computer as shown below.

If the connections are secure, and nothing has printed several minutes after you sent
a print job to the HP Photosmart, check the status of the HP Photosmart. In the
HP Photosmart Software, click Status.

For more information, see:

“Communication problems over a USB connection” on page 113

Cause: The HP Photosmart has a paper jam.

Solution: Clear the paper jam.

For more information, see:

“Clear paper jams” on page 115

Cause: The print head assembly has stalled.

Solution: Turn the HP Photosmart off, remove any objects that are blocking the
print head assembly (including any packing materials), and then turn the
HP Photosmart on again.

Cause: The HP Photosmart is out of paper.
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Solution: Load paper in the input tray.

For more information, see:

“Load paper” on page 57

The pages in my document came out in the wrong order
Cause: The print settings are set to print the first page of your document first.
Because of the way the paper feeds through the HP Photosmart, this means the first
page will be print side up at the bottom of the stack.

Solution: Print the document in reverse order. When the document finishes
printing, the pages will be in correct order.

For more information, see:

“Print a multiple-page document in reverse order” on page 78

The margins are not printing as expected
Cause: The margins are not set correctly in your software application.

Solution: Check the printer margins.

Make sure the margin settings for the document do not exceed the printable area of
the HP Photosmart.

To check your margin settings
1. Preview your print job before sending it to the HP Photosmart.
2. Check the margins.

The HP Photosmart uses the margins you have set in your software application,
as long as they are greater than the minimum margins the HP Photosmart
supports.

3. Cancel the print job if the margins are not satisfactory, and then adjust the margins
in your software application.

Cause: The paper size setting might not be set correctly for the project you are
printing.

Solution: Verify that you have selected the proper paper size setting for your
project. Make sure that you have loaded the correct paper size in the input tray.

Cause: The paper guides are not positioned correctly.

Solution: Remove the stack of paper from the input tray, reload the paper, and then
slide the paper width guide inward until it stops at the edge of the paper.

For more information, see:

“Load paper” on page 57

Cause: A stack of envelopes is loaded incorrectly.
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Solution: Remove all paper from the input tray. Load a stack of envelopes in the
input tray, with the envelope flaps facing up and on the left.

NOTE: To avoid paper jams, tuck the flaps inside the envelopes.

For more information, see:

“Load envelopes” on page 62

Text or graphics are cut off at the edge of the page
Cause: The margins are not set correctly in your software application.

Solution:

To check your margin settings
1. Preview your print job before sending it to the HP Photosmart.
2. Check the margins.

The HP Photosmart uses the margins you have set in your software application,
as long as they are greater than the minimum margins the HP Photosmart
supports.

3. Cancel the print job if the margins are not satisfactory, and then adjust the margins
in your software application.

Make sure the margin settings for the document do not exceed the printable area of
the HP Photosmart.

Cause: The size of the document you are printing is larger than the paper loaded
in the input tray.

Solution: Make sure the layout of the document you are trying to print fits on a paper
size supported by the HP Photosmart.

To preview the print layout
1. Load the correct paper size into the input tray.
2. Preview your print job before sending it to the HP Photosmart.
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3. Check the graphics in the document to make sure that the current size fits within
the printable area of the HP Photosmart.

4. Cancel the print job if the graphics do not fit in the printable area of the page.

TIP: Some software applications allow you to scale the document to fit the paper
size currently selected. Additionally, you can scale the size of a document from
the print Properties dialog box.

Cause: The paper is loaded incorrectly.

Solution: If the paper is misfeeding, it could cause parts of the document to cut off.

Remove the stack of paper from the input tray, and then reload the paper following
the steps below.

For more information, see:
“Load paper” on page 57

A blank page came out while printing
Cause: The document you are printing contains an additional blank page.

Solution: Open the document file in your software application and remove any extra
pages or lines at the end of the document.

Cause: The HP Photosmart picked up two sheets of paper.

Solution: If the HP Photosmart has only a few sheets remaining, load more paper
in the input tray. If there is plenty of paper in the input tray, remove the paper, tap the
stack of paper against a flat surface, and reload the paper into the input tray.

For more information, see:

“Load paper” on page 57

Ink is spraying the inside of the HP Photosmart when I print a photo
Cause: The borderless print settings require photo paper to be loaded in the input
tray. You are using the wrong paper type.
Solution: Make sure you load photo paper in the input tray before you print a
borderless print job.

Memory card and front USB port troubleshooting
Use this section to solve these memory card problems:

• My memory card no longer works in my digital camera
• The HP Photosmart does not read the memory card or storage device
• The Photo light next to the memory card slots is blinking
• The Attention light blinks when I insert my memory card or storage device
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• The photos on the memory card or storage device do not transfer to my computer
• Memory card or storage device is not available
• Photos in a connected digital camera with PictBridge do not print
• The file name appears as meaningless text
• Other users on the network can access my memory card or storage device
• Error message: Cannot find the file or item. Make sure the path and file name are

correct.

My memory card no longer works in my digital camera
Cause: You formatted the card on a Windows XP computer. By default, Windows
XP will format a memory card of 8 MB or less and 64 MB or more with the FAT32
format. Digital cameras and other devices use the FAT (FAT16 or FAT12) format and
cannot recognize a FAT32 formatted card.

Solution: Reformat your memory card in your camera or format your memory card
in a Windows XP computer by selecting the FAT format.

The HP Photosmart does not read the memory card or storage device
Cause: The card is inserted backwards or upside down.

Solution: Turn the memory card so that the label side is up and the contacts are
facing the HP Photosmart, and then push the card forward into the appropriate slot
until the Photo light turns on.

If the memory card is not inserted properly, the HP Photosmart will not respond and
the Photo light (near the memory card slots) will not turn on.

After the memory card has been inserted properly, the Photo light will blink for a few
seconds, and then remain lit.

Cause: The memory card or storage device is not fully inserted.

Solution: Make sure you fully insert the memory card into the appropriate slot on
the HP Photosmart. Or, if you are using a storage device such as a keychain drive,
make sure you fully insert the storage device into the front USB port.

If the memory card or storage device is not inserted properly, the HP Photosmart will
not respond and the Photo light (near the memory card slots) will not turn on.

After a memory card or storage device has been inserted properly, the Photo light will
blink for a few seconds, and then remain lit.

Cause: You have inserted more than one memory card, or you have an inserted a
memory card and a storage device at the same time.

Solution: If you have inserted more than one memory card, remove one of the
memory cards. You can use only one memory card at a time.

If you have a memory card and a storage device connected, remove either the
memory card or the storage device. You can use only one at a time.
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Cause: The file system is corrupted.

Solution: Check the display for an error message telling you about the problem and
how to solve it.
If the file system on the card is corrupt, reformat the memory card in your digital
camera.

CAUTION: Reformatting the memory card will delete any photos stored on the
card. If you have previously transferred the photos from your memory card to a
computer, try printing the photos from the computer. Otherwise, you will need to
retake any photos you might have lost.

The Photo light next to the memory card slots is blinking
Cause: The HP Photosmart is reading the memory card.

Solution: Do not pull out the memory card while the Photo light is flashing. A
flashing light means the HP Photosmart is accessing the memory card. Wait until the
light remains solid. Removing a memory card while it is being accessed might corrupt
information on the card or damage the HP Photosmart and card.

The Attention light blinks when I insert my memory card or storage device
Cause: The HP Photosmart has detected an error with the memory card.
Solution: Remove and reinsert the memory card. You might have inserted it
incorrectly. Turn the memory card so that the label side is up and the contacts are
facing the HP Photosmart, and then push the card forward into the appropriate slot
until the Photo light turns on.

If the problem continues, the memory card might be defective.

Cause: You have inserted more than one memory card, or you have an inserted a
memory card and a storage device at the same time.

Solution: If you have inserted more than one memory card, remove one of the
memory cards. You can use only one memory card at a time.

If you have a memory card and a storage device connected, remove either the
memory card or the storage device. You can use only one at a time.

The photos on the memory card or storage device do not transfer to my computer
Cause: The HP Photosmart Software is not installed.
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Solution: Install the HP Photosmart Software that came with the HP Photosmart.
If it is installed, restart your computer.

To install the HP Photosmart Software
1. Insert the HP Photosmart CD-ROM into your computer’s CD-ROM drive and then

start the Setup program.
2. When prompted, click Install More Software to install the HP Photosmart

Software.
3. Follow the onscreen instructions and the instructions provided in the Setup Guide

that came with the HP Photosmart.

Cause: The HP Photosmart is turned off.

Solution: Turn the HP Photosmart on.

Cause: The computer is turned off.

Solution: Turn the computer on.

Cause: The HP Photosmart is not properly connected to the computer.

Solution: If the HP Photosmart is directly connected to a computer with a USB
cable, check the physical connection from the HP Photosmart to the computer. Verify
that the USB cable is securely plugged into the USB port on the back of the
HP Photosmart. Make sure the other end of the USB cable is plugged into a USB port
on your computer. After the cable is connected properly, turn the HP Photosmart off
and then on again.

If the HP Photosmart is network-connected, check physical network connections and
make sure the network is operational. Once you verify network connectivity, retry the
task.

For more information, see:

• “Communication problems over a USB connection” on page 113
• “Network troubleshooting” on page 125

Memory card or storage device is not available
Cause: If this message appears on your display, it means that another user is
accessing the memory card or storage device over the network. Other users who try
to use the same memory device might see a read/write error message. The memory
device might not appear, as expected, in a list of shared network drives. In addition,
if the HP Photosmart is connected to your computer by a USB cable, the computer
might be accessing the memory card or storage device, making it inaccessible to the
HP Photosmart.

Solution: Wait until the other user has finished using the memory card or storage
device.
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Photos in a connected digital camera with PictBridge do not print
Cause: The digital camera is not in PictBridge mode.

Solution: If the camera supports PictBridge, make sure the camera is set to
PictBridge mode. See the user guide that came with the camera for instructions on
how to do this.

Cause: The images are not in a supported format.

Solution: Make sure the digital camera is saving photos in a file format that the
PictBridge transfer feature supports (exif/JPEG, JPEG, and DPOF).

Cause: You did not select any photos on the camera for printing.

Solution: Before you connect the digital camera to the front USB port on the
HP Photosmart, select some photos on the camera for printing.

NOTE: Some digital cameras do not allow you to select photos until after you
have established a PictBridge connection. If this is the case, connect your digital
camera to the front USB port, turn on the camera and change it to PictBridge
mode, and then use the camera to select the photos you want to print.

The file name appears as meaningless text
Cause: The HP Photosmart does not support Unicode. This is a limitation of the
Common Internet File System (CIFS) server.

The CIFS server is included in all network-connected HP Photosmart devices. It
provides network drive letter access to the memory card or storage device in the
HP Photosmart. This lets you read/write files on the network from the memory card
or storage device in the HP Photosmart. The CIFS server appears on your computer
as a network drive. In addition to reading/writing files from your memory card or
storage device, you can also create folders and store other information.

Solution: If a file name was created with Unicode by another application, it will
display as arbitrary characters.

Other users on the network can access my memory card or storage device
Cause: The Common Internet File System (CIFS) server in the HP Photosmart
does not support authentication. This is a limitation of the CIFS server.

The CIFS server is included in all network-connected HP Photosmart devices. It
provides network drive letter access to the memory card or storage device in the
HP Photosmart. This lets you read/write files on the network from the memory card
or storage device in the HP Photosmart. The CIFS server appears on your computer
as a network drive. In addition to reading/writing files from your memory card or
storage device, you can also create folders and store other information.

Solution: Every user on the network can access the memory card or storage
device.
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Error message: Cannot find the file or item. Make sure the path and file name are
correct.

Cause: The Common Internet File System (CIFS) server in the HP Photosmart is
not operational.

The CIFS server is included in all network-connected HP Photosmart devices. It
provides network drive letter access to the memory card or storage device in the
HP Photosmart. This lets you read/write files on the network from the memory card
or storage device in the HP Photosmart. The CIFS server appears on your computer
as a network drive. In addition to reading/writing files from your memory card or
storage device, you can also create folders and store other information.

Solution: Retry your task at a later time.

Errors
This section contains the following categories of messages on your device:

• Device messages
• File messages
• General user messages
• Paper messages
• Power and connection messages
• Ink cartridge messages

Device messages
The following is a list of device-related error messages:

• Firmware revision mismatch
• Mechanism error
• Photo tray problem
• Photo tray cannot engage
• Photo tray cannot disengage

Firmware revision mismatch
Cause: The revision number of the HP Photosmart firmware does not match the
revision number of the software.

Solution: To find support and warranty information, go to the HP Web site at
www.hp.com/support. If prompted, choose your country/region, and then click
Contact HP for information on calling for technical support.

Mechanism error
Cause: The HP Photosmart has a paper jam.
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Solution: Clear the paper jam.

For more information, see:

“Clear paper jams” on page 115

Cause: The print head assembly is blocked or stalled.

Solution: Turn the HP Photosmart off and open the ink cartridge door. Remove any
objects that are blocking the print head assembly (including any packing materials),
and then turn the HP Photosmart on again.

Photo tray problem
Cause: There is not enough paper in the photo tray.

Solution: If the photo tray is empty or there are only a few sheets remaining, load
more paper in the photo tray. If there is paper in the photo tray, remove the paper,
tap the stack of paper against a flat surface, and reload the paper into the photo tray.
Follow the prompts on the display or the computer screen to continue your print job.

Cause: The paper is not feeding properly or is loaded incorrectly.

Solution: Make sure you have paper loaded correctly in the photo tray.

Cause: There might be too much paper loaded in the photo tray.
Solution: Do not overload the photo tray; make sure the stack of photo paper fits
within the photo tray and is no higher than the top of the paper-width guide.

Cause: Two or more pieces of paper might be stuck together.

Solution: Remove the paper from the photo tray and shuffle the paper so it does
not stick together. Reload the paper into the photo tray and try printing again.

Cause: The photo paper might be curled.

Solution: If the photo paper is curled, place the paper in a plastic bag and gently
bend it the opposite direction of the curl until the paper lies flat. If the problem persists,
use photo paper that is not curled.

Cause: You might be using the printer in an extremely high- or low-humidity
environment.

Solution: Load one sheet of photo paper at a time.

Photo tray cannot engage
Cause: The photo tray might not be pushed all the way in.

Solution: Lift the output tray, then push the photo tray all the way in. Push the output
tray all the way down.
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Photo tray cannot disengage
Cause: The output tray might not be lowered all the way.

Solution: Push the output tray all the way down.

File messages
The following is a list of file-related error messages:

• Error reading or writing the file
• Unreadable files. NN files could not be read
• Photos not found
• File not found
• File format not supported
• Invalid file name
• Supported file types for the HP Photosmart
• File corrupted

Error reading or writing the file
Cause: The HP Photosmart software could not open or save the file.

Solution: Check to see if you typed the correct folder and file name.

Unreadable files. NN files could not be read
Cause: Some of the files on the inserted memory card or attached storage device
are damaged.

Solution: Reinsert the memory card in the HP Photosmart or try transferring the
files to your computer using a memory card reader or a USB cable. If you already
transferred the files to your computer, try printing those files by using the
HP Photosmart Software. The copies might not be damaged. If these solutions do
not work, retake the photos with your digital camera as a last resort.

Photos not found
Cause: Some of the files on the inserted memory card or attached storage device
are damaged.

Solution: Reinsert the memory card in the HP Photosmart or try transferring the
files to your computer using a memory card reader or a USB cable. If you already
transferred the files to your computer, try printing those files by using the
HP Photosmart Software. The copies might not be damaged. If these solutions do
not work, retake the photos with your digital camera as a last resort.

Cause: There are no photos found on the memory card or storage device.

Solution: Take some photos with your digital camera, or if you previously saved
photos on your computer, you can print them using the HP Photosmart Software.
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File not found
Cause: There is not enough available memory on your computer to create a print
preview file.
Solution: Close some applications and try the task again.

File format not supported
Cause: The HP Photosmart software did not recognize or support the file format of
the image you are trying to open or save. If the file extension indicates it is a supported
file type, the file might be corrupted.

Solution: Open the file in another application, and save it in a format that the
HP Photosmart software recognizes.

For more information, see:

“Supported file types for the HP Photosmart” on page 153

Invalid file name
Cause: The file name you entered is invalid.

Solution: Make sure that you are not using any invalid symbols in the file name.

NOTE: Although the file name might look correct, it could still include invalid
characters. Overwrite the existing file name with a new name.

Supported file types for the HP Photosmart
The HP Photosmart software recognizes the following file formats: BMP, DCX, FPX, GIF,
JPG, PCD, PCX, and TIF.

File corrupted
Cause: Some of the files on the inserted memory card or attached storage device
are damaged.
Solution: Reinsert the memory card or storage device in the HP Photosmart or try
transferring the files to your computer using a memory card reader or a USB cable.
If you already transferred the files to your computer, try printing those files by using
the HP Photosmart Software. The copies might not be damaged. If these solutions
do not work, retake the photos with your digital camera as a last resort.

Cause: The file system is corrupted.

Solution: Check the display for an error message telling you that the images on the
memory card or storage device are corrupted.
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If the file system on the card is corrupt, reformat the memory card in your digital
camera.

CAUTION: Reformatting the memory card will delete any photos stored on the
card. If you have previously transferred the photos from your memory card to a
computer, try printing the photos from the computer. Otherwise, you will need to
retake any photos you might have lost.

General user messages
The following is a list of messages related to common user errors:

• Memory card error
• Disconnected
• Out of disk space
• Card access error
• Use only one card at a time
• Card is inserted incorrectly
• Card is not fully inserted
• Card is damaged

Memory card error
Cause: There are two or more memory cards inserted into the HP Photosmart at
the same time.
Solution: Remove all but one memory card. The HP Photosmart reads the
remaining memory card and displays the first photo stored on the memory card.

Cause: You have inserted a Compact Flash memory card backwards or upside
down.

Solution: Remove the memory card and reinsert it correctly. The label of the
Compact Flash card faces up and should be readable as you insert it into the slot.

Cause: You have not fully inserted the memory card.

Solution: Remove the memory card and reinsert it in the memory card slot until it
stops.

Disconnected
Cause: Several situations can cause this error message to appear.
• Your computer is not turned on.
• Your computer is not connected to the HP Photosmart.
• The software that came with the HP Photosmart was not installed correctly.
• The software that came with the HP Photosmart is installed, but it is not running.
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Solution: Make sure your computer is turned on and is connected to the
HP Photosmart. Also make sure you installed the software that came with the
HP Photosmart.

For more information, see:

• “Communication problems over a USB connection” on page 113
• “Network troubleshooting” on page 125

Out of disk space
Cause: There is not enough available memory on your computer to perform the
task.

Solution: Close some applications and try the task again.

Card access error
Cause: There are two or more memory cards inserted into the HP Photosmart at
the same time.
Solution: Remove all but one memory card. The HP Photosmart reads the
remaining memory card and displays the first photo stored on the memory card.

Cause: You have inserted a Compact Flash memory card backwards or upside
down.

Solution: Remove the memory card and reinsert it correctly. The label of the
Compact Flash card faces up and should be readable as you insert it into the slot.

Cause: You have not fully inserted the memory card.

Solution: Remove the memory card and reinsert it in the memory card slot until it
stops.

Use only one card at a time
Cause: Multiple memory cards are inserted in the HP Photosmart.

Solution: You can insert only one memory card at a time.

If more than one memory card is inserted, the Attention light will blink rapidly, and an
error message will appear on the display. Remove the additional memory card to
resolve the problem.

Card is inserted incorrectly
Cause: The card is inserted backwards or upside down.

Solution: Turn the memory card so that the label side is up and the contacts are
facing the HP Photosmart, and then push the card forward into the appropriate slot
until the Photo light turns on.
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If the memory card is not inserted properly, the HP Photosmart will not respond and
the Photo light (near the memory card slots) will not turn on.

After the memory card has been inserted properly, the Photo light will blink for a few
seconds, and then remain lit.

Card is not fully inserted
Cause: The card is not fully inserted.

Solution: Make sure you fully insert the memory card into the appropriate slot on
the HP Photosmart.

If the memory card is not inserted properly, the HP Photosmart will not respond and
the Photo light (near the memory card slots) will not turn on.

After the memory card has been inserted properly, the Photo light will blink for a few
seconds, and then remain lit.

Card is damaged
Cause: You formatted the card on a Windows XP computer. By default, Windows
XP will format a memory card of 8 MB or less and 64 MB or more with the FAT32
format. Digital cameras and other devices use the FAT (FAT16 or FAT12) format and
cannot recognize a FAT32 formatted card.

Solution: Reformat your memory card in your camera or format your memory card
in a Windows XP computer by selecting the FAT format.

Cause: The file system is corrupted.

Solution: Check the display for an error message telling you that the images on the
memory card are corrupted.

If the file system on the card is corrupt, reformat the memory card in your digital
camera.

CAUTION: Reformatting the memory card will delete any photos stored on the
card. If you have previously transferred the photos from your memory card to a
computer, try printing the photos from the computer. Otherwise, you will need to
retake any photos you might have lost.

Paper messages
The following is a list of paper-related error messages:

• Cannot load paper from input tray
• Ink is drying
• Out of paper
• Paper jam, misfeed or blocked carriage
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• Paper mismatch
• Wrong paper width

Cannot load paper from input tray
Cause: There is not enough paper in the input tray.

Solution: If the HP Photosmart is out of paper or there are only a few sheets
remaining, load more paper in the input tray. If there is paper in the input tray, remove
the paper, tap the stack of paper against a flat surface, and reload the paper into the
input tray. Follow the prompts on the display or the computer screen to continue your
print job.

For more information, see:

“Load full-size paper” on page 58

Ink is drying
Cause: Transparencies and some other media require a drying time that is longer
than normal.
Solution: Leave the sheet in the output tray until the message disappears. If it is
necessary to remove the printed sheet before the message disappears, carefully hold
the printed sheet on the underside or the edges, and place it on a flat surface to dry.

Out of paper
Cause: There is not enough paper in the input tray.

Solution: If the HP Photosmart is out of paper or there are only a few sheets
remaining, load more paper in the input tray. If there is paper in the input tray, remove
the paper, tap the stack of paper against a flat surface, and reload the paper into the
input tray. Follow the prompts on the display or the computer screen to continue your
print job.

For more information, see:
“Load full-size paper” on page 58

Cause: The rear door is off the HP Photosmart.

Solution: If you removed the rear door to clear a paper jam, replace it.

For more information, see:
“Clear paper jams” on page 115

Paper jam, misfeed or blocked carriage
Cause: Paper has jammed the HP Photosmart.
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Solution: Clear the jam. Touch OK to continue your print job.

For more information, see:

“Clear paper jams” on page 115

Cause: The print head assembly is blocked or stalled.

Solution: Turn the HP Photosmart off and open the ink cartridge door. Remove any
objects that are blocking the print head assembly (including any packing materials),
and then turn the HP Photosmart on again.

Paper mismatch
Cause: The print setting for the print job does not match the paper type or size
loaded in the HP Photosmart.

Solution: Change the print setting or load the appropriate paper in the input tray.

For more information, see:

• “Set the paper type for printing” on page 67
• “Set the paper size” on page 66
• “Information on paper” on page 115

Wrong paper width
Cause: The print setting chosen for the print job does not match the paper loaded
in the HP Photosmart.

Solution: Change the print setting or load the appropriate paper in the input tray.

For more information, see:

• “Information on paper” on page 115
• “Change the print settings for the current job” on page 66

Power and connection messages
The following is a list of power- and connection-related error messages:
• Communication test failed
• HP Photosmart not found
• Improper shutdown
• Two-way communication lost

Communication test failed
Cause: The HP Photosmart is turned off.

Solution: Look at the display on the HP Photosmart. If the display is blank and the
On button is not lit, the HP Photosmart is turned off. Make sure the power cord is
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firmly connected to the HP Photosmart and plugged into a power outlet. Press the
On button to turn on the HP Photosmart.

Cause: The HP Photosmart is not connected to the computer.

Solution: If the HP Photosmart is not properly connected to the computer,
communication errors can occur. Make sure the USB cable is securely connected to
the HP Photosmart and the computer, as shown below.

For more information, see:

“Communication problems over a USB connection” on page 113

HP Photosmart not found
Cause: This error applies only to USB-connected devices. The USB cable is not
plugged in properly.

Solution: If the HP Photosmart is not properly connected to the computer,
communication errors can occur. Make sure the USB cable is securely connected to
the HP Photosmart and the computer, as shown below.
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For more information, see:

“Communication problems over a USB connection” on page 113

Improper shutdown
Cause: The last time the HP Photosmart was used, it was not turned off properly.
If the HP Photosmart is turned off by turning off the switch on a power strip or by using
a wall switch, the device can be damaged.

Solution: Press the On button located on the control panel of the HP Photosmart
to turn the device on and off.

Two-way communication lost
Cause: The HP Photosmart is turned off.

Solution: Look at the display on the HP Photosmart. If the display is blank and the
On button is not lit, the HP Photosmart is turned off. Make sure the power cord is
firmly connected to the HP Photosmart and plugged into a power outlet. Press the
On button to turn on the HP Photosmart.

Cause: The HP Photosmart is not connected to the computer.

Solution: If the HP Photosmart is not properly connected to the computer,
communication errors can occur. Make sure the USB cable is securely connected to
the HP Photosmart and the computer, as shown below.

For more information, see:

“Communication problems over a USB connection” on page 113

Chapter 12

160 Troubleshooting

Troubleshooting



Ink cartridge messages
The following is a list of ink cartridge error messages:

• Calibration error
• Cannot print
• Incorrect ink cartridge(s)
• The following ink cartridges cannot be used after device initialization and must be

replaced
• Ink cartridge problem
• Ink cartridge(s) are empty
• Ink delivery failure
• Ink supply error
• Ink cartridge(s) are expired
• Ink expiration near
• Non-HP ink
• Original HP ink depleted
• Print head assembly is stalled
• Print head failure
• Alignment failed
• Replace ink cartridges soon
• Scheduled maintenance
• Wrong ink cartridge(s) installed
• Ink cartridge is missing, incorrectly installed, or not intended for your device

Calibration error
Cause: An incorrect type of paper is loaded in the input tray.

Solution: If you have color or photo paper loaded in the input tray when the printer
aligns, the calibration might fail. Load unused plain white letter or A4 paper into the
input tray, and then follow the prompts on the display to continue.

Cannot print
Cause: The indicated ink cartridge(s) are out of ink.

Solution: Replace the indicated ink cartridge(s) immediately so that you can
resume printing.

The HP Photosmart cannot continue printing until the indicated ink cartridge(s) are
replaced. All printing will stop.

For more information, see:
“Replace the ink cartridges” on page 102

Incorrect ink cartridge(s)
Cause: The wrong ink cartridge(s) are installed.

Solution: The indicated ink cartridge(s) cannot be used after the device has
undergone first-time setup. Replace the ink cartridge(s) with the appropriate ink
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cartridges for the HP Photosmart. To find out the reorder number for all the ink
cartridges that the HP Photosmart supports, see the printed documentation that came
with the HP Photosmart.

For more information, see:

“Replace the ink cartridges” on page 102

Cause: The ink cartridge(s) are not intended for use in this device.
Solution: Contact HP support. Go to:

www.hp.com/support

If prompted, choose your country/region, and then click Contact HP for information
on calling for technical support.

The following ink cartridges cannot be used after device initialization and must be
replaced

Cause: The wrong ink cartridge(s) are installed.

Solution: The indicated ink cartridge(s) cannot be used after the device has
undergone first-time setup. Replace the ink cartridge(s) with the appropriate ink
cartridges for the HP Photosmart. To find out the reorder number for all the ink
cartridges that the HP Photosmart supports, see the printed documentation that came
with the HP Photosmart.
For more information, see:

“Replace the ink cartridges” on page 102

Cause: The ink cartridge(s) are not intended for use in this device.

Solution: Contact HP support. Go to:

www.hp.com/support

If prompted, choose your country/region, and then click Contact HP for information
on calling for technical support.

Ink cartridge problem
Cause: The indicated ink cartridge(s) are missing or are damaged.

Solution: Replace the indicated ink cartridge(s) immediately so that you can
resume printing. If there are no ink cartridges missing from the HP Photosmart, the
ink cartridge contacts might need to be cleaned.

If there are no ink cartridges missing from the HP Photosmart, and you still receive
this message after cleaning the ink cartridge contacts, you might have a damaged
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ink cartridge. Check to see if your ink cartridge is still under warranty and the end of
warranty date has not been reached.

• If the end of warranty date has been reached, purchase a new ink cartridge.
• If the end of warranty date has not been reached, contact HP support. Go to

www.hp.com/support. If prompted, choose your country/region, and then click
Contact HP for information on calling for technical support.

For more information, see:

• “Replace the ink cartridges” on page 102
• “Clean the ink cartridge contacts” on page 107
• “Ink cartridge warranty information” on page 169
• “Shop for ink supplies” on page 111

Ink cartridge(s) are empty
Cause: The indicated ink cartridge(s) are out of ink.

Solution: Replace the indicated ink cartridge(s) with new ink cartridge(s).

For more information, see:

“Replace the ink cartridges” on page 102

Ink delivery failure
Cause: The print head assembly or the ink delivery system has failed and the
HP Photosmart can no longer print.

Solution: Turn the HP Photosmart off, unplug the power cord, and wait 10 seconds.
Then, plug the power cord back in and turn the device on.

If you continue to receive this message, write down the error code provided in the
message, and then contact HP support. Go to:

www.hp.com/support

If prompted, choose your country/region, and then click Contact HP for information
on calling for technical support.

Ink supply error
Cause: The indicated ink cartridge was removed during maintenance.
Solution: Replace the indicated ink cartridge with the previous ink cartridge during
the maintenance procedure. After the maintenance procedure is complete, you can
insert the new ink cartridge.
For more information, see:

“Replace the ink cartridges” on page 102
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Ink cartridge(s) are expired
Cause: The ink in the indicated ink cartridge(s) is at the expiration date.

Solution: Each ink cartridge has an expiration date. The purpose of expiration is to
protect the printing system and to ensure ink quality. When you receive an ink
cartridge(s) are expired message, remove and replace the expired ink cartridge, and
then close the message. You can also continue printing without replacing the ink
cartridge, by following the instructions on the HP Photosmart or the ink cartridge
expiration message on your computer screen. HP recommends replacing the expired
ink cartridges. HP cannot guarantee the quality or reliability of expired ink cartridges.
Device service or repairs required as a result of using expired ink will not be covered
under warranty.

For more information, see:

“Replace the ink cartridges” on page 102

Ink expiration near
Cause: The ink in the indicated ink cartridge(s) is near expiration.

Solution: One or more of the ink cartridges are near their expiration date.

Each ink cartridge has an expiration date. The purpose of expiration is to protect the
printing system and to ensure ink quality. When you receive an ink cartridge(s) are
expired message, remove and replace the expired ink cartridge, and then close the
message. You can also continue printing without replacing the ink cartridge, by
following the instructions on the HP Photosmart or the ink cartridge expiration
message on your computer screen. HP recommends replacing the expired ink
cartridges. HP cannot guarantee the quality or reliability of expired ink cartridges.
Device service or repairs required as a result of using expired ink will not be covered
under warranty.

For more information, see:

“Replace the ink cartridges” on page 102

Non-HP ink
Cause: The HP Photosmart detected non-HP ink.

Solution: Replace the indicated ink cartridge(s).

HP recommends that you use genuine HP ink cartridges. Genuine HP ink cartridges
are designed and tested with HP printers to help you easily produce great results,
time after time.

NOTE: HP cannot guarantee the quality or reliability of non-HP ink. Printer
service or repairs required as a result of printer failure or damage attributable to
the use of non-HP ink will not be covered under warranty.

If you believe you purchased genuine HP ink cartridge(s), go to:
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www.hp.com/go/anticounterfeit

For more information, see:

“Replace the ink cartridges” on page 102

Original HP ink depleted
Cause: The original HP ink in the indicated ink cartridge(s) has been depleted.

Solution: Replace the indicated ink cartridge(s) or touch OK to continue.
HP recommends that you use genuine HP ink cartridges. Genuine HP ink cartridges
are designed and tested with HP printers to help you easily produce great results,
time after time.

NOTE: HP cannot guarantee the quality or reliability of non-HP ink. Printer
service or repairs required as a result of printer failure or damage attributable to
the use of non-HP ink will not be covered under warranty.

For more information, see:

“Replace the ink cartridges” on page 102

Print head assembly is stalled
Cause: The print head assembly is blocked.

Solution: Remove any objects that are blocking the print head assembly.

To clear the print head assembly
1. Open the ink cartridge door by lifting from the front center of the device, until the

door locks into place.

2. Remove any objects that are blocking the print head assembly, including any
packing materials.

3. Turn the HP Photosmart off, then turn it on again.
4. Close the ink cartridge door.
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Print head failure
Cause: The print head assembly or the ink delivery system has failed and the
HP Photosmart can no longer print.
Solution: Contact HP support. Go to:

www.hp.com/support

If prompted, choose your country/region, and then click Contact HP for information
on calling for technical support.

Alignment failed
Cause: An incorrect type of paper is loaded in the input tray.

Solution: If you have color or photo paper loaded in the input tray when you align
the printer, the alignment might fail. Load unused plain white letter or A4 paper into
the input tray, and then try the alignment again. If the alignment fails again, you might
have a defective sensor.

Contact HP support. Go to:

www.hp.com/support

If prompted, choose your country/region, and then click Contact HP for information
on calling for technical support.

Cause: The print head assembly or sensor is defective.

Solution: Contact HP support. Go to:

www.hp.com/support

If prompted, choose your country/region, and then click Contact HP for information
on calling for technical support.

Replace ink cartridges soon
Cause: The indicated ink cartridge is estimated to be low on ink and might need to
be replaced soon.

Solution: You might be able to continue printing for a short period of time with ink
remaining in the print head assembly. Replace the indicated ink cartridge(s) or follow
the prompts on the display or computer screen to continue.

For more information, see:

“Replace the ink cartridges” on page 102

Scheduled maintenance
Cause: The HP Photosmart performs a periodic maintenance procedure to ensure
excellent print quality.
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Solution: Load unused plain white letter or A4 paper in the input tray. Then follow
the prompts on the display or computer screen to continue.

Wrong ink cartridge(s) installed
Cause: The wrong ink cartridge(s) are installed.
Solution: The first time you set up and use the HP Photosmart, make sure to install
the ink cartridges that were shipped with your device. The ink in these ink cartridges
is specially formulated to mix with the ink in the print head assembly.
To resolve this error, replace the affected ink cartridge(s) with the ink cartridges that
were shipped with the HP Photosmart.

For more information, see:

“Replace the ink cartridges” on page 102

Ink cartridge is missing, incorrectly installed, or not intended for your device
Cause: One or more ink cartridges are missing.

Solution: Remove and reinsert the ink cartridges and verify that they are fully
inserted and locked in place.

Cause: One or more of the ink cartridges are not installed or are installed
incorrectly.

Solution: Remove and reinsert the ink cartridges and verify that they are fully
inserted and locked in place. If the problem persists, clean the copper-colored
contacts of the ink cartridges.

For more information, see:

• “Replace the ink cartridges” on page 102
• “Clean the ink cartridge contacts” on page 107

Cause: The ink cartridge is defective or not intended for use in this device.

Solution: Replace the indicated ink cartridge(s) immediately so that you can
resume printing. If there are no ink cartridges missing from the HP Photosmart, the
ink cartridge contacts might need to be cleaned.

If there are no ink cartridges missing from the HP Photosmart, and you still receive
this message after cleaning the ink cartridge contacts, you might have a damaged
ink cartridge. Contact HP support. Go to:

www.hp.com/support

If prompted, choose your country/region, and then click Contact HP for information
on calling for technical support.
For more information, see:

“Replace the ink cartridges” on page 102
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Cause: The wrong ink cartridge(s) are installed.

Solution: The first time you set up and use the HP Photosmart, make sure to install
the ink cartridges that were shipped with your device. The ink in these ink cartridges
is specially formulated to mix with the ink in the print head assembly.

To resolve this error, replace the affected ink cartridge(s) with the ink cartridges that
were shipped with the HP Photosmart.
For more information, see:

“Replace the ink cartridges” on page 102
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13 HP warranty and support
Hewlett-Packard provides Internet and phone support for the HP Photosmart.
This section contains the following topics:
• Warranty
• Ink cartridge warranty information
• Support process
• Before you call HP support
• HP support by phone
• Additional warranty options
• HP Quick Exchange Service (Japan)
• Call HP Korea customer support
• Prepare the HP Photosmart for shipment
• Pack the HP Photosmart

Warranty
For more information about the warranty, see the printed documentation that came with the
HP Photosmart.

Ink cartridge warranty information
The HP cartridge warranty is applicable when the product is used in its designated HP printing device.
This warranty does not cover HP ink products that have been refilled, remanufactured, refurbished,
misused, or tampered with.
During the warranty period the product is covered as long as the HP ink is not depleted and the end
of warranty date has not been reached. The end of warranty date, in YYYY/MM/DD format, may be
found on the product as indicated:

For a copy of the HP Limited Warranty Statement, see the printed documentation that came with the
HP Photosmart.
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Support process
If you have a problem, follow these steps:
1. Check the documentation that came with the HP Photosmart.
2. Visit the HP online support Web site at www.hp.com/support. HP online support is available to

all HP customers. It is the fastest source for up-to-date device information and expert assistance
and includes the following features:
• Fast access to qualified online support specialists
• Software and driver updates for the HP Photosmart
• Valuable HP Photosmart and troubleshooting information for common problems
• Proactive device updates, support alerts, and HP newsgrams that are available when you

register the HP Photosmart
3. Call HP support. Support options and availability vary by device, country/region, and language.

Before you call HP support
Software programs from other companies might be included with the HP Photosmart. If you
experience problems with any of those programs, you will receive the best technical assistance by
calling the experts at that company.

If you need to contact HP support, do the following before you call:
1. Make sure that:

a. The HP Photosmart is plugged in and turned on.
b. The specified ink cartridges are installed correctly.
c. The recommended paper is properly loaded in the input tray.

2. Reset the HP Photosmart:
a. Turn off the HP Photosmart by pressing the On button.
b. Unplug the power cord from the back of the HP Photosmart.
c. Plug the power cord back into the HP Photosmart.
d. Turn on the HP Photosmart by pressing the On button.

3. To find support and warranty information, go to the HP Web site at www.hp.com/support. If
prompted, choose your country/region, and then click Contact HP for information on calling for
technical support.
Check the HP Web site for updated information or troubleshooting tips for the HP Photosmart .

4. If you are still experiencing problems and need to speak with an HP support representative, do
the following:
a. Have the specific name of the HP Photosmart, as it appears on the control panel, available.
b. Print a self-test report.
c. Make a color copy to have available as a sample printout.
d. Be prepared to describe your problem in detail.
e. Have your serial number ready.

You can view the serial number by looking at the sticker on the rear side of the
HP Photosmart. The serial number is the 10-character code in the upper left corner of the
sticker.

5. Call HP support. Be near the HP Photosmart when you call.

Related topics
“Print a self-test report” on page 99

HP support by phone
For a list of support phone numbers, see the printed documentation that came with the device.
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This section contains the following topics:
• Phone support period
• Placing a call
• After the phone support period

Phone support period
One year of phone support is available in North America, Asia Pacific, and Latin America (including
Mexico). To determine the duration of phone support in Europe, the Middle East, and Africa, go to
www.hp.com/support. Standard phone company charges apply.

Placing a call
Call HP support while you are in front of the computer and the HP Photosmart. Be prepared to provide
the following information:
• Model number (located on the label on the front of the HP Photosmart)
• Serial number (located on the back or bottom of the HP Photosmart)
• Messages that appear when the situation occurs
• Answers to these questions:

• Has this situation happened before?
• Can you re-create it?
• Did you add any new hardware or software to your computer at about the time that this

situation began?
• Did anything else occur prior to this situation (such as a thunderstorm, HP Photosmart was

moved, etc.)?

After the phone support period
After the phone support period, help is available from HP at an additional cost. Help may also be
available at the HP online support Web site: www.hp.com/support. Contact your HP dealer or call
the support phone number for your country/region to learn more about support options.

Additional warranty options
Extended service plans are available for the HP Photosmart at additional costs. Go to www.hp.com/
support, select your country/region and language, then explore the services and warranty area for
information about the extended service plans.
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HP Quick Exchange Service (Japan)

For instructions on how to pack your device for exchange, see “Pack the HP Photosmart”
on page 174.

Call HP Korea customer support
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Prepare the HP Photosmart for shipment
If, after contacting HP support or returning to the point of purchase, you are requested to send the
HP Photosmart in for service, make sure you remove and keep the following items before returning
your device:
• The control panel faceplate
• The power cord, USB cable, and any other cable connected to the HP Photosmart

CAUTION: The replacement HP Photosmart will not be shipped with a power cord. Store
the power cord in a safe place until the replacement HP Photosmart arrives.

• Any paper loaded in the input tray
• Remove any originals you might have loaded in the HP Photosmart
This section contains the following topics:
• Secure the ink system
• Remove the control panel faceplate

Secure the ink system
Contact HP support for information about how you should secure the ink system to prevent ink from
leaking in the HP Photosmart during shipment. They might instruct you to replace the ink cartridges
with replacement ink cartridges.
If you receive a replacement HP Photosmart, refer to the instructions included in the box for
information about how to secure the ink system. The replacement HP Photosmart might come with
ink cartridges that you can use to install in your device to prevent the ink system from leaking during
shipment.

NOTE: This information does not apply to customers in Japan. For information on service
options in Japan, see “HP Quick Exchange Service (Japan)” on page 172.

Related topics
“Replace the ink cartridges” on page 102

Remove the control panel faceplate
Remove the control panel faceplate before returning the HP Photosmart for repair.

NOTE: This information does not apply to customers in Japan. For information on service
options in Japan, see “HP Quick Exchange Service (Japan)” on page 172.

CAUTION: The HP Photosmart must be unplugged before following these steps.

To remove the control panel faceplate
1. Press the On button to turn off the HP Photosmart.
2. Unplug the power cord, and then disconnect it from the HP Photosmart. Do not return the power

cord with the HP Photosmart.
3. Remove the control panel faceplate as follows:

a. Place your hands on each side of the control panel faceplate.
b. Use your fingertips to pry the control panel faceplate off.
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4. Retain the control panel faceplate. Do not return the control panel faceplate with the
HP Photosmart.

CAUTION: The replacement HP Photosmart might not come with a control panel
faceplate. Store your control panel faceplate in a safe place, and when the replacement
HP Photosmart arrives, reattach your control panel faceplate. You must attach your control
panel faceplate to use the control panel functions on the replacement HP Photosmart.

NOTE: See the Setup Guide that came with the HP Photosmart for instructions on how to
attach your control panel faceplate. The replacement HP Photosmart might come with
instructions for setting up your device.

Pack the HP Photosmart
Complete the following steps after you have prepared the HP Photosmart for shipment.

To pack the HP Photosmart
1. If available, pack the HP Photosmart for shipment by using the original packing materials or the

packaging materials that came with your exchange device.

If you do not have the original packaging materials, please use other adequate packaging
materials. Shipping damage caused by improper packaging and/or improper transportation is
not covered under the warranty.

2. Place the return shipping label on the outside of the box.
3. Include the following items in the box:

• A complete description of symptoms for service personnel (samples of print quality problems
are helpful).

• A copy of the sales slip or other proof of purchase to establish the warranty coverage period.
• Your name, address, and a phone number where you can be reached during the day.
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14 Technical information
The technical specifications and international regulatory information for the HP Photosmart are
provided in this section.
For additional specifications, see the printed documentation that came with the HP Photosmart.
This section contains the following topics:
• Specifications
• Environmental product stewardship program
• Regulatory notices
• Regulatory wireless statements
• Declaration of conformity (European Economic Area)
• HP Photosmart D7400 series declaration of conformity

Specifications
Technical specifications for the HP Photosmart are provided in this section. For additional
specifications, see the printed documentation that came with the HP Photosmart.

System requirements
Software and system requirements are located in the Readme file.
For information about future operating system releases and support, visit the HP online support Web
site at www.hp.com/support.

Paper specifications

Type Paper weight Input tray* Output tray† Photo tray*

Plain paper 20 to 24 lb. (75 to
90 gsm)

Up to 100 (20 lb.
paper)

50 (20 lb. paper) n/a

Legal paper 20 to 24 lb. (75 to
90 gsm)

Up to 100 (20 lb.
paper)

50 (20 lb. paper) n/a

Cards 110 lb. index max
(200 gsm)

Up to 20 25 Up to 20

Envelopes 20 to 24 lb. (75 to
90 gsm)

Up to 10 10 n/a

Transparency film n/a Up to 20 15 or fewer n/a

Labels n/a Up to 20 25 n/a

5 x 7 inch (13 x 18 cm)
Photo paper

145 lb.
(236 gsm)

Up to 20 25 n/a

4 x 6 inch (10 x 15 cm)
Photo paper

145 lb.
(236 gsm)

Up to 20 25 Up to 20
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Type Paper weight Input tray* Output tray† Photo tray*

8.5 x 11 inch (216 x 279
mm) Photo paper

n/a Up to 20 10 n/a

* Maximum capacity.
† Output tray capacity is affected by the type of paper and the amount of ink you are using.

HP recommends emptying the output tray frequently.
* Maximum capacity.

NOTE: For a complete list of supported media sizes, see the printer driver.

Print specifications
• Up to 1200 x 1200 rendered dpi black when printing from a computer
• Up to 4800 x 1200 optimized dpi color when printing from a computer and 1200-input dpi
• Print speeds vary according to the complexity of the document
• Panorama-size printing
• Method: drop-on-demand thermal inkjet
• Language: PCL3 GUI
• Duty cycle: Up to 3000 printed pages per month

Print resolution
To find out about the printer resolution, see the printer software. For more information, see “View
the print resolution” on page 67.

Ink cartridge yield
Visit www.hp.com/pageyield for more information on estimated cartridge yields.

Acoustic information
If you have Internet access, you can get acoustic information from the HP Web site. Go to:
www.hp.com/support.

Environmental product stewardship program
Hewlett-Packard is committed to providing quality products in an environmentally sound manner.
Design for recycling has been incorporated into this product. The number of materials has been kept
to a minimum while ensuring proper functionality and reliability. Dissimilar materials have been
designed to separate easily. Fasteners and other connections are easy to locate, access, and
remove using common tools. High priority parts have been designed to access quickly for efficient
disassembly and repair.
For more information, visit HP’s Commitment to the Environment Web site at:
www.hp.com/hpinfo/globalcitizenship/environment/index.html
This section contains the following topics:
• Paper use
• Plastics
• Material safety data sheets
• Recycling program
• HP inkjet supplies recycling program
• Energy consumption
• Special handling of materials
• Attention California users
• NDL battery disposal
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• Taiwan battery statement
• Disposal of Waste Equipment by Users in Private Households in the European Union

Paper use
This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability
to identify plastics for recycling purposes at the end of product life.

Material safety data sheets
Material safety data sheets (MSDS) can be obtained from the HP Web site at:
www.hp.com/go/msds

Recycling program
HP offers an increasing number of product return and recycling programs in many countries/regions,
and partners with some of the largest electronic recycling centers throughout the world. HP
conserves resources by reselling some of its most popular products. For more information regarding
recycling of HP products, please visit:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/

HP inkjet supplies recycling program
HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is
available in many countries/regions, and lets you recycle used print cartridges and ink cartridges
free of charge. For more information, go to the following Web site:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/

Energy consumption
This product is designed to reduce power consumption and save natural resources without
compromising product performance. It has been designed to reduce total energy consumption both
during operation and when the device is not active. Specific information on power consumption may
be found in the printed documentation that came with the HP Photosmart.

Special handling of materials
This HP product contains a lithium-manganese dioxide battery located on the main printed circuit
assembly that may require special handling at end-of-life.

Attention California users
The battery supplied with this product may contain perchlorate material. Special handling may apply.
For more information, go to the following Web site:
www.dtsc.ca.gov/hazardouswaste/perchlorate

NDL battery disposal

Dit HP Product bevat een lithium-manganese-dioxide 
batterij. Deze bevindt zich op de hoofdprintplaat. 
Wanneer deze batterij leeg is, moet deze volgens de 
geldende regels worden afgevoerd.   
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Taiwan battery statement

Disposal of Waste Equipment by Users in Private Households in the European
Union

Disposal of Waste Equipment by Users in Private Households in the European Union
This symbol on the product or on its packaging indicates that this product must not be disposed of with your other household waste. Instead, it is your responsibility to dispose of your waste 
equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste equipment 
at the time of disposal will help to conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where 
you can drop off your waste equipment for recycling, please contact your local city office, your household waste disposal service or the shop where you purchased the product.
Évacuation des équipements usagés par les utilisateurs dans les foyers privés au sein de l'Union européenne
La présence de ce symbole sur le produit ou sur son emballage indique que vous ne pouvez pas vous débarrasser de ce produit de la même façon que vos déchets courants. 
Au contraire, vous êtes responsable de l'évacuation de vos équipements usagés et, à cet effet, vous êtes tenu de les remettre à un point de collecte agréé pour le recyclage des 
équipements électriques et électroniques usagés. Le tri, l'évacuation et le recyclage séparés de vos équipements usagés permettent de préserver les ressources naturelles et de s'assurer 
que ces équipements sont recyclés dans le respect de la santé humaine et de l'environnement. Pour plus d'informations sur les lieux de collecte des équipements usagés, veuillez contacter 
votre mairie, votre service de traitement des déchets ménagers ou le magasin où vous avez acheté le produit.
Entsorgung von Elektrogeräten durch Benutzer in privaten Haushalten in der EU
Dieses Symbol auf dem Produkt oder dessen Verpackung gibt an, dass das Produkt nicht zusammen mit dem Restmüll entsorgt werden darf. Es obliegt daher Ihrer Verantwortung, das 
Gerät an einer entsprechenden Stelle für die Entsorgung oder Wiederverwertung von Elektrogeräten aller Art abzugeben (z.B. ein Wertstoffhof). Die separate Sammlung und das 
Recyceln Ihrer alten Elektrogeräte zum Zeitpunkt ihrer Entsorgung trägt zum Schutz der Umwelt bei und gewährleistet, dass sie auf eine Art und Weise recycelt werden, die keine 
Gefährdung für die Gesundheit des Menschen und der Umwelt darstellt. Weitere Informationen darüber, wo Sie alte Elektrogeräte zum Recyceln abgeben können, erhalten Sie bei 
den örtlichen Behörden, Wertstoffhöfen oder dort, wo Sie das Gerät erworben haben.
Smaltimento di apparecchiature da rottamare da parte di privati nell'Unione Europea 
Questo simbolo che appare sul prodotto o sulla confezione indica che il prodotto non deve essere smaltito assieme agli altri rifiuti domestici. Gli utenti devono provvedere allo 
smaltimento delle apparecchiature da rottamare portandole al luogo di raccolta indicato per il riciclaggio delle apparecchiature elettriche ed elettroniche. La raccolta e il riciclaggio 
separati delle apparecchiature da rottamare in fase di smaltimento favoriscono la conservazione delle risorse naturali e garantiscono che tali apparecchiature vengano rottamate 
nel rispetto dell'ambiente e della tutela della salute. Per ulteriori informazioni sui punti di raccolta delle apparecchiature da rottamare, contattare il proprio comune di residenza, 
il servizio di smaltimento dei rifiuti locale o il negozio presso il quale è stato acquistato il prodotto.
Eliminación de residuos de aparatos eléctricos y electrónicos por parte de usuarios domésticos en la Unión Europea
Este símbolo en el producto o en el embalaje indica que no se puede desechar el producto junto con los residuos domésticos. Por el contrario, si debe eliminar este tipo de residuo, es 
responsabilidad del usuario entregarlo en un punto de recogida designado de reciclado de aparatos electrónicos y eléctricos. El reciclaje y la recogida por separado de estos residuos 
en el momento de la eliminación ayudará a preservar recursos naturales y a garantizar que el reciclaje proteja la salud y el medio ambiente. Si desea información adicional sobre los 
lugares donde puede dejar estos residuos para su reciclado, póngase en contacto con las autoridades locales de su ciudad, con el servicio de gestión de residuos domésticos o con la 
tienda donde adquirió el producto.
Likvidace vysloužilého zařízení uživateli v domácnosti v zemích EU
Tato značka na produktu nebo na jeho obalu označuje, že tento produkt nesmí být likvidován prostým vyhozením do běžného domovního odpadu. Odpovídáte za to, že vysloužilé 
zařízení bude předáno k likvidaci do stanovených sběrných míst určených k recyklaci vysloužilých elektrických a elektronických zařízení. Likvidace vysloužilého zařízení samostatným 
sběrem a recyklací napomáhá zachování přírodních zdrojů a zajišťuje, že recyklace proběhne způsobem chránícím lidské zdraví a životní prostředí. Další informace o tom, kam můžete 
vysloužilé zařízení předat k recyklaci, můžete získat od úřadů místní samosprávy, od společnosti provádějící svoz a likvidaci domovního odpadu nebo v obchodě, kde jste produkt 
zakoupili.
Bortskaffelse af affaldsudstyr for brugere i private husholdninger i EU
Dette symbol på produktet eller på dets emballage indikerer, at produktet ikke må bortskaffes sammen med andet husholdningsaffald. I stedet er det dit ansvar at bortskaffe affaldsudstyr 
ved at aflevere det på dertil beregnede indsamlingssteder med henblik på genbrug af elektrisk og elektronisk affaldsudstyr. Den separate indsamling og genbrug af dit affaldsudstyr på 
tidspunktet for bortskaffelse er med til at bevare naturlige ressourcer og sikre, at genbrug finder sted på en måde, der beskytter menneskers helbred samt miljøet. Hvis du vil vide mere 
om, hvor du kan aflevere dit affaldsudstyr til genbrug, kan du kontakte kommunen, det lokale renovationsvæsen eller den forretning, hvor du købte produktet.
Afvoer van afgedankte apparatuur door gebruikers in particuliere huishoudens in de Europese Unie
Dit symbool op het product of de verpakking geeft aan dat dit product niet mag worden afgevoerd met het huishoudelijk afval. Het is uw verantwoordelijkheid uw afgedankte apparatuur 
af te leveren op een aangewezen inzamelpunt voor de verwerking van afgedankte elektrische en elektronische apparatuur. De gescheiden inzameling en verwerking van uw afgedankte 
apparatuur draagt bij tot het sparen van natuurlijke bronnen en tot het hergebruik van materiaal op een wijze die de volksgezondheid en het milieu beschermt. Voor meer informatie over 
waar u uw afgedankte apparatuur kunt inleveren voor recycling kunt u contact opnemen met het gemeentehuis in uw woonplaats, de reinigingsdienst of de winkel waar u het product 
hebt aangeschaft.
Eramajapidamistes kasutuselt kõrvaldatavate seadmete käitlemine Euroopa Liidus
Kui tootel või toote pakendil on see sümbol, ei tohi seda toodet visata olmejäätmete hulka. Teie kohus on viia tarbetuks muutunud seade selleks ettenähtud elektri- ja elektroonikaseadmete 
utiliseerimiskohta. Utiliseeritavate seadmete eraldi kogumine ja käitlemine aitab säästa loodusvarasid ning tagada, et käitlemine toimub inimeste tervisele ja keskkonnale ohutult. 
Lisateavet selle kohta, kuhu saate utiliseeritava seadme käitlemiseks viia, saate küsida kohalikust omavalitsusest, olmejäätmete utiliseerimispunktist või kauplusest, kust te seadme 
ostsite.
Hävitettävien laitteiden käsittely kotitalouksissa Euroopan unionin alueella
Tämä tuotteessa tai sen pakkauksessa oleva merkintä osoittaa, että tuotetta ei saa hävittää talousjätteiden mukana. Käyttäjän velvollisuus on huolehtia siitä, että hävitettävä laite 
toimitetaan sähkö- ja elektroniikkalaiteromun keräyspisteeseen. Hävitettävien laitteiden erillinen keräys ja kierrätys säästää luonnonvaroja. Näin toimimalla varmistetaan myös, 
että kierrätys tapahtuu tavalla, joka suojelee ihmisten terveyttä ja ympäristöä. Saat tarvittaessa lisätietoja jätteiden kierrätyspaikoista paikallisilta viranomaisilta, jäteyhtiöiltä tai tuotteen 
jälleenmyyjältä.
Απόρριψη άχρηστων συσκευών στην Ευρωπαϊκή Ένωση
Το παρόν σύμβολο στον εξοπλισμό ή στη συσκευασία του υποδεικνύει ότι το προϊόν αυτό δεν πρέπει να πεταχτεί μαζί με άλλα οικιακά απορρίμματα. Αντίθετα, ευθύνη σας είναι να 
απορρίψετε τις άχρηστες συσκευές σε μια καθορισμένη μονάδα συλλογής απορριμμάτων για την ανακύκλωση άχρηστου ηλεκτρικού και ηλεκτρονικού εξοπλισμού. Η χωριστή συλλογή και 
ανακύκλωση των άχρηστων συσκευών θα συμβάλει στη διατήρηση των φυσικών πόρων και στη διασφάλιση ότι θα ανακυκλωθούν με τέτοιον τρόπο, ώστε να προστατεύεται η υγεία των 
ανθρώπων και το περιβάλλον. Για περισσότερες πληροφορίες σχετικά με το πού μπορείτε να απορρίψετε τις άχρηστες συσκευές για ανακύκλωση, επικοινωνήστε με τις κατά τόπους αρμόδιες 
αρχές ή με το κατάστημα από το οποίο αγοράσατε το προϊόν.
A hulladékanyagok kezelése a magánháztartásokban az Európai Unióban
Ez a szimbólum, amely a terméken vagy annak csomagolásán van feltüntetve, azt jelzi, hogy a termék nem kezelhető együtt az egyéb háztartási hulladékkal. Az Ön feladata, 
hogy a készülék hulladékanyagait eljuttassa olyan kijelölt gyűjtőhelyre, amely az elektromos hulladékanyagok és az elektronikus berendezések újrahasznosításával foglalkozik. 
A hulladékanyagok elkülönített gyűjtése és újrahasznosítása hozzájárul a természeti erőforrások megőrzéséhez, egyúttal azt is biztosítja, hogy a hulladék újrahasznosítása az 
egészségre és a környezetre nem ártalmas módon történik. Ha tájékoztatást szeretne kapni azokról a helyekről, ahol leadhatja újrahasznosításra a hulladékanyagokat, forduljon 
a helyi önkormányzathoz, a háztartási hulladék begyűjtésével foglalkozó vállalathoz vagy a termék forgalmazójához.
Lietotāju atbrīvošanās no nederīgām ierīcēm Eiropas Savienības privātajās mājsaimniecībās
Šis simbols uz ierīces vai tās iepakojuma norāda, ka šo ierīci nedrīkst izmest kopā ar pārējiem mājsaimniecības atkritumiem. Jūs esat atbildīgs par atbrīvošanos no nederīgās ierīces, 
to nododot norādītajā savākšanas vietā, lai tiktu veikta nederīgā elektriskā un elektroniskā aprīkojuma otrreizējā pārstrāde. Speciāla nederīgās ierīces savākšana un otrreizējā pārstrāde 
palīdz taupīt dabas resursus un nodrošina tādu otrreizējo pārstrādi, kas sargā cilvēku veselību un apkārtējo vidi. Lai iegūtu papildu informāciju par to, kur otrreizējai pārstrādei var 
nogādāt nederīgo ierīci, lūdzu, sazinieties ar vietējo pašvaldību, mājsaimniecības atkritumu savākšanas dienestu vai veikalu, kurā iegādājāties šo ierīci.
Europos Sąjungos vartotojų ir privačių namų ūkių atliekamos įrangos išmetimas
Šis simbolis ant produkto arba jo pakuotės nurodo, kad produktas negali būti išmestas kartu su kitomis namų ūkio atliekomis. Jūs privalote išmesti savo atliekamą įrangą atiduodami ją 
į atliekamos elektronikos ir elektros įrangos perdirbimo punktus. Jei atliekama įranga bus atskirai surenkama ir perdirbama, bus išsaugomi natūralūs ištekliai ir užtikrinama, kad įranga 
yra perdirbta žmogaus sveikatą ir gamtą tausojančiu būdu. Dėl informacijos apie tai, kur galite išmesti atliekamą perdirbti skirtą įrangą kreipkitės į atitinkamą vietos tarnybą, namų ūkio 
atliekų išvežimo tarnybą arba į parduotuvę, kurioje pirkote produktą.
Utylizacja zużytego sprzętu przez użytkowników domowych w Unii Europejskiej
Symbol ten umieszczony na produkcie lub opakowaniu oznacza, że tego produktu nie należy wyrzucać razem z innymi odpadami domowymi. Użytkownik jest odpowiedzialny za 
dostarczenie zużytego sprzętu do wyznaczonego punktu gromadzenia zużytych urządzeń elektrycznych i elektronicznych. Gromadzenie osobno i recykling tego typu odpadów 
przyczynia się do ochrony zasobów naturalnych i jest bezpieczny dla zdrowia i środowiska naturalnego. Dalsze informacje na temat sposobu utylizacji zużytych urządzeń można 
uzyskać u odpowiednich władz lokalnych, w przedsiębiorstwie zajmującym się usuwaniem odpadów lub w miejscu zakupu produktu.
Descarte de equipamentos por usuários em residências da União Européia
Este símbolo no produto ou na embalagem indica que o produto não pode ser descartado junto com o lixo doméstico. No entanto, é sua responsabilidade levar os equipamentos 
a serem descartados a um ponto de coleta designado para a reciclagem de equipamentos eletro-eletrônicos. A coleta separada e a reciclagem dos equipamentos no momento do 
descarte ajudam na conservação dos recursos naturais e garantem que os equipamentos serão reciclados de forma a proteger a saúde das pessoas e o meio ambiente. Para obter mais 
informações sobre onde descartar equipamentos para reciclagem, entre em contato com o escritório local de sua cidade, o serviço de limpeza pública de seu bairro ou a loja em que 
adquiriu o produto.
Postup používateľov v krajinách Európskej únie pri vyhadzovaní zariadenia v domácom používaní do odpadu
Tento symbol na produkte alebo na jeho obale znamená, že nesmie by vyhodený s iným komunálnym odpadom. Namiesto toho máte povinnos odovzda toto zariadenie na zbernom 
mieste, kde sa zabezpečuje recyklácia elektrických a elektronických zariadení. Separovaný zber a recyklácia zariadenia určeného na odpad pomôže chráni prírodné zdroje a 
zabezpečí taký spôsob recyklácie, ktorý bude chráni ľudské zdravie a životné prostredie. Ďalšie informácie o separovanom zbere a recyklácii získate na miestnom obecnom úrade, 
vo firme zabezpečujúcej zber vášho komunálneho odpadu alebo v predajni, kde ste produkt kúpili.
Ravnanje z odpadno opremo v gospodinjstvih znotraj Evropske unije
Ta znak na izdelku ali embalaži izdelka pomeni, da izdelka ne smete odlagati skupaj z drugimi gospodinjskimi odpadki. Odpadno opremo ste dolžni oddati na določenem zbirnem 
mestu za recikliranje odpadne električne in elektronske opreme. Z ločenim zbiranjem in recikliranjem odpadne opreme ob odlaganju boste pomagali ohraniti naravne vire in zagotovili, 
da bo odpadna oprema reciklirana tako, da se varuje zdravje ljudi in okolje. Več informacij o mestih, kjer lahko oddate odpadno opremo za recikliranje, lahko dobite na občini, 
v komunalnem podjetju ali trgovini, kjer ste izdelek kupili.
Kassering av förbrukningsmaterial, för hem- och privatanvändare i EU
Produkter eller produktförpackningar med den här symbolen får inte kasseras med vanligt hushållsavfall. I stället har du ansvar för att produkten lämnas till en behörig återvinningsstation 
för hantering av el- och elektronikprodukter. Genom att lämna kasserade produkter till återvinning hjälper du till att bevara våra gemensamma naturresurser. Dessutom skyddas både 
människor och miljön när produkter återvinns på rätt sätt. Kommunala myndigheter, sophanteringsföretag eller butiken där varan köptes kan ge mer information om var du lämnar 
kasserade produkter för återvinning.
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Regulatory notices
The HP Photosmart meets product requirements from regulatory agencies in your country/region.
This section contains the following topics:
• Regulatory model identification number
• FCC statement
• Notice to users in Korea
• VCCI (Class B) compliance statement for users in Japan
• Notice to users in Japan about power cord
• Geräuschemission

Regulatory model identification number
For regulatory identification purposes, your product is assigned a Regulatory Model Number. The
Regulatory Model Number for your product is SDGOB-0711. This regulatory number should not be
confused with the marketing name (HP Photosmart D7400 series, etc.) or product numbers
(CC247A, etc.).

FCC statement

FCC statement

The United States Federal Communications Commission (in 47 CFR 15.105) has specified 
that the following notice be brought to the attention of users of this product. 
This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules.  These limits are designed to provide reason-
able protection against harmful interference in a residential installation.  This equipment 
generates, uses and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio communications.  
However, there is no guarantee that interference will not occur in a particular installation.  
If this equipment does cause harmful interference to radio or television reception, which can 
be determined by turning the equipment off and on, the user is encouraged to try to correct 
the interference by one or more of the following measures:
• Reorient the receiving antenna.
• Increase the separation between the equipment and the receiver.
• Connect the equipment into an outlet on a circuit different from that to which the 

receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.
For further information, contact:

Manager of Corporate Product Regulations
Hewlett-Packard Company
3000 Hanover Street
Palo Alto, Ca 94304
(650) 857-1501

Modifications (part 15.21)
The FCC requires the user to be notified that any changes or modifications made to this 
device that are not expressly approved by HP may void the user's authority to operate the 
equipment.
This device complies with Part 15 of the FCC Rules.  Operation is subject to the following 
two conditions:  (1) this device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired 
operation.
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Notice to users in Korea

VCCI (Class B) compliance statement for users in Japan

Notice to users in Japan about power cord

Geräuschemission

Geräuschemission

LpA < 70 dB am Arbeitsplatz im Normalbetrieb nach DIN 45635 T. 19

Regulatory wireless statements
This section contains the following regulatory information pertaining to wireless products:
• Wireless: Exposure to radio frequency radiation
• Wireless: Notice to users in Brazil
• Wireless: Notice to users in Canada
• European Union Regulatory Notice
• Wireless: Notice to users in Taiwan

Wireless: Exposure to radio frequency radiation

Exposure to radio frequency radiation

Caution The radiated output power of this device is far below the FCC radio 
frequency exposure limits. Nevertheless, the device shall be used in such a manner 
that the potential for human contact during normal operation is minimized. This 
product and any attached external antenna, if supported, shall be placed in such 
a manner to minimize the potential for human contact during normal operation. In 
order to avoid the possibility of exceeding the FCC radio frequency exposure 
limits, human proximity to the antenna shall not be less than 20 cm (8 inches) 
during normal operation.
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Wireless: Notice to users in Brazil

Aviso aos usuários no Brasil

Este equipamento opera em caráter secundário, isto é, não tem direito à proteção 
contra interferência prejudicial, mesmo de estações do mesmo tipo, e não pode causar 
interferência a sistemas operando em caráter primário. (Res.ANATEL 282/2001).

Wireless: Notice to users in Canada

Notice to users in Canada/Note à l'attention des utilisateurs canadiens

For Indoor Use. This digital apparatus does not exceed the Class B limits for radio noise 
emissions from the digital apparatus set out in the Radio Interference Regulations of the 
Canadian Department of Communications. The internal wireless radio complies with RSS 
210 and RSS GEN of Industry Canada.
Utiliser à l'intérieur. Le présent appareil numérique n'émet pas de bruit radioélectrique 
dépassant les limites applicables aux appareils numériques de la classe B prescrites dans 
le Règlement sur le brouillage radioélectrique édicté par le ministère des Communications 
du Canada. Le composant RF interne est conforme a la norme RSS-210 and RSS GEN 
d'Industrie Canada.
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European Union Regulatory Notice

European Union Regulatory Notice

Products bearing the CE marking comply with the following EU Directives:  
• Low Voltage Directive 73/23/EEC  
• EMC Directive 2004/108/EC
CE compliance of this product is valid only if powered with the correct CE-marked AC 
adapter provided by HP. 
If this product has telecommunications functionality, it also complies with the essential 
requirements of the following EU Directive:
• R&TTE Directive 1999/5/EC
Compliance with these directives implies conformity to harmonized European standards 
(European Norms) that are listed in the EU Declaration of Conformity issued by HP for this 
product or product family. This compliance is indicated by the following conformity 
marking placed on the product.

The wireless telecommunications functionality of this product may be used in the following 
EU and EFTA countries:

Austria, Belgium, Cyprus, Czech Republic, Denmark, Estonia, Finland, France, Germany, 
Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania, Luxembourg, 
Malta, Netherlands, Norway, Poland, Portugal, Slovak Republic, Slovenia, Spain, 
Sweden, Switzerland, and United Kingdom.
Products with 2.4-GHz wireless LAN devices
France
For 2.4 GHz Wireless LAN operation of this product certain restrictions apply: This 
product may be used indoor for the entire 2400-2483.5 MHz frequency band (channels 
1-13). For outdoor use, only 2400-2454 MHz frequency band (channels 1-9) may be used. 
For the latest requirements, see http://www.art-telecom.fr.
Italy
License required for use. Verify with your dealer or directly with the General Direction for 
Frequency Planning and Management (Direzione Generale Pianificazione e Gestione 
Frequenze).

Wireless: Notice to users in Taiwan
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Declaration of conformity (European Economic Area)
The Declaration of Conformity in this document complies with ISO/IEC 17050-1 and EN 17050-1. It
identifies the product, manufacturer’s name and address, and applicable specifications recognized
in the European community.

HP Photosmart D7400 series declaration of conformity

DECLARATION OF CONFORMITY 
according to ISO/IEC 17050-1 and EN 17050-1 

 

Manufacturer's Name: Hewlett-Packard Company DoC#: SDGOB-0711-rel.1.0 

Manufacturer's Address: 16399 West Bernardo Drive 
San Diego, CA 92127, USA 

 

declares, that the product 
 

Product Name: HP Photosmart D7400 Series (CC247A,B,C,D,E,F,G) 

Regulatory Model:4) SDGOB-0711 

Product Options: ALL 

Radio Module: RSVLD-0608 

Power Adapter: 0957-2230 
 

conforms to the following Product Specifications: 
 

SAFETY: IEC 60950-1:2001 / EN60950-1:2001  
IEC 60825-1 Ed. 1.2: 2001 / EN 60825-1 + A2 + A1: 2002 (LED)  
GB4943: 2001 

EMC: CISPR 22:1997 +A1:2000 +A2:2002 / EN55022:1998 +A1:2000 +A2:2003 Class B 3) 

CISPR 24:1997 +A1:2001 +A2:2002 / EN 55024:1998 +A1:2001 + A2:2003 Class B3)  

EN 301 489-1 V1.4.1: 2002  
EN 301 489-17 V1.2.1: 2002 
IEC 61000-3-2: 2000 + A1:2000 + A2:2005 / EN 61000-3-2: 2000 +A2:2005 
IEC 61000-3-3:1994 +A1: 2001 / EN 61000-3-3:1995 +A1: 2001 
FCC Title 47 CFR, Part 15 Class B / ICES-003, Issue 4  
GB9254-1998, GB17625.1-2003 

RADIO: EN 300 328 V1.6.1:2004-11 

HEALTH: EU: 1999/519/EC 
 

Supplementary Information: 

1. The product herewith complies with the requirements of the EMC Directive 2004/108/EC, the Low Voltage 
Directive 73/23/EEC and the R&TTE Directive 1999/5/EC and carries the CE-Marking accordingly 

2. This Device complies with Part 15 of the FCC Rules.  Operation is subject to the following two Conditions: 
(1) this device may not cause harmful interference, and (2) this device must accept any interference 
received, including interference that may cause undesired operation 

3. The product was tested in a typical configuration. 

4. For regulatory purposes, these products are assigned a Regulatory model number. This number should 
not be confused with the product name or the product number(s). 

 

San Diego, CA, USA 
15 September, 2006  

For Regulatory Topics only, contact: 
European Contact:   Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard Gmbh, 
  Department HQ-TRE / Standards Europe, Herrenberger Strasse 140, D-71034 Böblingen, Germany (FAX: +49-7031-14-3143) 
USA Contact:  Product Regulations Manager, Hewlett Packard Company, San Diego, (858) 655-4100 
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Symbols/Numerics
10 x 15 cm photo paper

load 60
specifications 175

2 pages on 1, print 78
4 pages on 1, print 78
4 x 6 inch (10 x 15 cm)

borderless photos
print 72

4 x 6 inch photo paper, load 60
802.11 wireless, configuration

page 47
802.3 wired, configuration

page 45

A
A4 paper, load 58
access point connection 29
access point HW address 49
ad hoc network 33
addresses, print 80
admin password 45
advanced network settings 41
after the support period 171
align printer 105
authentication type 49

B
base station. See access point

connection
blocked print head 120
Bluetooth

accessibility 22
connect to the

HP Photosmart 21
passkey authentication 22
print from a computer 24
radio, turn off 24
security settings 22

Bluetooth, configuration
page 50

booklet printing 76
borderless photos

print 72
brightness, change in print 69

Browsing photos 18
buttons, control panel 10

C
cancel

button 10
print job 82

cartridges. See ink cartridges
CAT-5 Ethernet cable 28
channel, wireless

communication 48
choose paper 55
clean

ink cartridge contacts 107
print head 106

color
dull 136
smeared 134

color graphics display 10
color tone, change in print 69
communication mode 48
communication problems

test failed 158
two-way communication

lost 160
computer-to-computer

network 33
config source (802.3 wired) 46
configuration page

802.11 wireless 47
802.3 wired 45
Bluetooth 50
general information 44

configuration source 47
connect

wired network (Ethernet) 27
wireless, with access

point 29
wireless, without access

point 29
connection

wireless 21
connection problems

device not found 159
HP All-in-One does not turn

on 118

connection types supported
Bluetooth adapter 21
Ethernet 21
printer sharing 26

control panel
buttons 10
features 10

country/region, set 17
crop photos 93
customer support

HP Quick Exchange Service
(Japan) 172

Korea 172
warranty 169, 171

D
damaged, ink cartridge 162
declaration of conformity

European Economic
Area 183

United States 183
default gateway 47
default gateway (802.3

wired) 45
default printer, set as 66
default settings

restore 19
default settings, restore 40
device

no response 139
not found 159

device address (Bluetooth) 50
device name (Bluetooth) 50
disconnected error 154
Display

icons 11
display

change language 120
change measurements 120
sleep state 11

DNS server 47
DNS server (802.3 wired) 46
double-sided prints 75, 76
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E
Embedded Web Server

access using web
browser 43

password settings 45
setup wizard 43

encryption
settings 49
WEP key 34

envelopes
load 62
specifications 175

environment
Environmental product

stewardship program 176
error messages

memory cards 154
out of paper 157
reading or writing file 152

European Union
Directive 2002/95/EC 177
recycling information 178

EWS. See Embedded Web
Server

F
factory defaults, restore 19
fax

paper width incorrect 158
poor quality printouts 132
volume 18

fax problems
poor print quality 132
smeared ink 132

FCC statement 179
file

invalid name 153
supported formats 153
unreadable 152
unsupported formats 153

firmware revision mismatch 150
firmware version 44

G
gateway, default setting 45, 47
general information,

configuration page 44
greeting cards, load 63

H
hardware address 47

hardware address (802.3
wired) 45

help
menu 12

hostname 44, 51
HP Photosmart

send images 90

I
images

crop 93
rotate 94
zoom 93

improper shutdown 160
infrastructure mode 29
ink

drying time 157
empty 163
low 145
replace soon 166
sprays inside

HP Photosmart 145
ink cartridge

failure 163
ink cartridges

check ink levels 101
clean contacts 107
damaged 162
empty 163
error message 167
error messages 161
expired 164
HP ink depleted 165
incorrect 161, 162, 167
missing 162
non-HP ink 164
order 111
replace 102
replace soon 166
supply error 163
tips 114
troubleshoot 120

ink levels
icons 11

ink levels, check 101
ink supplies

purchase 111
ink, removing ink from skin and

clothing 108
install software,

troubleshoot 117
interface card 30
invalid file name 153

IP
address 44, 45, 47
settings 41

iron-on transfers 79

J
jams, paper 64, 120

L
labels

load 63
specifications 175

landscape orientation 68
language, set 17
legal paper

load 58
specifications 175

letter paper
load 58
specifications 175

link
configuration 46
speed 41

load
10 x 15 cm photo paper 60
4 x 6 inch photo paper 60
A4 paper 58
envelopes 62
full-size paper 58
greeting cards 63
index cards 61
iron-on transfers 63
labels 63
legal paper 58
letter paper 58
transparencies 63

M
MAC address 45, 47
maintenance

align printer 105
check ink levels 101
clean print head 106
replace ink cartridges 102
restore factory defaults 19
self-test report 99
set FEMP mode 109

margins
incorrect 143
text or graphic cut off 144

mDNS service name 45
media. See paper
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Media Access Control (MAC)
address 45, 47

memory cards
digital camera cannot

read 146
e-mail photos 90
error message 154
file unreadable 152
HP Photosmartcannot

read 146
inaccessible 148
insert 91
photos missing 152
read or write error 148
save files to computer 91
share photos 90
slots 85

menus
help 12
setup 12

missing
ink cartridge 162

N
network

advanced settings 41
connection type 44
interface card 30
name 48
restore settings 40
security 34
status 44
upgrade 38

network configuration page 44

O
OK button 10
order

ink cartridges 111
ink supplies 111

out of paper 157
overheads, print 79

P
page order 78
paper

choose 55
feed fails 138
incompatible types 57
jam 150, 157
jams 64, 115, 120
load 57

misfeed 157
out of 157
recommended sizes for

printing 66
recommended types 55
size incorrect 158
specifications 175
tips 115
type incorrect 158
width incorrect 158

paper type 67
passkey (Bluetooth) 50
password, Embedded Web

Server 45
peer-to-peer network 33
phone numbers, support 170
phone support 170
phone support period

period for support 171
photo

photosmart express
menu 12

Photo browsing 18
photo paper

load 60
specifications 175

photos
add a frame 93
add color effect 93
adjust brightness 93
crop 93
e-mail 90
flip horizontal 93
ink sprays 145
missing 152
print borderless 72
print on photo paper 73
remove red-eye 93
rotate 94
send using HP

Photosmart 90
share 90
zoom 93

poor fax printout quality 132
portrait orientation 68
posters 81
preview print job 69
print

2 or 4 pages on 1 78
addresses 80
blank printout 145
booklet 76
borderless fails 139

borderless photos 72
both sides of page 75
cancel job 82
CD/DVD labels 74
correct order 78
distorted printout 134
envelopes 80
envelopes print

incorrectly 139
faded 136
from computer 65
from software application 65
iron-on transfers 79
labels 80
margins incorrect 143, 144
meaningless characters 141
multiple pages on one

sheet 78
nothing happens 141
on photo paper 73
posters 81
preview 69
print options 66, 70
quality, troubleshoot 132,

135, 137
reverse images 79
reversed page order 143
self-test report 99
special print jobs 72
specifications 176
transparencies 79
troubleshooting 138
vertical streaks 137
Web pages 81

print cartridges
low ink 145

print head
clean 106
failure 166
stalled 165

print head, blocked 120
print quality 68
print settings

brightness 69
color tone 69
layout 68
orientation 68
paper size 66
paper type 67
print quality 131
quality 68
reduce/enlarge 69
resizing options 69

Index
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resolution 68
saturation 69
speed 68

printer found screen,
Windows 37

printer sharing
Mac 26
Windows 26

printer, align 105
Printing Shortcuts tab 70
problems

error messages 150
print 138

Q
quality

print 68

R
radio, turn off 24, 40
Readme file 117
recycle

ink cartridges 177
red-eye, remove 93
regulatory notices

China 177
declaration of conformity

(European Economic
Area) 183

declaration of conformity
(U.S.) 183

Directive 2002/95/EC 177
FCC statement 179
geräuschemission 180
notice to users in Japan

(power cord) 180
notice to users in Japan

(VCCI) 180
notice to users in Korea 180
regulatory model

identification number 179
wireless statements 180

reinstall software 123
removing ink from skin and

clothing 108
replace ink cartridges 102
reports

self-test 99
resolution

print 68
restore factory settings 19
restore network defaults 40

RJ-45 plug 28, 51
rotate photos 94
router 28

S
saturation, change in print 69
save

photos to computer 91
security

Bluetooth 50
Bluetooth adapter 22
network, WEP key 30, 34,

35, 36, 48, 49
troubleshoot 34

self-test report 99
set

print options 66, 70
settings

country/region 17
language 17
network 38
restore defaults 40

setup
menu 12

sharing 37
ship your device 173
signal strength 48
sleep state 11
Smart Key 30
smeared ink, fax 132
software application, print

from 65
software installation

reinstall 123
troubleshoot 121
uninstall 123

sound, adjust volume 18
speed

print 68
SSID

troubleshoot 128
wireless setting 48

status, network 44
stop

print job 82
Store Demo 19
subnet mask 45, 47
support

contact 170
support process 170
system requirements 175

T
T-shirt transfers. See iron-on

transfers
technical information

paper specifications 175
print specifications 176
system requirements 175

telephone numbers,
support 170

text
cut off 144
jagged 133
meaningless characters 141
not filled in 132
smooth fonts 133

Tips Slideshow 19
total packets

received 50
transmitted 49

total packets received (802.3
wired) 46

total packets transmitted (802.3
wired) 46

transparencies
load 63
specifications 175

troubleshoot
blocked print head 120
fax problems 132
hardware installation 117
incorrect

measurements 120
jams, paper 64, 120
language, display 120
low signal 129
network connection 129
network setup 125
Passphrase, invalid 130
printer alignment 120
printer not found 131
Readme file 117
software installation 121
USB cable 119
WEP key 130
wireless setup wizard 125,

128
troubleshooting

cannot find the file or
item 150

communication
problems 113

error messages 150
file system 145
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filename appears as
gibberish 149

others on network can
access my memory
card 149

print 138
Printer not Found 127
unable to discover

device 126
two-sided prints 75, 76

U
uninstall software 123
upgrade to network 38
URL 44
USB cable

communication lost 160
USB cable installation 119

V
visibility (Bluetooth) 50
volume, adjust 18

W
warranty 169, 171
Web pages, print 81
WEP key, setup 34
wireless

radio, turn off 40
setup wizard,

troubleshoot 125, 128
status 48

wireless regulatory notices
exposure to wireless

frequency radiation 180
notice to users in Brazil 181
notice to users in

Canada 181
notice to users in

Taiwan 182
notice to users in the

European Economic
Area 182

wireless router 28

Z
zoom

buttons 93
photos 93

Index
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